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Before Reading This Manual 
Thank you for purchasing the IMAGECHECKER PV240. 

This manual describes information on the hardware such as how to install and wire and the software such as how 
to set the functions. Read this User’s Manual carefully before use. 

Safety Precautions 
To ensure that you use this product correctly, read this User’s Manual thoroughly before use. Make sure that you 
fully understand the product and information on safe. 

 

 WARNING 
Critical situations that could lead to user’s death or serious injury are assumed by mishandling of the product: 

 Do not use this product in areas with inflammable gas. It could lead to an explosion. 

 Exposing this product to excessive heat or open flames could lead to damage to the lithium battery or 
other electronic parts. 

 Do not store a lens in the locations subject to direct sunlight. It could lead to smoke generation. 

 Do not look at the sun through a lens. It could lead to blindness. 

 Always take precautions to ensure the overall safety of your system, so that the whole system remains 
safe in the event of failure of this product or other external factor. 

 CAUTION 
Critical situations that could lead to user’s injury or only property damage are assumed by mishandling of the 
product: 

 Do not dismantle or remodel the product. It could lead to excessive exothermic heat or smoke 
generation. 

 Do not touch the terminal while turning on electricity. It could lead to an electric shock. 

 Do not allow foreign matters such as liquid, flammable materials, metals to go into the inside of the 
product. It could lead to excessive exothermic heat or smoke generation. 

 Do not bend the cables forcibly, place a heavy object on them or bring them close to a thermal 
appliance. It could lead to an electric shock or smoke generation. 

 To prevent excessive exothermic heat or smoke generation, use this product at the values less than 
the maximum of the characteristics and performance that are assured in these specifications. 

 Use the external devices to function the emergency stop and interlock circuit. 

 Connect the wires or connectors securely. The loose connection could lead to excessive exothermic 
heat or smoke generation. 

 Do not undertake construction (such as connection and disconnection) while the power supply is on. It 
could lead to an electric shock. 
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Software License Agreement 

 
Panasonic Industrial Devices SUNX Co., Ltd. (“PIDSX”) grants to you a license to use this 
Software on condition that you accept this Agreement. You must read this Software 
License Agreement (this “Agreement”) carefully before using this Software. Only in case 
that you accept this Agreement, you may start your use of this Software. 
Your unsealing the package of this Software, or your downloading, installing or launching 
this Software or the like shall be deemed as your acceptance of this Agreement. 
 
Article 1 Grant of License 

PIDSX hereby grants to you a non-exclusive license to use this Software only in 
combination with PIDSX product(s) specified in the manual of this Software (the 
“Product”) in accordance with the terms of this Agreement. You may not use this 
Software in connection with products of any third party other than PIDSX. 

 
Article 2 Restrictions 

You may NOT: 
(1)Modify, reverse engineer, decompile, or disassemble this Software, 
 
(2)Use this Software by methods or for purposes other than those specified in 
the manual of this Software provided by PIDSX, nor 
(3)Distribute, rent, lease or otherwise transfer this Software to any third party; 
provided, however, that you may assign the rights to use this Software under 
this Agreement along with the Product on the condition that the assignee 
agrees to be bound by all the terms of this Agreement. In the case of such 
assignment, you must deliver any and all the copies of this Software and all 
the accompanying materials to the assignee and you may not retain any 
copies of this Software including backups. 

 
Article 3 Disclaimer 

3-1. PIDSX HEREBY DISCLAIMS ALL OTHER WARRANTIES ON THIS 
SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF MARCHANTABILITY, FITNESS 
FOR PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF THIRD 
PARTY RIGHTS. 

3-2. UNDER NO CIRCUMSTANCES SHALL PIDSX BE LIABLE FOR ANY 
DAMAGES (INCLUDING DIRECT, INDIRECT, INCIDENTAL, 
CONSEQUENTIAL OR SPECIAL OR WHATSOEVER) ARISING OUT OF THE 
USE OF THIS SOFTWARE, INABILITY TO USE THIS SOFTWARE, DEFECTS 
IN THIS SOFTWARE (e.g., BUGS, SECURITY HOLES, AND MALFUNCTION), 
OR OTHERWISE IN CONNECTION WITH THIS SOFTWARE. 
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Article 4 Term 

4-1. This Agreement shall come into effect upon your unsealing the package of this 
Software, or your downloading, installing or launching this Software or the like. 

4-2. PIDSX may terminate this Agreement immediately, if you breach any of the 
provisions of this Agreement. 

4-3. You shall, at your own costs, return, delete or destroy this Software and any of 
its copies within four (4) weeks after termination of this Agreement. 

 
Article 5 Export Control 

You shall comply with all laws and regulations regarding export control under 
any competent jurisdiction, including but not limited to the Japanese Foreign 
Exchange & Foreign Trade Control Law, the export control regulations based on 
resolutions of the United Nations Security Council, etc. If any license or 
appropriate approval from a governmental authority is required under the 
applicable laws, you may not export this Software without such approval to any 
countries either directly or indirectly. Furthermore, you shall neither use nor sell 
this Software for military purposes either directly or indirectly. 

 
Article 6 Intellectual Property Rights 

All intellectual property rights in this Software, including the copyright, belong to 
PIDSX and/or the licensors of PIDSX. 

 
Article 7 Upgrade of this Software 

7-1 Release of future upgrades or updates of this Software is not guaranteed and 
left to the sole discretion of PIDSX.  Furthermore, PIDSX may charge fees for 
upgrading or updating of this Software. 

7-2. If any upgrades or updates are provided to you either for fees or for free, such 
upgrades or updates shall be deemed as a part of this Software and shall be 
governed by this Agreement, unless PIDSX designates otherwise at the time of 
provision of such upgrades or updates. 

 
Article 8 Limitation on Liability 

AGGREGATE LIABILITIES OF PIDSX IN CONNECTION WITH THIS 
AGREEMENT OR THIS SOFTWARE SHALL IN NO EVENT EXCEED TEN 
THOUSAND (10,000) YEN. 

 
Article 9 Governing Law and Jurisdiction 

9-1. This Agreement shall be governed by the laws of Japan. 
9-2. Should any dispute arise from or in connection with this Agreement,  Nagoya 

District Court, Japan shall exclusively have the jurisdiction over such dispute. 
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1.1 Menu 

The followings are specific menus for Alignment function. For information on other menus, refer to PV200 
User's Manual. 

SETUP MENU 
TYPE ─ Alignment ┬ Stage Setting ┬ Stage Type ─ UVW / 

XYTheta(YXTheta) / 
XThetaY / YThetaX / 
XTheta  

  │
  

▶ p.52 ├ Theta Axis ─ Rotation / Straight Line 

  │  ├ Theta Axis Length (mm)  
  │  ├ UVW Pin Position (mm)  
  │  ├ Stage Direction Automatic 

Judgement 
─ No / Yes 

  │  ├ Stage +XY Direction ┬ Direction1(->^) 
  │  │ ├ Direction2(<-^) 
  │  │ ├ Direction3(->v) 
  │  │ └ Direction4(<-v) 
  │  ├ Stage +Theta Direction ─ CW / CCW 
  │  └ Stage MAX Distance  
  ├ Calibration ┬ Stage Movement  
  │ ▶ p.165 └ Rotation Point Adj.  
  └ Alignment ┬ TRIG Type ┬ Mark Sync. Execution 
   ▶ p.156 │ └ Mark Async. Execution 
   ├ Retry  
   ├ Target Cross Drawing ─ No / Yes 
   ├ Arrowhead of stage direction 

│ 
─ No 

 / Top Left / Bottom Left 
/ Top Right / Bottom 
Right 

   ├ Display Inspection Time ─ Inspection Time / 
Alignment Time 

   └ Options  
    ├ Target Position ─ Mark Detection / Center 

of Display 
    ├ Display Data R/W ─ Fixed / Free 
    ├ Display Total 

Judgement 
─ No / Yes 

    └ Checksum ─ No / Yes 
     

 
INSPECTION ─ Alignment ┬ Checkers Setting ┬ Comment  
  │ ▶ p.162 ├ Calibration Checker ┬ Mark0 
  │  │ └ Mark1 
  │  ├ Common Object  
  │  ├ Target Checker ┬ Mark0 
  │  │ └ Mark1 
  │  └ Object Checker ┬ Mark0 
  │   └ Mark1 
  ├ Calibration ┬ Checker ┬ Mark0 
   ▶ p.166 │ └ Mark1 
    ├ Calibration Data ┬ Show details ─ 

Display Global Coordinate 
    │ └ Manual Setting 
    └ Rotation Point Adj. ┬ Mark0 
     └ Mark1 
  ├ Target ┬ Checker ┬ Mark0 
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   ▶ p.182 │ └ Mark1 
    ├ Display Coordinates ─ Camera Coordinates / 

Stage Coordinates 
  │ ├ Register coordinates of target 
  │ │ ├ Display Coordinates  
  │ │ ├ Coordinates of Detected Target 
  │ │ ├ Register coordinates of target 
  │ │ ├ Coordinates of Registered Target 
  │ │ ├ Stage Coordinates Offset 
  │ │ ├ Target Coordinates Offset 
  │ └ Coordinates of Registered Target 
  ├ Object ┬ Checker ┬ Mark0 
   ▶ p.192 │ └ Mark1 
    ├Display Coordinates ─ Camera Coordinates / 

Stage Coordinates 
  │ └ Detect Coordinates Offset ┬ Mark0 
  │  └ Mark1 
  └ Judgement 

Limits 
┬ Change Base ┬ Center 

   ▶ p.198 │ ├ Mark0 
    │ └ Mark1 
    ├ Threshold of Change Judgement 
   ├ Threshold value for Mark Deviation 
   └ Threshold value for pitches between marks(mm) 

 
ENVIRONMENT ─ 

Input/Out
put 

┬ Print Screen ┬ Destination ─ SD Card / Ethernet 

  │ ▶ p.40 ├ Overwrite ─ Yes / No 
  │  └No. of folders ─ 1 to 1000 
  └ Command 

Com. Log 
┬ Format ─Command / Data 

   ▶ p.152 ├ Polling view ─ No / Yes 
    ├ Keep logs ─ No / Yes 
    ├ Overwrite ─ No / Yes 
    ├ No. of Folders ─ 1 to 1000 
    └ New log file (type select) ─ Yes / No 

 

RUN MENU 
OPERATION ┬ Select Type    
 ├ Reset Statistics  

 ├ Start RUN Mode   
 ├ Stop RUN Mode   

 └ To SETUP Menu   
     

VIEW ┬ Data R/W    

 ├ Message ▶ p.12   
 ├ Window Transparency (RUN MENU)  

 └ Command Communication Log ▶ p.152  
     

LAYOUT ─ LAYOUT    
     

TOOL ┬ Eject SD Card   

 ├ Save Setting Data   

 ├ Save Image Memory   

 ├ Clear Image Memory   

 └ Information    
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OBJECT ┬ Mark0 
└ Mark1 

▶ p.45   

 

F1 
(Select 
Window) 

┬ Screen 0 - 1 ┬ Select Camera  

│ 
│ 
│ 

 ├ Switch Disp. 
│ 
│ 

─ Memory/Live / Trapezoid Adju / NG Image / Slice 
Level / Grayscale/Color / Grayscale Conv. / 
Extracted Color / Extraction Display Mode / 
Grayscale Preprocess 

│ 
│ 

├ Display 
Patterns 
│ 

─ Area / Scan Direction/ Detect Position / Display 
Condition / Geometry Calculation / 
Character/Figure Drawing / Marker Display / 
Coordinate Axis / Arrowhead of stage direction 

│ ├ Scroll   

│ ├ Magnification   

│ └ Full Screen   

├ Data R/W 0 - 1   

 ├ Message    

 └ Print Screen View   
     

F2 ─ Switch Layout   
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1.2 Main Settings 

Flow of Setup 
 

1.  Setting Stage Chapter 3  

     

2.  
Setting Communication 

(Necessary for exchanging or controlling stage 
information.) 

Chapter 4  

     

3.  
Setting Alignment Function 

(Creating the base for conducting steps 4 to 7) 
Chapter 5  

     

4.  
Setting Calibration 

(Creating the coordinates for conducting steps 5 
to 7) 

Chapter 6  

     

5.  
Setting Target 

(Setting the target position for positioning) 
Chapter 7  

     

6.  
Setting Object 

(Setting objects for positioning) 
Chapter 8  

     

7.  
Setting Judgement Criteria 

(Judging whether or not positioning is 
appropriate) 

Chapter 9  

 
 

 



 

10 

A
ppendix 



 

11 

 

Chapter 2 
 Basic Operation 
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2.1 About Windows 

2.1.1 RUN Menu and SETUP Menu 

PV240 has two windows; RUN menu for performing inspections and SETUP menu for making settings such as 
inspection conditions. 
In this section, the screen structure dedicated to PV240 is described. For details of the standard screen 
structure of PV200, refer to "Chapter 3 Basic Operation" - "3.1 About Windows" of PV200 User's Manual. 

Example of RUN Menu 
The specialized window layout for Alignment function can be selected in PV240. 
Specialized layout for Alignment: Preset Layout No. 10 "Hor.Align-2(Top)" 
Normal layout: Preset layouts Nos. 0 to 6 
Full screen layout: Preset layout Nos. 7 to 9 

 
For information on how to select layouts, set display items and adjustments, refer to "Chapter 5 Setting of 
Operation and RUN Menu" - "5.3. Setting display in RUN Menu" of PV200 User's Manual. 

 

When selecting PV240 special layout No. 10 "Hor.Align-2(Top)" 

 
 

1 Information 
display area 

a Area No. and 
comment 

Displays the source area number of the current setting 
data or comment information. 

b Type information Displays the current type and comment. 

2 Alignment message Displays the situation of PV240 or an error message when executing 
Calibration or Alignment. For details of error numbers to be displayed when 
errors occur, refer to page 151 or PV200 User's Manual. 
To switch the display of this window, select "VIEW" > "Message" in the main 
menu. To change the display position, press the F1 key and select "Message" 
in the window select menu. Press the FUNC key and select "Move" from the 
pop-up menu. 

3 OBJECT OBJECT is the menu to register object positions manually. It is used when 
object marks cannot be detected at the time of alignment. (See page 45.) 

 Others For details of display contents of the screen window and information display 
area, see page 158. 
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2.1.2 Operation by Pressing TRIG Key in RUN Menu (Manual Alignment) 

Manual Alignment is to execute Alignment with the TRIG key of the keypad. 

Using Manual Alignment detects two mark objects (moving marks for positioning) and calculates deviation 
and stage adjustment amounts. (For details of the amount of deviation, refer to page 199.) 

The target position used for this operation (target position to which the object moves) is the target 
registered position right before the execution of Manual Alignment. Manual Alignment calculates the 
amount of deviation between this position and a detected object position. 

For executing Alignment, it is necessary to register Calibration, Coordinates of target and Object Checker 
in advance. 

 

The procedure of Manual Alignment varies according to the setting of "TYPE" > "Alignment" > "Alignment" 
> "TRIG Type". 

When TRIG Type is "Mark Sync. Execution" 

Two object marks are detected by pressing the TRIG key. Alignment is executed once based on the 
detected positions. 

When TRIG Type is "Mark Async. Execution" 
Pressing the TRIG key displays the menu for selecting "Mark0 
Detection", "Mark1 Detection" and "Alignment Execution". To execute 
Alignment, the positions of two marks should be set in advance. 
Each operation is executed as below.  
 
Mark0: Detects the object mark0. 
Mark1: Detects the object mark1. 
Alignment Execution: Executes Alignment with the mark0 and mark1 detected in advance. 
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2.2 Select Menu 
Select Menu is the function to create a special menu by registering frequently used operations and setting 
items as buttons. 
Creating a special menu can reduce the number of setting processes and limit a range where an operator can 
use. 

 
• In PV240, the following two select menus can be set for each type. 

 (1) "Engineering Menu" specialized for the setting items of Alignment 
 (2) "User Menu" for customizing the menu from an empty state for normal users 
 For details, refer to “2.2.1 Engineering Menu and User Menu” on page 17. 

• For details of how to set Select Menu and standard registrable items in PV200, refer to the "Select 
Menu" chapter of PV200 User's Manual. 

Appearance of Select Menu Window 

First hierarchy of Select Menu 

 
 

1 Page number The currently-displayed page number and the total of pages are displayed. 

2 Page switchable 
mark 

By tilting the ENTER key left/right, you can switch the page. These marks are 
displayed when other pages exist. 

3 Menu hierarchy 
number and button 
name 

Hierarchy number on the page of Select Menu and button name are displayed. 
Hierarchy numbers are displayed only for Preset Menu. Items which are added to 
Select Menu using Assign Menu function are not displayed. 
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Second hierarchy of Select Menu 

 
1 The Select Menu item currently selected is displayed. 

2 The page name currently selected is displayed. 

3 Select Menu items currently selected are composed of these buttons. 

4 Display window according to menu contents. It can be switched with buttons. 

Adding Items to Select Menu 
Items registered in Select Menu can be changed or added. For details, refer to the "Select Menu" chapter of 
PV200 User's Manual. 

 
Top items of the preset engineering menu mentioned later can be assigned to Select Menu. However, 
items under the top items cannot be assigned. For details, refer to “2.2.2 Selecting Engineering/User 
Menu” on page 20. 
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Registrable Items in Select Menu 
The followings are specialized items for PV240 that can be registered by "Set Button in Select Menu. 
TYPE          
 ├ Alignment       
  ├ Stage Setting     
  ├ Calibration     
 └ Alignment     

 
INSPECTION      
 ├ Alignment      
  └ Specify No. (000 Fixed)  
  ├ Checkers Setting  
   │ ├ Comment 
  │ ├ Calibration Checker, Common Object 
  │ ├ Target Checker 
  │ └ Object Checker 
  │    
   ├ Calibration   
   │ ├ Calibration Checker  
  │ ├ Calibration data, Show details  
  │ │ └ Display Global Coordinate *  
  │ ├ Calibration Data, Manual setting  
  │ ├ Rotation Point Adj. (Mark0, Mark1)  
  │ └ Display Global Coordinate  
  │    
   ├ Target    
   │ ├ Target Checker  
  │ ├ Display Coordinates  
  │ ├ Coordinates of Registered Target ** 
  │ └ Register coordinates of target  
  │    
   ├ Object    
   │ ├ Object Checker  
  │ └ Display Coordinates  
  │  Detect Coordinates Offset  
  │    
   └ Judgement Limits    
    ├ Change Base  
   ├ Threshold of Change Judgement  
   ├ Threshold value for Mark Deviation  
   └ Threshold value for pitches between marks  

 
Preset      
 ├ Type Setting      
 ├ Calibration     
 ├ Display Global Coordinate    
 ├ Alignment Setting     
 ├ Offset Setting     
 ├ Device Setting     
 ├ Communication Setting    
└ Environment Setting    

*Registrable by Assign Menu 
(Assign Menu: Items in the pop-up menu displayed by pressing the FUNC key in a corresponding menu.) 

**Only registrable by "TYPE" > "Select Menu". Unregistrable by Assign Menu. 
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2.2.1 Engineering Menu and User Menu 

What is Engineering Menu? 
Engineering Menu is the specialized Select Menu for Alignment setting items considering the operations 
for introducing or maintaining PV240. Engineering Menu has been already registered as preset menu, and 
it will be automatically applied by selecting "Engineering" in Select Menu under TYPE. 

 
Items registered in Select Menu can be changed or added. For details, refer to the "Select Menu" chapter of 
PV200 User's Manual. 

Items of Engineering Menu (Presets) 

Page 1/3  Alignment Setting 

 

1 TYPE Setting 
To display the menus for Select Type, Camera and 
Execution Condition. 
・Select Type, Camera, Execution Condition settings 

2 Calibration <Special menu *> 
To display the menu for Calibration. 
・Stage Setting, Calibration, Checker setting 

3 Display Global Coordinate 
Global coordinates created by the calibration setting can be 
confirmed. 

4 Alignment Setting 
To display the menus in "INSPECTION" > "Alignment". The 
settings for mark detection and base position required for 
Alignment can be specified. 
・Checkers setting, Target, Object, Judgement Limits 
・Others 

5 OFFSET Setting <Special menu *> 
Offset values required for executing Alignment are input. 
・Stage Coordinates Offset, Target Coordinates Offset 
・Detect Coordinates Offset 

6 Save Setting Data, Read Setting Data 

*: The menu configuration is specialized for Engineering Menu. As for special menus, see page 16. 
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Page 2/3  Configuration 

 

1 Device Setting 
To set the device information on PV240. 
・Network, Calendar, Language  
・Camera Setting, Initialize 
* For selecting language, set "Preset Menu" in "TYPE" > 
"Select Menu". 

2 Communication Setting 
To set communication setting for external control. 
・PLC Communication, Parallel, Parallel Output, Serial 

3 Environment Setting 
To make settings relating to input/output such as General 
Output and Image Output. 
・Startup Setting, General Output, Image Output 
・Alignment Result Output, Save Image Memory, Print 
Screen 
・SD Card Setting, Command Communication Log 

4 Save Setting Data 
To save setting data. 

5 Information 

6 Update 

Page 3/3  Option setting 

 

1 Data R/W 
To display the setting menu for Data R/W. 

2 Numerical Calculation 
To display the setting menu for Numerical Calculation. 

3 Draw Character/Figure 
To display the registration menu for Draw 
Character/Figure. 

4 Judgement 
To display the menu for Judgement. 

5 Save Setting Data, Read Setting Data 

 

 
The top items of Engineering Menu (Presets) can be assigned to Select Menu. For details, refer to “Assign 
Engineering Menu (Presets) Items to Select Menu.”. 
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Special Menu (Specialized Menu Configuration for 
Engineering Menu) 

As it is the specialized Select Menu for Alignment setting items, some menu items are different from the normal 
menu window of PV240. This section describes some of those menu items. 

Example 1. "1.2 Calibration" > "Calibration" 

 

 

① 

 

Select items from "TYPE" > 
"Alignment" > "Calibration". 

②  
Select items from "TYPE" > 
"Alignment" > "Alignment". 

 

Example 2. "1.2 Calibration" > "Options" 

 

 ③  
Select items from "TYPE" > 
"Alignment" > "Alignment". 

 

Example 2. "1.3 Offset Setting" 

 

 

④  
Select items from "INSPECTION" > 
"Alignment" > "Alignment Checker 
000" > "Target" > "Detect 
Coordinates Offset". 

⑤  
Select items from "INSPECTION" > 
"Alignment" > "Alignment Checker 
000" > "Object". 
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What is User Menu? 
User Menu is the select menu for customization which is mounted as a standard function of PV200. All the 
items are empty by default. Add items as necessary. 

 
For details of the procedures for changing and adding items of Select Menu, refer to the "Select Menu" 
chapter of PV200 User's Manual. 

2.2.2 Selecting Engineering/User Menu 

1. Select "TYPE" > "Select Menu". 

2. Select "Engineering" or "User" in "Assign 
Menu". 

Select "Engineering" to register the dedicated 
preset menu automatically. Select "User" to 
register an empty select menu. 

4. To change or add menu items, customize the 
menu by "Assign Menu". 

For details of the procedures for changing and 
adding items of Select Menu, refer to the "Select 
Menu" chapter of PV200 User's Manual. 
 

 

 

 
 

 

 

 

2.2.3 Referring to Engineering/User Menu 

Referring to Engineering/User Menu of the Same 
Type 

Select Menu items can be copied between Engineering and User Menus of the same type. Use this 
function to copy the customized engineering or user menu to the other. 

1. Select "TYPE" > "Select Menu". 

2. Select either menu in "Assign 
Menu" as destination, and press 
"Copy from Engineering (User) 
menu". 

When "Engineering" is selected, 
the button "Copy from user menu" 
is displayed. When "User" is 
selected, the button "Copy from 
Engineering menu" is displayed. 
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3.  Select [Yes] when this message 
appears. 

The right figure shows the 
message when Engineering menu 
is copied to User menu.  

Referring to Engineering/User Menu of Other 
Types 

The engineering/user menu that has been set for another type can be copied to the type currently selected. 

 
Executing "Copy" copies both Engineering and User menus to an arbitrary type. It is not possible to copy 
only either of the menus. 

1. Select "TYPE" > "Select Menu". 

2. Press "Copy" in "Refer to Other Type Menus". 

3. Select the type number you want to copy. 

 
 
 
 
 
 
 
 

4. Select [Yes] when the message confirming 
overwriting appears. 

Now, copying the menu is complete. 
 

 
 

 
 

 

Assign Engineering Menu (Presets) Items to Select 
Menu 

1. Select "TYPE" > "Select Menu". 

2. Press "Set" for "Assign Menu". 
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3. Select "Page" and "Item No.", and press "Set 
Button". 

 

 

4. Press “Unset” button. 

5. Select "Preset" from the list of registered 
data. 

6. Select items you want to register as buttons 
from the list. 

 

 

 

 
Items under the top items cannot be assigned to the menu. 

2.2.4 Applying Preset Menu (Engineering Menu) Again 

Preset Menu (Engineering Menu) is automatically generated when creating a type. However, for applying 
preset menus again to the select menu which has been edited once or for using preset menus after 
switching language, the following setting is required. (At the time of switching language, the display of the 
item names in the normal menu is switched to the selected language, however, the item names in the 
select menu are not switched. The items set in the preset menu will be displayed properly by reading the 
preset menu again after switching the language.) 

Reading Preset Menu 

1. Select "TYPE" > "Select Menu". 

2. Select "Set" in "Preset Menu". 

 

 

 

 

3. Select "Yes" in the confirmation window. 

Select "Yes" to set Preset Menu to the initial 
setting. 

 
If current select menu items are not set, the 
confirmation message does not appear. 
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2.3 Result Output and Image Output to SD Card 
PV240 can output inspection results and inspection images to external devices. 

Inspection results can be output to an Ethernet, RS232-C serial interface or SD memory card using PLC 
communication or general purpose communication. For details of the result output via Ethernet and RS232-C, 
refer to the chapters 4.16.2 and 11 of PV200 User's Manual. For details of the output to an SD memory card, 
see the following. 

2.3.1 Outputting Alignment Result Data 

PV240 can output inspection results to an SD memory card. 

The following two types are available to output results. Select which otuput is necessary. 
Data Output content Setting/Output timing 

General results: 

 Date and time of inspection 

 Scan Count 

 Total Judg. 

 Judgement 

 Numerical Calculation 
It is selectable which result is output. (A 
plurality of result data is selectable.) 

Set "Output" to "Yes” for "SD Card" in 
"ENVIRONMENT" > "Input/Output" > 
"General Output" menu. 
Output timing: After execution of 
inspection 

Alignment 
results: 

Results of AAE (Auto alignment execution) 
and AAS (Auto alignment execution (Simple 
flow) commands: 

 Execution date 

 Judgement 

 Inspection time 

 No. of retries 

 Amount of deviation X 

 Amount of deviation Y 

 Amount of deviation Theta 

 Mark the amount of deviation M0 X, 
Mark the amount of deviation M0 Y 

 Mark the amount of deviation M1 X, 
Mark the amount of deviation M1 Y 

All the above results are output. 

Set "Alignment result output" in 
"ENVIRONMENT" > "Input/Output" > 
"Alignment result output" menu. 
 
Output timing: After the execution of 
AAE and AAS commands 

 
Other than the above settings, the 
alignment result following the reception 
of general-purpose communication 
command from an external device or 
PLC communication command [RTD] 
can be output. However, it can be 
output only when setting "Output" to 
"No" for "SD Card" in "General Output". 
For details of commands, refer to 
pages 110 and 150. 

 
Results are output to the following folder in either case. 

¥ Panasonic-ID SUNX Vision ¥PV240¥Result 

Outputting General Results 

1. Select 
"ENVIRONMENT" > 
“INPUT / OUTPUT” 
from the menu bar. 

 
 

2. Select “General 
Output” in 
“Input/Output” 
setting window. 
 

3. Select "Yes" for 
"Output" of "SD 
Card". 
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The message appears as the right figure. 
Select "Yes". 

 
When outputting general results to an SD memory 
card, alignment data cannot be output. 

 

4. Set "Yes" for the data to be 
output among "Date/Time", 
"Scan Count", "Total Judge.", 
"Judge." and "Nu. Calc.". 

 

5. When running an inspection in 
RUN Menu by inputting START, 
the results of the data which are 
set to "Yes" in the above step 4 
are output to an SD card. 
 

For details, refer to the chapter 
4.16.2 of PV200 User's Manual. 

 
 

 

Outputting Alignment Result (Supporting AAE and 
AAS Commands) 
When PV240 receives an auto alignment command (AAE or AAS) and executes it, the result is output. 
Output results: Execution date, Judgement, Execution time, No. of retries, Amount of deviation X, Amount of 

deviation Y, Amount of deviation Theta, Mark the amount of deviation M0 X, Mark the amount 
of deviation M0 Y, Mark the amount of deviation M1 X, Mark the amount of deviation M1 Y 

 

1. Select "ENVIRONMENT" > “INPUT / 
OUTPUT” from the menu bar. 

 
 

2. Select “Alignment result output” in 
“Input/Output” setting window. 
 

3. Select "Yes" for "Alignment result output". 

 

 

The right message appears at this time. 
Select "Yes". 

 
 

4. Select Output Conditions. 
 

"All results" (Default) 
Execution results are output regardless of the judgement 
result of alignment execution. 

"OK results only" 
Execution results are output when the judgement result 
of alignment execution is OK. 

"NG results only" 
Execution results are output when the judgement result 
of alignment execution is NG. 
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5. When running an inspection of Alignment in RUN Menu by inputting START, the result is output 
when the condition specified in the above step 4 is met. 
 

The output file name is as below. 
YYYYMMDD_ALN_RSLT.txt 

     YYMMDD :Alignment execution time 
       When a date is changed, results are output to another file. 

Result Data Output Format 
Alignment results (Execution date, Judgement, Execution time, No. of retries, Amount of deviation X, 
Amount of deviation Y, Amount of deviation Theta, Mark the amount of deviation M0 X, Mark the amount of 
deviation M0 Y, Mark the amount of deviation M1 X, Mark the amount of deviation M1 Y) are output in 
comma separated data according to the table below. 

 

Result 

No. 
of 
digits 

Output 
format Sign Unit Example 

Execution date 14 Value No YYYYMMDDhhmmss 20150121142034 

Judgement 2 String No No OK 

Execute Time 14 Value No µs 00000054423684 

Retry No. of 
times 14 Value No Times 00000000000003 

Amount of 
deviation 

X 14 Value Yes 0.00001mm 00000000199924 

Y 14 Value Yes 0.00001mm 00000000100178 

Theta 14 Value Yes 0.000001 degrees 00000000000270 

Mark the 
amount of 
deviation 
M0 

X 14 Value Yes 0.00001mm 00000000199848 

Y 14 Value Yes 0.00001mm 00000000099984 

Mark the 
amount of 
deviation 
M1 

X 14 Value Yes 0.00001mm 00000000200000 

Y 14 Value Yes 0.00001mm 00000000100372 

 
Output Examples 

20150121142034,OK,00000002478668,00000000000000,00000000199956,0000
0000100106,00000000000170,00000000199976,00000000099984,00000000199
936,00000000100228, 

←First execution of 
AAE or AAS 

20150121142039,OK,00000002364153,00000000000000,00000000199924,0000
0000100178,00000000000270,00000000199848,00000000099984,00000000200
000,00000000100372, 

←Second 
execution of AAE 
or AAS 

20150121162316,OK,00000054423684,00000000000003,00000000199994,0000
0000100030,-0000000000060,00000000200031,00000000100072,000000001999
57,00000000099988, 

←Third execution 
of AAE or AAS 

・・・  
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2.3.2 Outputting Inspection Images to External Device 

Displaying “Image Output” Setting Window 

1. Select “ENVIRONMENT” >  “Input/Output” from 
the menu bar. 

2. Select “Image Output” in “Input/Output” setting 
window. 

 

Selecting Destination 

1. Select a “SD Card” or “Ethernet” in “Destination”. 

 

 
When outputting through Ethernet to a PC, the port number 
of PV240 is “8602”. 
Ver.1.30 or later of the software for image receiving 
"Image Receiver for PV" needs to be installed in the PC 
which receives images. Also, to receive compressed 
images (available from Ver.1.40), Ver.1.50 or later of 
"Image Receiver for PV" is required. 
You can download the Image Receiver from our web site. 

http://panasonic.net/id/pidsx 

(“Products” > “Machine Vision System” > “PV240” > 
“Software”) 

Downloading the software requires a user information 
registration. 

 

Outputting to a SD memory card 

A folder named as date and time (YYMMDDHHMMSS= year, month, day, hour, minute, second) is created in 
the following path of a SD memory card and image files are saved in it. 

 

¥ Panasonic-ID SUNX Vision ¥PV240¥Image¥Output¥ 
 

Initially, decide the number of folders to save images. When using a SD memory card with PV200, it has a limit 
that up to 100 files can be saved in per folder. Thus, the specified number of folders by 100 files can be saved. 
Select either overwriting from older files or terminating image saving when the number of files reaches the 
saving limits. 

1. Select "No. of Folders”. 

The default is “10” and the range of available value is “1 to 1000”. 

2. Set "Overwrite". 

[No] (Default): Terminates image saving. 

[Yes]:  Deletes the oldest folder and all images stored in the folder and creates a new folder to 
continue saving when the number of folders reaches the limit or the space of a SD 
memory card is used up. 
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Outputting through Ethernet interface 

When the PC has an error, such as uninvoked Image Receiver and disconnection of cables, images cannot be 
output correctly. Set the operation of PV200 in such case. 

When "Output Conditions" is set to "Command Reception", two items described below cannot be selected. In 
this case, if outputting an image failed, ERROR signal will be output.  

1. Set [ERR signal ON at Output Error]. 

To turn on the ERROR signal when an error occurs, select “Yes”. (Default: No) 

2. Set [Forced Outage at Output Error]. 

[No] (Default): Continues the inspection. 

[Yes]:  Terminates the inspection. Confirm the connection following the displayed message. 
When outputting Synchronously, images can be resent. 

Specifying a Camera Image to Output 
You can set images to output or not by a camera. 

 
This setting is not allowed when "Output conditions" is set to "Alignment output". This setting is depend on the 
camera settings of the Alignment-checker. 

1. Select “Yes” in "Camera No.0 Output" of “Image Output”. 

Doing so makes setting that an inspection image of camera No.0 is output. 

2. In the same way, set a Camera No. to “Yes” to output its image. 

Selecting Output Condition 
Other than outputting by an inspection, images can be output when the specified conditions are fulfilled. 

1. Select a condition to output images in “Output Condition”. 

[Alignment 
output](default)*(a 

It outputs images when some alignment commands are executed.This can be 
set if "Destination" is set to "SD Card".（Refer to page 31.） 

[All 
Images](default):*(b: 

Images are output at every inspection. 

[NG Judgement]: To output all images of the cameras which are set to output when the 
judegment selected in “Image Output” in “Judgment” is NG.Refer to
（PV200User’sManual4.13.3）If any condition is not specified, no image is 
output. 

[At Interval]: Images are output per the specified number of inspections. 

[Command 
Reception]: 

Images are output when receiving the certain signal* from external device. 
* The signal of “Output Latest Image” assigned to one of ASSIGN0-1 and 
EXTRA0-2. 

[Judge. Per Cam.] To output images when the judegment selected in “Image Output” in 
“Judgment” for each camera is NG. Refer to（PV200User’sManual4.13.3）. 
Images are output each time when selecting "No Condition" for "Image 
Output". 
If "Destination" is set to "None", no image is output. 
Judgement formula which is used as output condition can be specified per 
camera. As only the images of the camera the result of which is NG can be 
output, the transmission time of images and the image capacity can be 
reduced. 

  *a) OutputCondition：Default of Selecting [SD]  

*b) OutputCondition： Default of Selecting[Ethernet] 
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2. Set an interval in “Interval”. 

(This is the item to set when you select "At Interval" in Step 1.) 
The range of available value is 2 to 10000. 
Specifying “10” outputs an image at the first inspection, and then outputs every ten inspections as 11th time, 
21st time, 31st time… 

Selecting Output Timing 
Set the timing to output images in "Image Output". 

Select from "Synchronous" (default), "Asyn. (image output first)", and "Asyn. (sequence first)". 

There are two settings; to output images every time one inspection is executed, to output images while PV240 
is able to output them until the start of the next inspection.Refer to PV200User’sManual6.3. 

 

Selecting Additional Information for a File Name 
A file name of image consists of the following information. Please see page 31 when "Output conditions" is set 
to "Alignment output".The setting below is not allowed.  

 
Header: Up to eight characters can be specified. 
Additional information 
0-3: 

Four types of information can be added. 

 Type No.: Type No. (000 - 255) when the image is captured. 
 Date: The date (yymmdd) of built-in calendar of PV240 when the image is captured. 
 Time: The time (hhmmss) of built-in calendar of PV240 when the image is captured. 
 Total Judgement: Total judgement of the image (OK/NG) 

* Total judgement is other than OK/NG, such as NJ = Unset 
 Judge. Per Cam. 

(Result): 
Judgement of the image per camera （CJNJ /CJ NG / CJAL） 
*CJNJ = When "Output Condition" is other than "Judge. Per Cam.” 
*CJNG = When "Output Condition" is "Judge. Per Cam.” 
*CJAL = When "Image Output" set in Judgement is "No Condition” 

Camera No.: C0 – C1 (2 digits) Number of the camera which captured the image. (Automatically 
added) 

Scan Count:  Scan count: 7 digits (Automatically added) 
 

Scan Count is reset to “0” by turning on the power, switching type, and resetting 
statistics data. If the file name of the image to be output after reset is the same as 
the file name that has been output before reset, it will be overwritten. Adding time 
or type number to the additional information prevents the file names to be the 
same.) 
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Selecting Compression Rate of Output Image  

1. Select from "None", "1/2", "1/4" and "1/8" in 
"Compression". 

 
 
 

 
Compressio
n rate Captured image size Output image size Output time 

 
 None 

• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

• 640 x 480 pixels 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

Approx. 1/2 of the case 
of "None" 

 
 
 

 

1/2 
• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

• 320 x 240 pixels 
• 800 x 600 pixels 
• 1024 x 1024 pixels 

Approx. 1/2 of the case 
of "None” 

 
 1/4 

• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048 pixels 

• 160 x 120 pixels 
• 400 x 300 pixels 
• 512 x 512 pixels 

Approx. 1/4 of the case 
of "None” 

 
 

 
1/8 

• 640 x 480 pixels (*a 
• 1600 x 1200 pixels 
• 2048 x 2048pixels 

• 80 x 60 pixels 
• 200 x 150 pixels 
• 256 x 256 pixels 

Approx. 1/8 of the case 
of "None” 

 
Compressed images can be automatically decompressed and retrieved with PV200 and PVWIN200. 
However, note that the resolution deteriorates. 

 

*a) When the used camera is 0.3-Meaga Compact Color Camera (ANPVC6030), the image size is 640 x 478 
pixels, however, the inspection is performed with an image of 640 x 480 pixels. The missing vertical two pixels 
are filled with black pixels (Gray level 0). It is the same state as when partial imaging is set with another camera. 
For the details of Partial Imaging, refer to PV200 User’s Manual. 

1. Select "Set" in "Image file setting", and enter 
"File Header" with the software keyboard. 

Default: “Image_” 

2. Select an item from five types for “Additional 
Information 0” to “Additional Information 4”. 

Select "None" when no additional information is 
needed. 
Ex.） 

File Header: Image_ 
Additional information 0: Type No. (=50) 
Additional information 1: Date (=20101215) 
Additional information 2: Total Judgement (=NG) 
Additional information 3: Judge. Per Cam. (=NG) 
Additional information 4: None 
Camera No.0 
Scan Count 100 

 
Filename: 
Image_050_101215_NG_CJNG_C0_0000100.b
mp 

 
 

Maximum number of digits for a file name is 50. 
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Selecting a Format to Output Color Images 

1. Select "Bayer Img. (.byr)" or "RGB Img. (.bmp)" in 
"Color Image Format". 

 

What is Bayer Image? 

Bayer image is an image saved in the same array as an image sensor of a color camera. 
As the file size is small and the time for saving is shortened, you should use Bayer Image to save many images. 

Files saved in this format (.byr) cannot be confirmed with general applications such as a PC. 
Bayer images can be confirmed on PV240, PVWIN240 or PVImageConverter. Its files size is smaller than that 
of RGB image (.bmp). 

 

 
Using PVImageConverter can convert a bayer image (.byr) to a RGB image (.bmp). 
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Outputting Images When Executing Alignment 
Command 

When "Output Conditions" is set to "Alignment output", 
captured images at the time of the execution of special 
commands for Alignment such as Calibration execution or 
Alignment execution can be saved in an SD memory card 
or transmission contents of commands are output to text 
files with PVWIN240. Images and text files output with this 
function can be used for simulations of Calibration or 
Alignment on a computer mounting PVWIN240. 

 
When simulating using images output with this function with 
PVWIN240, do not change the file names of images or do 
not edit the images on a computer. The output images have 
information such as the stage position and offsets at the 
time of command execution (described on the next page), 
and this information will be cleared when they are edited on 
a computer. 

 

[The following items cannot be set.] 
• Interval 
• Camera No.0 Output, Camera No.1 Output (Depend on the checker settings related to Alignment.) 

• Image File Setting (File names are predetermined.) 

• Forced Outage at Output Error 
 
List of corresponding commands 

Output Image 

CAE (Execute Calibration) 
AAE (Execute Alignment) 
AAS (Execute Auto Alignment (Simple 
flow)) 
TAG (Get Target Position) 

TAR (Request Stage Absolute Position 
Move) 
TGG (Get Target Position) 
OBG (Get Object Position) 
AOG (Get Deviation/Stage Adjustment 
Amount) 

Outputting Text 
Data 

ACL (Execute Alignment for 1 camera) 
AZG (Get Stage Adjustment Amount)  
GDV (Get Deviation) 

TGS (Set Target Position) 
SRP (Move Rotation Center) 
SCT (Change Threshold of Change 
Judgement) 

 
Function 

• Image data captured when executing a specific command for Alignment is output to an SD memory 
card. 

• As for a command which is not for capturing images, a general-purpose communication command 
including each parameter is output as text because image data cannot be output. 

 
Output destination folder 

Saves images in separate folder for each command in ¥Panasonic-ID SUNX 
Vision¥PV240¥Image¥Output. 

 

[Timing of folder creation] 

A folder is created when executing a command of "List of corresponding command" after executing any 
of the following events. 
• When selecting type (Switching setting data) 
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• When inserting an SD card 

• When starting up 

• When completing command CAE (Execute Calibration), AAE (Execute Auto Alignment) or AAS 
(Execute Auto Alignment (Simple flow))  
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Files are named according to the following formats when each command is executed. 

 Image 
file 
 
(Output 
as 
bitmap 
or 
bayer 
image) 

hhmmss_###_Img_Command_Mark.bmp 
hhmmss: Time (Hour-Minute-Second) 
###: Serial number (The number of executions of alignment command. A number is 

added to the name of each file in the order of being written to a folder as 001, 002, 
003, ... 100.) 

Command: Sign such as CAE or AAE. (Mark numbers 00 to 02 are added to CAE, OBG 
and TGG. 00: Mark0, 1 / 01: Mark0 / 02: Mark1) 

Mark: Any of M0, M1 and M0M1 
Extension: bmp or byr 

Command Example of file name 
CAE (Execute Calibration)、 
AAE (Execute Auto Alignment) 
AAS (Execute Auto Alignment (Simple flow)) 
TAG (Get Target Position) 
TAR (Request Stage Absolute Position Move) 
TGG (Get Target Position) 
OBG (Get Object Position) 
AOG (Get Deviation/Stage Adjustment Amount) 

hhmmss_001_Img_CAE00_M0.bmp 
hhmmss_001_Img_AAE_M1.bmp  
hhmmss_002_Img_AAS_M1.bmp  
- - - - - - - - - - - -   
- - - - - - - - - - - - 
hhmmss_003_Img_TGG00_M0.bmp 
hhmmss_004_Img_OBG01_M0.bmp 
hhmmss_005_Img_AOG_M0.bmp 

 The following information is added to these images automatically. 

 Information indicating whether or not alignment is held 

 Alignment mark number 

 Current stage position (XYTheta / UVW / UV + Distance between the center of 
stage and the center of motor axis) 

 Stage offset (Value of parameter added by the transmission of command such as 
AAE or AAS) 

Text 
file 

hhmmdd_###_Str_Command.txt 
hhmmss: Time (Hour-Minute-Second) 
###: Serial number (The number of executions of alignment command) 
Command: Sign such as ACL or AZG 

Command Example of file name 
ACL (Execute Alignment for 1 camera) 
AZG (Get Stage Adjustment Amount) 
GDV (Get Deviation) 
TGS (Set Target Position) 
SRP (Move Rotation Center) 
SCT (Change Threshold of Change Judgement) 

hhmmss_006_Str_ACL.txt 
hhmmss_008_Str_AZG.txt 
hhmmss_009_Str_GDV.txt 
hhmmss_010_Str_TGS.txt 
hhmmss_011_Str_SRP.txt 
hhmmss_012_Str_SCT.txt 

 General purpose communication commands received by PV240 are output to these text files. 
(Even when PV240 receives a command for PLC communication, character strings of general 
purpose communication command are output to text files.) 

 Command Example of command 
 ACL(* &ACL00+00000000004+00000000005+00000011111¥ 

  &TAG-00000000001-00000000011-0000000011100¥ 

 AZG &AZG+00000000331+00000000332+00000000333+00000000000+0000000000000¥ 

 GDV &GDV00+00000000224+00000000225+00000022221¥ 

 TGS &TGS01+00004444444+00003335555¥ 

  &TGS02+00004444444+00003335555¥ 

 SRP &SRP10+00000200000-00000200000¥ 

  &SRP20+00000200000+00000200000¥ 

 SCT &SCT00+00001000000+00002000000+00003000000¥ 

 *) In the case of ACL, the commands for obtaining a current position and running offset are 
output in two lines. 
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Specifications for each command 
The ways of outputting files when each command is executed are as follows. 

CAE (Execute Calibration) No Rotation Point Adjustment 
Image files are output to the folder :YYMMDDhhmmss_###_ Calibration. Images are output to a new folder 
when CAE command is executed. 
 
When executing for both Mark0 and Mark1. 

Send & C A E 0 0 ¥ (SUM) CR 
 

Captures images at the origin position and the moving position from the origin by +X, +Y or +Theta for Mark0 
and Mark1, and outputs the images. 

Output file 

HHMMSS_001_Img_CAE00_M0.bmp Mark0 Origin 
HHMMSS_001_Img_CAE00_M1.bmp Mark1 Origin 
HHMMSS_002_Img_CAE00_M0.bmp Mark0 +X 
HHMMSS_002_Img_CAE00_M1.bmp Mark1 +X 
HHMMSS_003_Img_CAE00_M0.bmp Mark0 +Y 
HHMMSS_003_Img_CAE00_M1.bmp Mark1 +Y 
HHMMSS_004_Img_CAE00_M0.bmp Mark0 +Theta 
HHMMSS_004_Img_CAE00_M1.bmp Mark1 +Theta 
HHMMSS_005_Img_CAE00_M0.bmp Mark0 -Theta 
HHMMSS_005_Img_CAE00_M1.bmp Mark1 -Theta 

 
When executing for Mark0 

Send & C A E 0 1 ¥ (SUM) CR 
 

Captures images at the origin position and the moving position from the origin by +X, +Y or +Theta for Mark0, 
and outputs the images. 

Output file 

HHMMSS_001_Img_CAE01_M0.bmp Mark0 Origin 
HHMMSS_002_Img_CAE01_M0.bmp Mark0 +X 
HHMMSS_003_Img_CAE01_M0.bmp Mark0 +Y 
HHMMSS_004_Img_CAE01_M0.bmp Mark0 +Theta 
HHMMSS_005_Img_CAE01_M0.bmp Mark0 -Theta 

 
 
When executing for Mark1 

Send & C A E 0 2 ¥ (SUM) CR 
 

Captures images at the origin position and the moving position from the origin by +X, +Y or +Theta for Mark1, 
and outputs the images. 

Output file 

HHMMSS_001_Img_CAE02_M1.bmp Mark1 Origin 
HHMMSS_002_Img_CAE02_M1.bmp Mark1 +X 
HHMMSS_003_Img_CAE02_M1.bmp Mark1 +Y 
HHMMSS_004_Img_CAE02_M1.bmp Mark1 +Theta 
HHMMSS_005_Img_CAE02_M1.bmp Mark1 -Theta 
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CAE (Execute Calibration) with Rotation Point Adjustment 

Image files are output to the folder :YYMMDDhhmmss_###_ Calibration. Images are output to a new folder 
when CAE command is executed. When the number of files exceeds 100, a new folder is output from 
number 101. 
 
When executing for both Mark0 and Mark1. 

Send & C A E 0 0 ¥ (SUM) CR 
 

Captures images at the origin position and the moving position from the origin by +X, +Y or +Theta for Mark0 
and Mark1, and outputs the images. 

Output file 

HHMMSS_001_Img_CAE00_M0.bmp Mark0 Origin  
HHMMSS_001_Img_CAE00_M1.bmp Mark1 Origin  
HHMMSS_002_Img_CAE00_M0.bmp Mark0 +X  
HHMMSS_002_Img_CAE00_M1.bmp Mark1 +X  
HHMMSS_003_Img_CAE00_M0.bmp Mark0 +Y  
HHMMSS_003_Img_CAE00_M1.bmp Mark1 +Y  
HHMMSS_004_Img_CAE00_M0.bmp Mark0 +Theta  
HHMMSS_004_Img_CAE00_M1.bmp Mark1 +Theta  
HHMMSS_005_Img_CAE00_M0.bmp Mark0 -Theta  
HHMMSS_005_Img_CAE00_M1.bmp Mark1 -Theta  

 HHMMSS_006_Img_CAE00_M0.bmp Mark0 Adjustment 1  
 HHMMSS_007_Img_CAE00_M0.bmp Mark0 Adjustment 2  
 HHMMSS_008_Img_CAE00_M0.bmp Mark0 Adjustment 3  
 … Mark0 Adjustment…  
 HHMMSS_099_Img_CAE00_M0.bmp Mark0 Adjustment 94  
 HHMMSS_100_Img_CAE00_M0.bmp Mark0 Adjustment 95  
 HHMMSS_001_Img_CAE00_M0.bmp Mark0 Adjustment 96 Output to a new folder 
 HHMMSS_002_Img_CAE00_M0.bmp Mark0 Adjustment 97  
 HHMMSS_003_Img_CAE00_M0.bmp Mark0 Adjustment 98  
 HHMMSS_004_Img_CAE00_M0.bmp Mark0 Adjustment 99  
 HHMMSS_005_Img_CAE00_M0.bmp Mark0 Adjustment 100  
 HHMMSS_006_Img_CAE00_M1.bmp Mark1 Adjustment 1  
 HHMMSS_007_Img_CAE00_M1.bmp Mark1 Adjustment 2  
 … Mark1 Adjustment…  
 HHMMSS_099_Img_CAE00_M1.bmp Mark1 Adjustment 94  
 HHMMSS_100_Img_CAE00_M1.bmp Mark1 Adjustment 95  
 HHMMSS_001_Img_CAE00_M1.bmp Mark1 Adjustment 96 Output to a new folder 
 HHMMSS_002_Img_CAE00_M1.bmp Mark1 Adjustment 97  
 HHMMSS_003_Img_CAE00_M1.bmp Mark1 Adjustment 98  
 HHMMSS_004_Img_CAE00_M1.bmp Mark1 Adjustment 99  
 HHMMSS_005_Img_CAE00_M1.bmp Mark1 Adjustment 100  

 
When executing for Mark0 

Send & C A E 0 1 ¥ (SUM) CR 
 

Captures images at the origin position and the moving position from the origin by +X, +Y or +Theta for Mark0, 
and outputs the images. 

Output file 

HHMMSS_001_Img_CAE01_M0.bmp Mark0 Origin  
HHMMSS_002_Img_CAE01_M0.bmp Mark0 +X  
HHMMSS_003_Img_CAE01_M0.bmp Mark0 +Y  
HHMMSS_004_Img_CAE01_M0.bmp Mark0 +Theta  
HHMMSS_005_Img_CAE01_M0.bmp Mark0 -Theta  

 HHMMSS_006_Img_CAE01_M0.bmp Mark0 Adjustment 1  
 HHMMSS_007_Img_CAE01_M0.bmp Mark0 Adjustment 2  
 …    
 HHMMSS_099_Img_CAE01_M0.bmp Mark0 Adjustment 94  
 HHMMSS_100_Img_CAE01_M0.bmp Mark0 Adjustment 95  
 HHMMSS_001_Img_CAE01_M0.bmp Mark0 Adjustment 96 Output to a new folder 
 HHMMSS_002_Img_CAE01_M0.bmp Mark0 Adjustment 97  
 HHMMSS_003_Img_CAE01_M0.bmp Mark0 Adjustment 98  
 HHMMSS_004_Img_CAE01_M0.bmp Mark0 Adjustment 99  
 HHMMSS_005_Img_CAE01_M0.bmp Mark0 Adjustment 100  
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When executing for Mark1 

Send & C A E 0 2 ¥ (SUM) CR 
 

Captures images at the origin position and the moving position from the origin by +X, +Y or +Theta for Mark1, 
and outputs the images. 

Output file 

HHMMSS_001_Img_CAE02_M1.bmp Mark1 Origin  
HHMMSS_002_Img_CAE02_M1.bmp Mark1 +X  
HHMMSS_003_Img_CAE02_M1.bmp Mark1 +Y  
HHMMSS_004_Img_CAE02_M1.bmp Mark1 +Theta  
HHMMSS_005_Img_CAE02_M1.bmp Mark1 -Theta  

 HHMMSS_006_Img_CAE02_M1.bmp Mark1 Adjustment 1  
 HHMMSS_007_Img_CAE02_M1.bmp Mark1 Adjustment 2  
 …    
 HHMMSS_099_Img_CAE02_M1.bmp Mark1 Adjustment 94  
 HHMMSS_100_Img_CAE02_M1.bmp Mark1 Adjustment 95  
 HHMMSS_001_Img_CAE02_M1.bmp Mark1 Adjustment 96 Output to a new folder 
 HHMMSS_002_Img_CAE02_M1.bmp Mark1 Adjustment 97  
 HHMMSS_003_Img_CAE02_M1.bmp Mark1 Adjustment 98  
 HHMMSS_004_Img_CAE02_M1.bmp Mark1 Adjustment 99  
 HHMMSS_005_Img_CAE02_M1.bmp Mark1 Adjustment 100  

 

AAE (Execute Auto Alignment) 
Image files are output to the folder :YYMMDDhhmmss_###_ Alignment. After outputting an image by AAE 
command, outputting an image by the next arbitrary alignment command is performed to a new folder. 
 
When using two cameras 

Send  P1 to P4: Parameters & A A E P1 P2 P3 P4 ¥ (SUM) CR 

 
No. of retries: When setting one or a larger number (The way of succeeding Alignment by one retry.) 

Output file 

Flow File name  
>TGG HHMMSS_001_Img_TGG00_M0.bmp Mark0 
 HHMMSS_001_Img_TGG00_M1.bmp Mark1 
AAE   
TAG HHMMSS_002_Img_AAE_M0.bmp Mark0 
 HHMMSS_002_Img_AAE_M1.bmp Mark1 
TAR (1st movement)   
TAG HHMMSS_003_Img_AAE_M0.bmp Mark0 
 HHMMSS_003_Img_AAE_M1.bmp Mark1 
TAR (2nd movement)   

 TAG HHMMSS_004_Img_AAE_M0.bmp Mark0 
  HHMMSS_004_Img_AAE_M1.bmp Mark1 
 AAE Response   

 
When using one camera and two marks 
No. of retries: When setting one or a larger number (The way of succeeding Alignment by one retry.) 

Output file 

Flow File name  
>TGG HHMMSS_001_Img_TGG00_M0M1.bmp Marks0,1 
AAE   
TAG HHMMSS_002_Img_AAE_M0M1.bmp Marks0,1 
TAR (1st movement)   
TAG HHMMSS_003_Img_AAE_M0M1.bmp Marks0,1 
TAR (2nd movement)   

 TAG HHMMSS_004_Img_AAE_M0M1.bmp Marks0,1 
 AAE Response   
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AAS (Execute Auto Alignment (Simple Flow)) 

Image files are output to the folder :YYMMDDhhmmss_###_ Alignment. After outputting an image by AAS 
command, outputting an image by the next arbitrary alignment command is performed to a new folder. 
 

Send P1 to P4: Parameters & A A S P1 P2 P3 P4 ¥ (SUM) CR 

 
When using two cameras 
No. of retries: When setting one or a larger number (The way of succeeding Alignment by one retry.) 

Output file 

Flow File name  
>TGG HHMMSS_001_Img_TGG00_M0.bmp Mark0 
 HHMMSS_001_Img_TGG00_M1.bmp Mark1 
AAS   
TAG HHMMSS_002_Img_AAS_M0.bmp Mark0 
 HHMMSS_002_Img_AAS_M1.bmp Mark1 
TAR (1st movement)   
   
(Object detection) HHMMSS_003_Img_AAS_M0.bmp Mark0 
 HHMMSS_003_Img_AAS_M1.bmp Mark1 

 TAR (2nd movement)   
    
 (Object detection) HHMMSS_004_Img_AAS_M0.bmp Mark0 
  HHMMSS_004_Img_AAS_M1.bmp Mark1 
 AAE Response   

 
 
When capturing two marks with one view range 
No. of retries: When setting one or a larger number (The way of succeeding Alignment by one retry.) 

Output file 

Flow File name  
>TGG HHMMSS_001_Img_TGG00_M0M1.bmp Marks0,1 
AAS   
TAG HHMMSS_002_Img_AAS_M0M1.bmp Marks0,1 
TAR (1st movement)   
(Object detection) HHMMSS_003_Img_AAS_M0M1.bmp Marks0,1 

 TAR (2nd movement)   
 (Object detection) HHMMSS_004_Img_AAS_M0M1.bmp Marks0,1 
 AAE Response   
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TGG (Get Target Position) 

Image files are output to the folder :YYMMDDhhmmss_###_ Alignment. 
 
When capturing two marks 

Send P2, P3: Parameters & T G G 0 0 P2 P3 ¥ (SUM) CR 

 

When using two cameras 

Output file 

Flow File name  
>TGG HHMMSS_001_Img_TGG00_M0.bmp Mark0 
 HHMMSS_001_Img_TGG00_M1.bmp Mark1 
<TGG   

 
When capturing two marks with one view range 

Output file 
Flow File name  

>TGG HHMMSS_001_Img_TGG01_M0M1.bmp Marks0,1 
<TGG   

 
 
 
When capturing one mark only (Mark0) 

Send P2, P3: Parameters & T G G 0 1 P2 P3 ¥ (SUM) CR 

 

Output file 
Flow File name  

>TGG HHMMSS_001_Img_TGG01_M0.bmp Mark0 
<TGG   

 
 
When capturing one mark only (Mark1) 

Send P2, P3: Parameters & T G G 0 2 P2 P3 ¥ (SUM) CR 

 

Output file 
Flow File name  

>TGG HHMMSS_001_Img_TGG02_M1.bmp Mark1 
<TGG   
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OBG (Get Object Position) 

Image files are output to the folder :YYMMDDhhmmss_###_ Alignment. 
 
 
When capturing two marks 

Send & O B G 0 0 ¥ (SUM) CR 
 

 
When using two cameras 

Output file 

Flow File name  
>OBG HHMMSS_001_Img_OBG00_M0.bmp Mark0 
 HHMMSS_001_Img_OBG00_M1.bmp Mark1 
<OBG   

 
When capturing two marks with one view range 

Output file 
Flow File name  

>OBG HHMMSS_001_Img_OBG01_M0M1.bmp Marks0,1 
<OBG   

 
 
When capturing one mark only (Mark0) 

Send & O B G 0 1 ¥ (SUM) CR 
 

 

Output file 
Flow File name  

>OBG HHMMSS_001_Img_OBG01_M0.bmp Mark0 
<OBG   

 
 
When capturing one mark only (Mark1) 

Send & O B G 0 2 ¥ (SUM) CR 
 

 

Output file 
Flow File name  

>OBG HHMMSS_001_Img_OBG02_M1.bmp Mark1 
<OBG   

 
 
 
 



 

40 

2.4 Useful functions 

2.4.1 Copying the Screen Display (Print Screen) 

In almost screens, whether RUN menu or SETUP menu, the contents displayed on the entire screen can be 
copied and output to a SD card. The images are saved as bitmap. 

Destination can be changed to Ethernet to save the images directly into a PC. 

1. Display an image to copy. 

2. Hold down the FUNC key for two seconds or more. 

In the key guide field, a message of “PRINT SCREEN” appears and the screen is copied. 
When the message disappears, printing the screen is complete. 

 
 

If the message does not appear in the key guide area, an image cannot be copied in the current screen. 
When an image is copied in the full-screen layout, you cannot see the result as the key guide area is not 
displayed. Note that the copied image may not be saved due to the condition of the destination to output 
(SD memory card or Ethernet). 

About Image File Name 

Example of file name: 071215_150848_0.bmp 
 

Saving image file name consists of date; 6-digit (YYMMDD), time; 6-digit (HHMMSS), and image number; 
1-digit (N). Between each of the information, “_” (underscore) is inserted. 

• Date and Time: 
Calendar data of PV240 

• Image number:  
0 to 9. Numbered consecutively within the same second 

 
When print screen command with a file name is received, the file name becomes arbitrary(given file name) 
and is different from the format above.（Please Refer to Chapter4) 

About Image File Format 

File format: Bitmap 

Image size: 640 x 480 pixels 

Color depth: 24 bits 

About Save Folder of Image Files 

For SD card: ¥Panasonic-ID SUNX Vision¥PV240¥Screen¥ YYYYMMDDHHMMSS 

When you run the print screen, folder with executed date is automatically created, and image files are 
saved in that folder. 
Saving folder name consists of date; 8-digit (YYYYMMDD), time; 6-digit (HHMMSS). 
 
Ex.：20140403110531 
 

 
The maximum number of print screen files in one folder is 100. 
Even though date is changed, a newer folder cannot be created unless a folder is filled with 100 files.  

For Ethernet: Specify with Image Receiver. 
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2.4.2 Changing Saving Conditions of Print Screen 

 

Changing Destination of Image Files 

1. Select “ENVIRONMENT” >  “INPUT / OUTPUT” > ”Print Screen”from the menu bar. 

2. Select "Destination". 

SD card (default): Saves in the SD card inserted in PV240. 
Ethernet: Outputs to Ethernet. Saves in devices such as a PC connected with an Ethernet cable. 
 

 
When selecting "Ethernet", "Overwrite" and "No. of Folders" are not selectable. 

Setting the Number of Folders 
For using an SD memory card, specify the number of storage folders. Up to 100 print screen image files 
can be saved in one folder. 

1. Select "ENVIRONMENT" > “Input/Output” > "Print Screen" from the menu bar. 

2. Specify "No. of Folders". 

Default: 10 
Setting range: 1 to 1000 

 

Setting for Overwriting Print Screen  
Select whether or not folders are overwritten when executing Print Screen exceeding the number of folders 
specified in "No. of Folders". 

1. Select "ENVIRONMENT" > “Input/Output” > "Print Screen" from the menu bar. 

2. Select "Yes" or "No" for "Overwrite". 

“Yes”: Deletes the oldest folder automatically, and saves image files into a new folder. 
"No": Terminates the output of print screen images. Image files will not be saved after the execution. 
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2.4.3 Displaying Print Screen Images on Monitor 

Captured print screen images and images which meet the following conditions are displayed on the 
monitor when the operation stops. The print screen images can be displayed and confirmed from a SD 
card in the PV without a PC. The order of display depends on the file system. 

 
About Save Folder of Image Files, Refer to Chapter 2.4.1 Copying the Screen Display (Print Screen):Page 40 

 

 
 

1 File Name Displays the file name of a print screen image. 

2 No. of counts Displays the number of images which are currently displayed and the total 
number of images. 

3 Key guide Displays the operation keys when a print screen image is displayed. 

 

In SETUP menu 

1. Press the F1 key and select "Print Screen 
View". 
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2. Select a folder in which images are saved. 

Select a folder from the Screen folder, move 
the cursor to the image file you want to view, 
and press the <ENTER> key. 

 

If the file name exceeds maximum number of 
characters for the text box (indicated red 
rectangle in the right figure), it will not be 
displayed properly. Please note if you want to 
change the file name directly on the PC, or to 
save a file with its file name by PS 
command(P101). 

 

3. Print screen images are displayed on the monitor. 

F1 key Auto play images and stop.The time interval for auto play is two seconds. 
It will automatically stop after the last image is displayed. 

F2 key Go to the next image. 

F3 key Back to the previous image. 

CANCEL key Exit Print Screen View, and back the "Select Folder" window. 
 

When no print screen image exist in the folder, 
the right error message appears. 

 
 
 

In RUN menu 

1. Stop the operation when it is operating. 
Select "OPERATION" > "Stop RUN Mode" 
to stop the operation. 

 
 

2. Press the F1 key and select "Print Screen 
View". 

 

 

3. Select a folder in which images are saved. 

4. Print screen images are displayed on the monitor. 

F1 key Auto play images and stop. 

F2 key Go to the next image. 

F3 key Back to the previous image. 

CANCEL key Exit Print Screen View, and back the "Select Folder" window. 
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The print screen view is only available when operation stops. 
The right error message appears by executing the print screen view during the operation. 
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2.4.4 Setting Object Position in RUN Menu (Manual Registration) 

Object position is a target mark for Alignment. This is positioned with the target as a target position when 
executing Alignment. "OBJECT" is used to set the object position manually (with the keypad). The object 
position specified here is valid for one alignment. 

 

The specified position is the object position 
for the executed alignment. 

 

 

 

 

 

Once it is specified, Alignment is 
automatically executed with the specified 
object position information. After the 
execution, the deviation and stage 
adjustment amounts are calculated.  

Setting Procedure 

1. Press the TRIG key to capture an image. 
 

When setting "TYPE" > "Alignment" > 
"Alignment" > "TRIG Type" >"Mark Async. 
Execution", select Mark0 or Mark1, which 
image is captured. 

 

2. Select "OBJECT". 
 

3. Select a mark to register. 
 

4. The camera image for the selected mark 
is displayed. The window becomes a 
memory display automatically, and the 
image captured in advance is displayed. 
 
Move an orange cross mark to the object 
position. 

 

 
 

 

 
When setting "Target Cross Drawing" to "Yes" in "TYPE" > "Alignment" > "Alignment", a cross is 
displayed at the target position, and it is set as a mark. The cross is displayed in pink for Mark0 and 
in blue for Mark1. 

5. Pressing the CANCEL key goes back to RUN Menu. The object position of a selected mark is 
determined at this time. If the other mark is detected at this point, alignment is automatically 
executed with this data, and the deviation and stage adjustment amounts are calculated. 
 

6. After the execution of alignment, move the stage based on the calculated deviation and stage 
adjustment amounts and perform positioning. 

7. Once the position is determined, the cursor returns to RUN Menu, and the deviation and stage 
adjustment amounts are calculated. 
Move the stage based on the calculated values. 
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2.5 Difference from Standard PV200 

Many functions of PV240 are the same as those of the standard PV200. Therefore, refer to the PV200 User's 
Manual for information on the common functions. The difference between PV240 and the standard PV200 
are as follows. 

SETUP Menu 
ENVIRONMENT 

 
The specifications of the following items in 
"ENVIRONMENT" are different from those of 
PV200. 

"System Settings" > "Operation"  

 

 

[Function which is available for PV200 and 
unavailable for PV240] 

- Continuous Inspection 

 

"Input/Output"  

 

[Special functions for PV240] 

"Alignment result output" 

“Command Com. Log” 

Special communication commands for Alignment 

[Functions slightly different from those of PV200] 

”Image Output” 

"Print Screen" 

[Function which is available for PV200 and unavailable for PV240] 

"Serial" > "A Series Compatible" 

 

 "Alignment result output"  Special menu for 
PV240 

 

 Page 23 

"Command Com. Log"  Special menu for 
PV240 

 

 Page 152 
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--- “Serial” 

 
[Function which is available for PV200 and 
unavailable for PV240] 

"A Series Compatible" 

"Image Output" 

 "Print Screen" 

 
[Special functions for PV240] 

“Overwrite” (Yes/No) 

“No. of Folders”  

 Page 41 

 [Special functions for PV240] 

Choice of "Output Conditions": "Alignment 
output" 

  
Image Output: Page 26 

Alignment Output: Page 31 

 [Special communication commands for 
Alignment] 

 General communication 
command: Page 79 
PLC communication command: 
Page 129 
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TYPE 

  
The specifications of the 
following items in "TYPE" are 
different from those of PV200. 

"Type Setting" > "Camera" "Data R/W" 

 
[Functions which are available for PV200 and 
unavailable for PV240] 

Camera Trigger 

Calibration (This is different from the calibration 
in PV240.) 

 Page 163 

[Functions slightly different from those of PV200] 

White Balance 
(In PV240, each RGB gain is set in the 
range of 1.00 to 3.00. "Offset" is not 
available.) 

 
[Special functions for PV240] 

"Presets" is provided. (Values have been set 
in Data R/W in advance.)  

 Page 208 

"Select Menu" 

 
[Functions slightly different from those of 
PV200] 

Preset Menu is provided in which functions 
frequently used for Alignment have been 
registered as buttons to improve operability 
of PV240. Also, two types of select menus 
can be created and used. 

 Page 14 

"Alignment"  Special menu for PV240  

 

 

 
Stage Setting: Page 54 

Calibration: Page 165 

Alignment: Page 156 
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INSPECTION 

 
A special menu for PV240, "Alignment" is 
available in "INSPECTION". 

"Alignment"  Special menu for PV240 

 

Setting for conducting inspections 
of Alignment 

 
Checker Setting: Page 162 

Calibration: Page 166 

Target: Page 182 

Object: Page 192 

Judgement Limits: Page 198 

 

“Judgement” 

 

 

[Functions slightly different from 
those of PV200] 

The following expression is 
automatically set in JDC000 
when a type is created. 

 
JDC000 = ALN000_JUDGE 

 

Condition: JDG and Checker 
No.000 is automatically set in 
"Total Judge." when a type is 
selected. They can be 
changed as necessary. 

 
Pages 157, 204 
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TOOL 

 
A special menu for PV240, "Alignment" 
is available in "TOOL". 

"General"  

 

"Account Setting" equipped with the 
standard PV200 is not available for 
PV240. 

 

RUN Menu 

 

In RUN Menu, there are special 
functions for PV240 "OBJECT" in 
the menu bar and some special 
items in "VIEW" and "LAYOUT". 

 

[Functions which are available for 
PV200 and unavailable for PV240] 

"DEBUG" 

"Account" 

 

"VIEW" "LAYOUT" 

 
"Message" is a special function for PV240. It is used to 
switch the window display showing alignment messages. 

 Page 12 

 
The layout No.10 is a special layout for 
Alignment. 

 Page 12 

"OBJECT"  Special function for PV240 

 

  
This function is used to set object positions manually. 

 Page 45 
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Chapter 3 
 Stage Setting 
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3.1 Supported Stages 

PV240 supports the following five types of stages. 

XYTheta Stage XThetaY Stage YThetaX Stage XTheta Stage 

    
UVW Stage    

 

  

 

 

XYTheta, XThetaY, YthetaX and XTheta stages correspond to the following stage configurations. 
 

XYTheta, XThetaY, YThetaX and XTheta Stages 

 
 

 XYTheta 
Stage 

XThetaY 
Stage 

YThetaX 
Stage 

XTheta 
Stage 

A Theta Stage Y Stage X Stage Theta Stage 

B Y Stage Theta Stage Theta Stage - 

C X Stage X Stage Y Stage X Stage 

* X Stage and Y Stage can be replaced. 
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Line Theta Stage 

 

 
 

Calculates the motor movement amount in the case of Theta 
rotation by setting the distance between the centers of the 
stage rotation and the motor axis (L). 

 

 XYTheta Stage XThetaY Stage YThetaX Stage 

A Line Theta 
Stage 

Y Stage X Stage 

B Y Stage Line Theta 
Stage 

Line Theta 
Stage 

C X Stage X Stage Y Stage 

 XTheta Stage 

A Line Theta 
Stage 

B - 

C X Stage 

* X Stage and Y Stage can be replaced. 
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3.2 Setting Stages 
Set the items related to the stage types and the specifications. This setting is made from "TYPE" > 
"Alignment" > "Stage Setting" in Normal Menu. In Engineering Menu, it is made from "Calibration" on the 
top page. 

 
 

Normal Menu Engineering Menu 

 

3.3 Selecting Stage Type 

Select a type of stages to be used for Alignment. 

 

 
 

Used stage Stage type Necessary setting in "Stage Setting" menu 

UVW Stage UVW Stage Set "UVW Pin Position (mm)". 

XYTheta (YXTheta) Stage 
XYTheta 
Stage 

Select "Rotation" for "Theta Axis". 

XYTheta (YXTheta) Line 
Theta Stage 

Select "Straight Line" for "Theta Axis", and set 
"Theta Axis Length (mm)". 

XThetaY Stage 
XThetaY 
Stage 

Select "Rotation" for "Theta Axis". 

XTheta Y Line Theta Stage Select "Straight Line" for "Theta Axis", and set 
"Theta Axis Length (mm)". 

YThetaX Stage 
YThetaX 
Stage 

Select "Rotation" for "Theta Axis". 

YThetaX Line Theta Stage Select "Straight Line" for "Theta Axis", and set 
"Theta Axis Length (mm)". 

XTheta Stage 
XTheta 
Stage 

Select "Rotation" for "Theta Axis". 

XTheta Line Theta Stage Select "Straight Line" for "Theta Axis", and set 
"Theta Axis Length (mm)". 
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3.4 Setting Theta Axis 
The setting for Theta Axis is to distinguish Rotation Stage or Line Theta Stage. This setting is required for 
converting the Theta adjustment amount calculated by PV240 to movement amount data. 

 

 
 

 

Used stage "Theta Axis" setting 

XYTheta (YThetaX) Stage 

XThetaY Stage 

YThetaX Stage 

XTheta Stage 

Select "Rotation". 

XYTheta (YThetaX) Line 
Theta Stage 

XTheta Y Line Theta Stage 

YThetaX Line Theta Stage 

XTheta Line Theta Stage 

Select "Straight Line". 
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3.5 Setting Theta Axis Length (mm) 
For using Line Theta Stage, set the distance between the centers of stage rotation and motor axis as 
"Theta Axis Length". This setting is required for converting the Theta adjustment amount calculated by 
PV240 to movement amount data. 

 

 

 

The distance between the centers of stage 
rotation and motor axis (L) is the value of 
"Theta Axis Length". 
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3.6 Setting UWV Pin Position (mm) 
These values should be input for converting the XYTheta adjustment amounts calculated by PV240 to 
UVW axes. 

 

 

 

■Example 
 
Condition 
U axis coordinate: ( 100, 200 ) 
V axis coordinate: ( -100, -200 ) 
W axis coordinate: ( 100, -200 )  
* The stage center (Tx, Ty) is considered as (0, 0). 
 
Input value 
UVW pin position UX=100 
UVW pin position UY=200 
UVW pin position VX=-100 
UVW pin position VY=-200 
UVW pin position WX=100 
UVW pin position WX=-200 
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3.7 Setting Stage Operation Direction 

The operation direction of stages should be specified for 
performing alignment in the right direction. 

The specified items are "Stage +XY Direction" and 
"Stage +Theta Direction". 

 

These positive direction of XY axes and rotation direction 
can be distinguished automatically by Calibration when 
global coordinates are established, however, they can be 
specified directly by setting the menu as necessary.  

Set whether or not they are automatically distinguished 
at the time of Calibration in the following "Stage Direction 
Automatic Judgement". Refer to Chapter 3.7.1. For 
details of the operation directions of stages, refer to page 
60. 

 

3.7.1 Stage Direction Automatic Judgement 

This item is set to distinguish the positive direction of XY axes of stages or rotation direction automatically 
when global coordinates are created by Calibration. 
(Confirm the rotation direction by "Display Global Coordinate" after the execution of Calibration just to make 
sure. If the rotation direction is inappropriate, change the setting of rotation direction.) 

When setting "Stage Direction Automatic Judgement" to "No", "Stage +XY Direction" and "Stage +Theta 
Direction" should be specified. Refer to Chapter 3.7.2. 

 

 

Procedure for Setting a Correct Stage Direction 

1. Set "Stage Direction Automatic Judgement" to "Yes". 

2. Set a large angle as much as possible for "Stage MAX Distance" ("TYPE" > "Alignment" > 
"Calibration" > Theta of "Stage MAX Distance"). (For details of the setting procedure, see “6.2.1 
Stage Movement” on page 165.) 
 

3. Start Calibration. 
(For details of the execution of Calibration, see the following pages. 
The execution by a controller: Pages 81, 84, 132, 133. The manual execution: Page 168) 
PV240 distinguishes the positive direction of XY axes of the stage and rotation direction while 
executing Calibration. 

4. After the completion of Calibration, confirm whether the current stage direction and camera layout 
is correct by "Display Global Coordinate". 
 

5. When images are displayed by "Display Global Coordinate" (camera image), and if the axis 
direction or how to be photographed is not correct (if marks displayed by Display Global 
Coordinate or images captured with cameras differ from the actual layout of the objects), recheck 
the settings and execute Calibration again. 
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In the left figure, each camera captures a circle 
and a cross. 
The figures below show cases of the global 
coordinate display when the setting of "Stage 
+Theta Direction" is wrong and when it is correct. 

 

When Stage +Theta Direction is wrong; Change the setting with the keypad. 

  

 
 

For details of "Stage +XY Direction" and "Stage +Theta Direction", refer to the next page "Operation 
Directions of Stages". 
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Operation Directions of Stages 
When setting "Stage Direction Automatic Judgement" to "No", set the operation direction based on the 
following concept. When setting it to "Yes", PV240 automatically judges the direction based on the 
following concept. 

[For XYTheta Stage, Line Theta Stage) 
1. Give a driving pulse for "moving in the positive direction" to the X-axis motor, and check in which way 
left or right the X-axis stage moves.  

2. Give a driving pulse for "moving to the positive direction" to the Y-axis motor, and check in which way 
left or right the Y-axis stage moves. 

3. Give a driving pulse for "moving to the positive direction" to the Theta-axis motor, and check in which 
way clockwise or counterclockwise the Theta-axis stage moves.  

4. Select "Stage +XY Direction" and "Stage +Theta Direction" from the directions confirmed in the above 
steps 1, 2 and 3. 

Operation Directions of Stages 

Direction1 (->^) Direction2 (<-^) 

  

Direction3 (->v) Direction4 (<-v) 

  

Rotation directions of Stages 
Set the rotation direction of the stage to be used in "Stage +Theta Direction". It is not related to the positive 
and negative directions of XY axes. It is determined by the stage and the mounting position of a camera. The 
figures below show the case when a camera is mounted above the stage. 

Clockwise Counterclockwise 

  
 



 

61 

[For UVW Stage] 

1. Confirm where the motor driving U axis (or 
pin position) is located, which of four sides of 
the stage. As shown in the left figure, set "Stage 
+XY Direction" considering the positional 
relation that its side becomes the upper side. 

 

2. Give a driving pulse for "moving to the 
positive direction" to the U-axis motor, and 
check in which way left or right the Y-axis stage 
moves.  

 

3. Give driving pulses for "moving to the positive 
direction" to the V and W axes (the pulses of V 
and W axes are the same direction at this time), 
and check in which way upward or downward 
the V and W axes move. 

 

 
4. Select "Stage +XY Direction" and "Stage +Theta Direction" from the directions confirmed in the above 
steps 2 and 3. 

 

 

Direction1 (->^) Direction2 (<-^) 

  
Direction3 (->v) Direction4 (<-v) 
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3.7.2 Setting Stage +XY Direction and Stage +Theta Direction 

The operation direction of stages should be specified for performing alignment in the right direction. These 
items are selectable when "Stage Direction Automatic Judgement" is set to "Yes". For information on the 
concept of operation directions, refer to page 60, Operation Directions of Stages. 

Stage +XY Direction 
Specify the positive direction of the XY axes on the stages. 

 

Stage +Theta Direction 
Specify the rotation direction of the stages. 
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3.8 Setting Stage MAX Distance 
When the movement amount calculated by PV240 exceeds the stage movement amount during the 
execution of alignment, an error is output if the value is larger than the specified value, and the alignment 
operation can be cancelled. 

 

 

 
 
Default 
X (mm): 1000.0000 mm 
Y (mm): 1000.0000 mm 
Theta (degree): 180.00000 degrees 

 

Concept of Stage Control 
 

 

• When the middle point between targets is (M) 
and the middle point between objects is (m), 
the angle that the object line (ab) becomes 
parallel to the target line (AB) is the stage 
movement amount Theta. 
 

• The stage rotates with the stage rotation 
center as an axis, and the distances until the 
middle point between objects (m) matches the 
middle point between targets (M) are the stage 
movement amount (X) and the stage 
movement amount (Y). 
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3.9 Stage Adjustment Amount (Absolute Value) 
PV240 calculates the absolute value of stage adjustment amount according to the following procedure. 
 

STEP1: The stage adjustment amount obtained from the calculated amount of deviation is used as a 
relative value. 

 

 
 
 

STEP2: The value which is the above stage adjustment amount (relative value) plus the stage current 
value is used as an absolute value. 

 Corresponding commands*: TAG: Get Stage Current Position 
  TAR: Request Stage Absolute Position Move 
  AZG: Get Stage Adjustment Amount 
  AOG: Get Deviation/Stage Adjustment Amount 

 

 

 
Stage adjustment amount (X, Y, Theta) is 
an absolute position. 
 
Stage adjustment amount 
= Stage current position + Stage 
adjustment amount 
(Relative value) 

= (Xs,Ys,Thetas) + (Xr,Yr,Thetar) 
 

* The absolute position is the coordinate 
values including the current stage 
position. 

 
 

* Commands are the instructions for controlling PV240 with external devices. The list of commands by 
general purpose communication is described on page 77, and the list of commands by PLC communication 
is described on page 128. 
** For details of "Amount of deviation", refer to page 199 which describes judgement conditions. 
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Chapter 4 
 Communication Setting 
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4.1 Communication Port and Protocol 

 

PV240 is provided with the following communication ports. 
• COM port: RS-232C interface 

• Ethernet port: Ethernet interface 
 

There are two types of protocols for each communication port, 
"General Communication " and "PLC Communication". The 
communication details differ depending on the protocols. Use one 
of them according to your purpose. 

 

 

 

4.1.1 RS-232C Interface 

 

Using COM port, PV240 communicates with the external device through RS-232C. Outputting inspection 
result data and sending/receiving control commands can be performed.Make the settings for RS232C 
interface from the following items. 

Setting of 
communication 
condition 

“ENVIRONMENT” > “Input/Output” > “Serial” 

Setting of serial output “ENVIRONMENT” > “Input/Output” > “General Output” > "Serial" column 
Setting of PLC 
communication 

“ENVIRONMENT” > “Input/Output” > “PLC Communication” 

Setting when selecting 
"PLC Communication" - 
"Command Read Type" - 
"Parallel Input" 

“ENVIRONMENT” > “Input/Output” > “Parallel I/O” > "ASSIGN0-1/EXTRA0-2" 
> Read PLC Communication Command 

 
For PLC communication, either RS-232C interface or Ethernet interface must be selected. 

Communication Specification of RS-232C 
Communication method Full duplex 
Synchronous method Asynchronous 
Baud rate *1) 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200 bps (Factory 

default: 9600) 
Transmission code ASCII 
Transmission 
format 

Bit length 7-bit, 8-bit (Factory default: 8-bit) 
Stop bit 1-bit, 2-bit (Factory default: 1-bit) 
Parity check None/Odd/Even (Factory default: Odd) 
Flow control None/Soft Flow (Factory default: None) 

Delimiter CR 

*1) When Baud Rate is "115200 bps", the communication may not be carried out stably in accordance with the 
device to communicate with. In the case, set Baud Rate to "57600 bps" or lower. 

 
About Baud rate, Transmission code,Refer to PV200User’sManual. 
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Connecting with a PC or a PLC 

Connecting with a PC 

The arrangement of the cables is shown on the right. 

 

PV240                           PC         

 

Connections with Panasonic PLC 
 

FP2 CCU FP0 /FP0R/ FP7 

PV240                      PLC              

 

PV240                           PLC         
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4.1.2 Ethernet Interface 

Ethernet communication is performed with an external device. Outputting inspection result data and 
sending/receiving Control commands can be performed. PV240 can communicate with the designated setting 
software PVWIN240. By using "Image Receiver for PV", image data can be also output. 

Make the settings for Ethernet interface from the following items. 

 
Setting of network "TOOL" > "General" > "Network" 
Setting of Ethernet output “ENVIRONMENT” > “Input/Output” > “General Output” > "Ethernet" column 
Setting of PLC 
communication 

“ENVIRONMENT” > “Input/Output” > “PLC Communication” 

Setting when selecting 
"PLC Communication" - 
"Command Read Type" - 
"Parallel Input” 

“ENVIRONMENT” > “Input/Output” > “Parallel I/O” > "ASSIGN0-1/EXTRA0-2" > 
Read PLC Communication Command 

Setting software 
"PVWIN240" 

All the settings except the network setting are set with PVWIN240. 

Image output “ENVIRONMENT” > “Input/Output” > “Image Output” 
Print screen “ENVIRONMENT” > “Input/Output” > “Print Screen” 

 
• Note that incorrect setting of the connection to the existing LAN might cause malfunction in the 

devices on the network. Consult your network administrator before connecting. 

• One PV240 cannot be operated by multiple PCs on the network. 

• Depending on the network condition, delay might be caused in the communication. It is advisable to 
use I/O interface or RS-232C interface for the operation that requires speedy response such as 
inspection trigger input. 

• For PLC communication, either RS-232C interface or Ethernet interface must be selected. 

Communication Specification of Ethernet 
 

Item Specifications 

Connector RJ-45 

Media 10BASE-T / 100BASE-TX / 
1000BASE-T 

 
According to the network adapter of your PC, 1000BASE-T communication may not be available.  
When you use Ethernet communication with 1000BASE-T, please check the maximum frame size (which is the 
data size that can be sent or received in one communication) available in the network environment. In some 
cases, the network adapter complying with 1000BASE-T also requires a setting change. For details including 
how to set, please contact a manufacturer of network adapters. 

 

About Baud Rate 

PV240 automatically adjusts the baud rate according to the speed of the device to communicate. (Auto 
negotiation)You can know the current baud rate by the position and color of LED of Ethernet port that lights 
when communicating. 

 
Ethernet Port LED Color Baud Rate 

 

Upper Green 100 megabits 

 Orange 1000 megabits 
(1 gigabit) 

Lower Yellow 10 megabits 
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About Port Number 

Port number differs depending on protocol and communication data. 

General Purpose Communication – 
Data Output: 

8601 

General Purpose Communication – 
Command send/receive 

8604 

PLC Communication – Data Output:         
Command send/receive 

1 – 65534  
（Except 8600 – 8699, 9090） 

Image output 8602 

Connecting PV240 with PC 

Communicating between a PV240 and a PC 
Connect them with a commercially available crossing cable. (STP crossing cable of category 5e or more is 
recommended.) 

 
 

Communicating between a PV240 and Multiple PCs 
Connect them with a commercially available straight cable (STP straight cable of category 5e or more is 
recommended.) through a hub or a router, which supports 1000BASE-T, 100BASE-TX, and 10BASE-T. 

 

 
Do not use the same IP addresses for the PV240 and the PC on the network. 
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4.1.3 Protocol 

The following two protocols are available for PV240. 
 

General 
Communication : 

This method communicates with external devices according to the protocol 
specified in PV240. 

As data is sent and received using ASCII strings, there is no restriction on external 
devices, however, a communication program for PV240 should be created in the 
external devices. 

Using this method enables to output inspection results, control PV240, read and 
change the setting values of PV240. 

PLC 
COMMUNICATION : 

This method communicates with a PLC according to the protocol of the destination 
PLC. Although usable PLC units are limited, communication can be easily 
performed by reading or writing specified registers. Inspection results are written in 
a specified register of PLC. Also, PV240 can be controlled or the setting values can 
be read and changed by writing commands into another specified register. Unlike 
General communication, only integers can be read and written. 

Two methods are available for the timing of reading commands, "Polling" and 
"Parallel Input". "Polling" checks whether commands are written in the register of 
PLC or not in a specified “Polling Time”. The response speed is slower than that of 
"Parallel Input". The time such as the time of inspection or image output gets longer 
because the polling process is performed even during the inspection. 

 
For PLC communication, either RS-232C interface or Ethernet interface must be selected. 

The pattern 1 in the table below shows the condition when PLC communication is selected for RS-232C 
interface. In this case, PLC communication cannot be used for Ethernet interface. Although the result output of 
RS-232C interface is limited to PLC communication, the control command can be also accepted through 
General communication. 

The pattern 2 in the table below shows the condition when PLC communication is selected for Ethernet 
interface. In this case, PLC communication cannot be used for RS-232C interface. Even when PLC 
communication is selected for Ethernet interface, General communication can be used for both result output 
and control command. Note that, however, the output port is different from that of PLC communication. 

 

 RS-232C Interface Ethernet Interface 

 General 
Communication 

PLC  
Communication 

General 
Communication 

PLC  
Communication 

 Result 
output 

Control 
command 

Result 
output 

Control 
command 

Result 
output 

Control 
command 

Result 
output 

Control 
command 

Pattern 
1 

N/A A A A A A N/A N/A 

Pattern 
2 

A A N/A N/A A A A A 

 
A: Available. It is also OK not to use. 

N/A: Not available 
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4.2 General Communication 

4.2.1 Overview and Communication Specifications 

This method communicates with external devices according to the protocol specified in PV200. 
Use General Communication for communicating with a PLC other than the PLCs applicable for PLC 
Communication or PC. RS232C interface and Ethernet interface can be used simultaneously. (In some cases, 
they cannot be used simultaneously.Refer to 4.1.3 Protocol for details.） 
The following communications are available with General Communication. 

 

・General output  

When accepting an inspection start signal (parallel input including reinspection signal, control command by 
communication or TRIG input by keypad) in RUN menu, after the inspection, the inspection results that are 
set to be output (Date and Time, Scan count, Total judgement, Judgement, Numerical calculation) and 
BCC are output using ASCII strings, and CR is output at the end of data strings. The following two output 
methods are available; Outputs data separated with comma and outputs data in fixed digits (unused digits 
filled with zeros) according to a specified output digits (For Scan count and Numerical calculation results 
only. For Total judgement, it is one digit. For Judgement, it depends on a set judgement formula.). 

Numerical calculation results are output as integer omitting the decimal point by specifying digits after decimal 
point you want to output in advance. 
(e.g. When setting "Decimal digit" to "2" for "12.345", it is rounded and output as "1235".) 
The date and time at the time of the execution of inspections can be output to Ethernet interface or SD 
card, and date and time can be added to the header of general output. 
These settings are common to all destination devices. 

ASCII strings to be output vary depending on the specified settings. Create a program to read data on the 
external device according to the output strings. 

For information on the settings to use this function, refer to PV200 User’s Manual "Selecting Destination 
and Output Data". 

A function to resend general output is not available. 

 

・Control command  

Using this function enables to control PV240, read and change the setting values (including decimal point). 
(In PLC communication, only integers can be read and changed.) 

For the details of the control and commands to be used, refer to PV200 User’s Manual . 

Even when performing general output and control command using PLC communication, PV240 can accept 
all the general communication commands. 

4.2.2 Setting General Communication 

Set only "General Output" for the setting of general communication. The condition to set for "Control 
command" using general communication is the setting of communication port only. 

Displaying General Output Setting Window 

1. Select “ENVIRONMENT” >  “Input/Output” 
from the menu bar. 

2. Select “General Output” in “Input/Output” 
setting window. 
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Selecting Destination and Output Data 

1. Select a data destination in “Output”. 

You can select multiple interfaces as destinations. 
 

Both "Serial" and "Ethernet" can be selected for the general output using general communication as 
the figure below. However, for PLC communication, either “Serial” or “Ethernet” can be selected. 

2. To output Date and Time, select “Yes”. 

Note the followings when the destination is "Serial" or 
"Ethernet (PLC) Communication", 
"Date/Time of General Output" is need to set "Yes". 

3. To output Scan Count/ Total Judgement/ 
Judgement/ Numerical Calculation, select “Yes”. 

 

4. To output BCC (block check code), select “Yes”. 
 

Specifying Digit Number of Output Data 
In general communication, real numbers (values including after decimal point) can be output. Set the digit 
number of integer and after decimal point. 

1. Specify total digits of integer part and after decimal point in “No. of Digits”. 

2. In “Decimal Digit”, specify digits for after decimal point used from the digits set in step 1. 

The outputs specified in "No. of Digits" are "Scan Count" and 
"Numerical Calculation" only. If you set “No. of Digits” = 14 
(default) and “Decimal Digit” =3 (default), the value consisting of 
11-digit integer and 3-digit decimal number is output. If you set 
“Decimal Digit” = 2 or 1, the value is rounded. 

 
When the value exceeding the specified digits is processed, the 
value is output as “0”.  

3. Set "Unused Digit". 

If the digit number of the data is less than the output digit number you have set, select a handling of 
unused digit. 
Comma 
Separated:  

Unused digits are deleted. Multiple data are output in different number of digits. Data 
are separated with a comma (",") before being output. 

Filled with '0' 
(default):  

Unused digits are filled with “0”. Although the data become longer, multiple data are 
output in the same number of digits. 
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4.2.3 Outputting Data through General Communication 

Data Output Flaw 

PV240    PLC 

     
Receives START signal.  

 
 Outputs START signal for inspection 

execution. 

Outputs response in case of accepting 
inspection by control command. 

 
 

 Receives response such as %S$52(CR). 

Executes inspection; capturing image 
and performing checkers. 

 
 

  

 
 

 
  

Outputs inspection results specified in 
advance using ASCII strings at a time 
and outputs CR at the end. 

 
 

 PLC uses transmitted ASCII strings by 
converting them to values. 

 
 

 
 

 

Waits for the next signal.  
 

 Goes back to the beginning and outputs 
START signal for the next inspection 
execution. 

     

About Data that can be Output 
When PV240 executes inspection, the data set to output are output in the following order. 

1. Date and Time  

2. Scan Count 

3. Total Judgement 

4. Judgement result: 
Up to 1000 points combining judgements and numerical calculations. 

5. Numerical Calculation: 

6. BCC  

The settings for the above output items 1 to 6 (Output; "Yes" / "No") are common to all the destinations 
(Serial / Ethernet / SD Card). 

In the following cases, the data of Judgement and Numeric Calculation are not output to PLC. 
• PV sets data to output, but no data exist. 
• The setting data exist, but data are set to not to be output. 

 

Output format of Date and Time: 
Output Data • Date: YY/MM/DD (2-digit of year/ 2-digit of Month/ 2-digit of Day) Total eight 

characters 
• Time: HH:MM:SS(2-digit of Hour/2-dgit of Minute/2-digit of Second) Total eight 

characters 
• Sixteen characters or seventeen characters (when setting "Unused Digit" to 

"Comma Separated" are output regardless of output digits. 
Number of Data 1 

However, when "Unused Digit" is "Comma Separated", a comma is put between 
date and time. 
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Output format of Scan count: 
Output Data 1 to 2147483647 

Number of Data 1 

Values to be Output Normal 1 to 2147483647 

Overflow  2147483647 

When exceeding the specified "No. of Digits". 0 

 

Output format of Total Judgement: 
Output Data 1 / 0 / E (1 character) 

Number of Data 1 

Values to be Output OK 1 

NG 0 

Error E 

Unset E 

 

Output format of Judgement data: 
Output Data Outputs one judgement data with one character (1 / 0 / E) 

Once all data are output, output will be terminated regardless of output digits. 
Number of Data Up to 1000 

Values to be Output OK 1 

NG 0 

Error E 

Unset Data are not output.  

 

Output format of Numerical Calculation:  

Values to be output are integers. When setting "Decimal Digit", the integer part and the digit after decimal 
point that is rounded to the specified decimal place is output without the decimal point. 

Example: In case of numerical calculation result is 123.456; 
When setting "Decimal Digit" to "2", 12346 is output by rounding it to two decimal place.  
Output Data Outputs one numerical calculation output as one data. 

-2147483648 to 2147483647 
Number of Data Numerical Calculation: Up to 1000 
Values to be Output Normal Calculation results: 

 -2147483648 to +2147483647 
Overflow or when exceeding 
the specified "No. of Digits". 

0 
("0" is output only for the appropriate 
numerical calculation results.)) 

Error 0 
Unset Data are not output. 

 

Output format of BCC:  

BCC is output subsequent to previous data. When "Unused Digits" is set to "Comma Separated", commas 
are put between each data for separation. However, the last data and BCC are output without separation. 
If you want to read the last data separated with comma, output one extra data next to it. 
Output Data 00 ~ FF (2 characters) 

Number of Data 1 
Values to be Output Obtains an Exclusive OR from the ASCII code of all characters from the first 

character of output string to the string right before BCC. The obtained 
Exclusive OR is expressed in hexadecimal and two characters are output 
regarding four bits as one character. 
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Example of General Output 

 For details of output to SD card, refer to PV200 User’s Manual. 
Output Data: Date: 

Time: 
Scan Count: 
Total Judgement: 
Judgement: 
Numerical Calculation: 

2010/12/15 
09:25:48 
1234 times 
OK 
JDC000 = OK, JDC001 = unset, JDC002 = NG 
CAC000 = 215.8, CAC001 = unset, CAC002 = -368.0 

   
Output Condition 
1: 

Date and Time: 
No. of Digits: 
Decimal Digit: 
Unused Digit: 
BCC: 

Output  
6 
1 
Filled with ‘0’ 
Output 

 

Output destination=”Serial” 

0 0 1 2 3 4 1 1 0 0 0 2 1 5 8 - 0 3 6 8 0 BCC CR 

 Scan Count To
tal 
Ju
dg
e. 

Jud
ge- 
men

t 

Numerical 
Calculation 0 

Numerical 
Calculation 2 

2-digit 
Block Check 

Code 

 

 

Output destination=”Ethernet (General Communication)” 

1 0 / 1 2 / 1 5 0 9 : 2 5 : 4 8 0 0 1 2 3 4 1 1 0 

                         Date Time Scan Count Total 
Judge. 

Judgement 

 

0 0 2 1 5 8 - 0 3 6 8 0 BCC CR 

              Numerical  
Calculation 0 

Numerical  
Calculation 2 

2-digit 

Block Check 
Code 

 

 
Judgement JDC001 and Numeric Calculation CAC001 are not output because they are unset. 
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Output Condition 
2: 

Date and Time: 
No. of Digits: 
Decimal Digit: 
Unused Digit: 
BCC: 

Output  
6 
1 
Deleted 
Output 

 

Output destination = "Serial" 

1 2 3 4 , 1 , 1 , 0 , 2 1 5 8 , - 3 6 8 0 BCC CR 
                       

Scan Count  To
tal 
Ju
dg
e. 

 Ju
dg
e. 

 Ju
dg
e. 

 Numerical 
Calculation0 

 Numerical 
Calculation 2 

2-digit 
Block Check Code 

 

 

Output destination=”Ethernet (General Communication)”: 

1 0 / 1 2 / 1 5 , 0 9 : 2 5 : 4 8 , 1 2 3 4 , 1 , 1 , 0 , 
                             

Date  Time  Scan Count  To
tal 
Ju
dg
e. 

 Ju
dg
e. 

 Ju
dg
e. 

Dat
e 

 

2 1 5 8 , - 3 6 8 0 BCC CR 
            

Numerical  
Calculation 

0 

 Numerical  
Calculation 2 

2-digit 

Block Check 
Code 
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4.2.4 List of Commands for Genral Communication 

The commands described in this chapter are the common commands for the ports to control PV240 with 
RS-232C interface and Ethernet interface through general communication.  

 
Port number of Ethernet interface to send/ receive commands for PV240 is “8604”. 

List of Alignment Commands 

 Comm
and 

Refer 
to 

Description 

Request Stage Current 
Position TAG 80 Obtains the coordinate of the stage current position. 

Request Stage Absolute 
Position Move 

TAR 81 
Specifies the movement amount of stage absolute position. 
It is specified with the absolute position (stage coordinate system) of 
XYTheta or UVW. 

Execute Calibration CAE 82 Starts a calibration sequence. 

Execute Auto Alignment AAE 86 Starts an auto alignment sequence. 
Target running offsets are specified. 

Execute Auto Alignment 
(Simple Flow) AAS 88 

Starts an auto alignment sequence. Target running offsets are 
specified. Obtaining the stage current position (TAG) at the time of 
retry is omitted, and the execution time is shorter than AAE 
command. 

Get Target Position TGG 90 

When "Target Position" is set to "Mark Detection", a detected mark 
position is registered as the target position. When "Target Position" 
is set to "Center of Display", the center position of the display is 
registered as the target position. 

Get Object Position OBG 91 Detects object marks. 

Reset, Cancel Alarm ARR 92 Turns off the parallel I/O error flag. 
Clears an error message on the screen. 

Execute Aligment for 1 
camera 

ACL 93 Executes an alignment sequence once at an obtained object 
position. 

Get Deviation GDV 95 Obtains the amount of deviation between the target position and 
object position 

Get Stage Adjustment 
Amount AZG 96 Obtains the adjustment amount (absolute value) based on the 

current position (absolute value). 

Set Target Position 
(Specify Camera 
Coordinate)  

TGS 98 Specifies camera coordinates and registers the position. 

Move Rotation Center SRP 99 Moves the rotation center for alignment calibration. 

Print Screen PS 100 Obtains print screen images of screens. 

Save Print Screen in 
Image Memory PSM 102 Saves print screen images in the dedicated image memory. 

Save Print Screen in SD SSM 103 Saves print screen images saved in the dedicated image memory to 
an SD card, and clears data within the image memory. 

Get Distance between 
Target/Object Marks 

GML 104 Obtains the distance between target marks and the distance 
between object marks. 

Change Camera Shutter 
Speed 

CSH 105 Changes the shutter speed of a camera. 

Change Threshold of 
Change Judgement SCT 106 Changes the threshold of change judgement of X, Y and Theta. 

Get Deviation/Stage 
Adjustment Amount AOG 107 Obtains the current value, and returns the adjustment amount plus 

the amount of deviation after the detection of an object. 

Set Object Position OBS 108 Assigns the coordinate of an object position directly instead of the 
detected position by the checker when executing Alignment. 

Output Alignment Result 
Data 

RTD 110 Saves the latest result of the execution of Alignment to an SD card. 
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*1: Both reading and writing cannot be executed when PV240 stops. 
*2: It cannot be executed when you select “TOOL” > "General", "Setting Help", or "Update". 
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4.3 Details of General Communication Commands 

Command (Response) Composition 

The configurations of general communication commands and command responses are as follows. 
 

 

& Command P1(R1) P1(R1) … ¥ Checksum CR 

 
 

& Start code; "&" of ASCII characters 

Command Command (Response); Composed of three ASCII characters. 

P1,P2 
 (R1,R2) 

Command parameter (Response parameter) 
Parameter values are expressed as decimal values using ASCII 
characters. The number of digits and the range of values differ according 
to commands. There is no delimiter between parameters. 

¥ Terminate code; "¥" of ASCII characters 

Checksum 

When "Checksum" is set to "Yes", the sum of all the ASCII characters 
between the start code and the terminate code is calculated, and the lower 
one-byte value is added as hexadecimal two-digit values using ASCII 
characters. 
(Checksum is specified from "TYPE" > "Alignment" > "Alignment" > 
"Options" > "Checksum".) 

CR Terminate code 0DH (Carriage return) 
 

 

Checksum 

Unlike the normal BCC, the sum of all the ASCII character codes of a command and command parameter 
is calculated, and the lower one-byte value is expressed as hexadecimal two-digit values using ASCII 
characters. 

 

Example) In the case of Reset Alarm command 

 

& A R R ¥ 

 41H 52H 52H  

▼The lower two bytes of addition result▼ 

E5H 
 

Command composition including checksum 

& A R R ¥ E 5 

     Checksum 
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Request Stage Current Position 
Obtains the request of the stage current position. 
 

Send & T A G ¥ (SUM) CR 
 

Receive & T A G R1 R2 R3 R4 ¥ (SUM) CR 
 

  

Parameter 

R1 [For XYTheta Stage, Line Theta Stage) 
X-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

[For UVW Stage] 
U-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

R2 [For XYTheta Stage, Line Theta Stage) 
Y-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

[For UVW Stage] 
V-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

R3 [For XYTheta Stage] 
Theta-axis absolute value (12 digits, sign + or - as the head) [1/100000 degree 
units] 

[For UVW Stage] 
W-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

[For Line Theta Stage] 
Stroke absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 
Communication is performed with the value converted from theta to the amount 
of movement. 

R4 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 

 

Communication behavior 

Host  PV240 

Obtains stage current position. ← Sends TAG command. 

Sends TAG response. → Receives response. 
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Request Stage Absolute Position Move 
Specifies the movement amount of stage absolute position. 
It is specified with the absolute position (stage coordinate system) of XYTheta or UVW. 
 

Send & T A R P1 P2 P3 ¥ (SUM) CR 
 

Receive & T A R R1 ¥ (SUM) CR 
 

  

Parameter 

P1 [For XYTheta Stage, Line Theta Stage) 
X-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

[For UVW Stage] 
U-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

P2 [For XYTheta Stage, Line Theta Stage) 
Y-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

[For UVW Stage] 
V-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

P3 [For XYTheta Stage] 
Theta-axis absolute value (12 digits, sign + or - as the head) [1/100000 degree 
units] 

[For UVW Stage] 
W-axis absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 

[For Line Theta Stage] 
Stroke absolute value (12 digits, sign + or - as the head) [1/10000 mm  units] 
Communication is performed with the value converted from theta to the amount 
of movement. 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 

 

Communication behavior 

Host  PV240 

Moves stage absolute 
position. 

← Sends TAR command. 

Sends response. → Receives response. 
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Execute Calibration 
Starts a calibration sequence. 
 

Send & C A E P1 ¥ (SUM) CR 
 

Receive & C A E R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Mark No. 
00: Mark0 and Mark1 
01: Mark0 
02: Mark1 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
11: Specified mark unregistered 
14: Calibration failed 
22: Mark0 undetected 
23: Mark1 undetected 

 

Communication behavior 

Host  PV240 

Sends CAE command. →   

Gets the current stage position. ← Sends TAG command. 

Sends TAG response. → Detects the base position in X direction. 
(Executes mark detection.) 

Shifts in X direction. ← Sends TAR command. 

Sends TAR response. → Detects the shift position in X direction. 
(Executes mark detection.) 

Shifts in Y direction. ← Sends TAR command. 

Sends TAR response. → Detects the shift position in Y direction. 
(Executes mark detection.) 

Shifts in +Theta direction. ← Sends TAR command. 

Sends TAR response. → Detects the shift position in +Theta 
direction. (Executes mark detection.) 

Shifts in -Theta direction. ← Sends TAR command. 

Sends TAR response. →  

 ← Sends CAE response. 
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CAE Command Flow 
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Execute Calibration (with Rotation Point 
Adjustment) 
Performs Rotation Point Adjustment after a calibration sequence. 
 

Send & C A E P1 ¥ (SUM) CR 
 

Receive & C A E R1 R2 R3 ¥ (SUM) CR 
 

  

Parameter 

P1 Mark No. (2 digits) 
00: Mark0 and Mark1 
01: Mark0 
02: Mark1 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
15: Calibration unset 
22: Mark0 undetected 
23: Mark1 undetected 

60: Alignment checker unregistered 
61: Calibration checker unregistered 
64: Sequence error 
66: Inexecutable due to the PV not in 
RUN mode 

R2 Final deviation (12 digits, sign + as the head) 
The smallest deviation in the repeat processing (Final deviation) 
* Final deviation of Mark0 when specifying Mark No.00 and Mark No.01. 
  Final deviation of Mark1 when specifying Mark No.02. 

R3 Final deviation (12 digits, sign + as the head) 
The smallest deviation in the repeat processing (Final deviation) 
* Final deviation of Mark1 when specifying Mark No.00. 
 This item is not added when specifying Mark No.01 and Mark No.02. 

 

Communication behavior 

Host  PV240 

  1. When the number of retries is 0, sends 
CAE response. When it is other than 0, 
goes to step 2. 

Moves X, Y Theta. ← 2. Sends TAR command. 

Sends TAR response. → Calculates the adjusted rotation point 
position. 

Calibration complete ← When the counter is smaller than the 
number of retires, goes to step 2. When it is 
larger, sends CAE response. 
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CAE Command Flow (with Rotation Point 
Adjustment) 

 
* For details of Rotation Point Adjustment, refer to 6.3.5 Rotation Point Adjustment (Calibration Data) on page 
174. 
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Execute Auto Alignment 
Starts an alignment sequence. This command is used for capturing two object marks simultaneously. 

 
When the timing of capturing the object mark0 is different from that of capturing the mark1, use ACL 
command. 

 

Send & A A E P1 P2 P3 P4 ¥ (SUM) CR 
 

Receive & A A E R1 ¥ (SUM) CR 
 

  

Parameter 

P1 X-axis offset value (12 digits, sign + or - as the head) [1/10000 mm units] 

P2 Y-axis offset value (12 digits, sign + or - as the head) [1/10000 mm units] 

P3 Theta-axis offset value (12 digits, sign + or - as the head) [1/100000 degree 
units] 

P4 Reserved (2 digits): 00 fixed 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
11: Specified mark unregistered 
14: Alignment calculation failed 
15: Calibration unset 
20: Alignment retry error 
21: Target position outside screen error 
22: Mark0 undetected 
23: Mark1 undetected 
25: Mark pitch incorrect 
34: X: Movement threshold error 
35: Y: Movement threshold error 
36: Theta: Movement threshold error 
37: XY: Movement threshold error 
38: XTheta: Movement threshold error 
39: YTheta: Movement threshold error 
40: XYTheta: Movement threshold error 

 

Communication behavior 

Host  PV240 

Sends AAE command. →  

Gets the current stage position. ← 1. Sends TAG command. 

Sends TAG response. → 2. When within deviation threshold, goes to 
step 5 below. 

  3. When exceeding the number of retries, goes 
to step 5 below. 

Moves stage. ← 4. Sends TAR command. 

Sends TAR response. → Goes to the above step 1. 

Complete ← 5. Sends AAE response. 
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AAE Command Flow 
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Execute Auto Alignment (Simple Flow) 
Starts an auto alignment sequence. Target running offsets are specified. Obtaining the stage current 
position (TAG) at the time of retry is omitted, and the execution time is shorter than AAE command. 
This command is used for capturing two object marks simultaneously. 

 
When the timing of capturing the object mark0 is different from that of capturing the mark1, use ACL 
command. 

 

Send & A A S P1 P2 P3 P4 ¥ (SUM) CR 
 

Receive & A A S R1 ¥ (SUM) CR 
 

 Parameter 

P1 Reserved (2 digits): 00 fixed 

P2 X-axis offset value (12 digits, sign + or - as the head) 

P3 Y-axis offset value (12 digits, sign + or - as the head) 

P4 Theta-axis offset value (12 digits, sign + or - as the head) 

 
R1 Error (2 digits) 

00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
15: Calibration unset 
17: Target coordinate unregistered 
20: Number of alignment retries exceeded 
21: Target position out of the screen 
22: Mark0 undetected 
23: Mark1 undetected 
25: Mark pitch incorrect 
34: Movement threshold error (X      ) 
35: Movement threshold error (Y      ) 
36: Movement threshold error (Theta      ) 
37: Movement threshold error (X, Y   ) 
38: Movement threshold error (X,  , Theta) 
39: Movement threshold error (   Y, Theta) 
40: Movement threshold error (X, Y, Theta) 
60: Alignment checker unregistered  
61: Calibration checker unregistered  
63: Object checker unregistered  
64: Sequence error 
66: Inexecutable due to the PV not in RUN mode 

Communication behavior 

Host  PV240 

Sends AAS command. →  

 ← 1. Sends TAG command. 

Sends TAG response. → 2. When within deviation threshold, goes to 
step 5 below. 

  3. When exceeding the number of retries, 
goes to step 5. 

Moves stage. ← 4. Sends TAR command. 

Sends TAR response. → Goes to the above step 2. 

Complete ← 5. Sends AAS response. 
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AAS Command Flow 
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Get Target Position 
When "Target Position" is set to "Mark Detection", a detected mark position is registered as the target 
position. 
When "Target Position" is set to "Center of Display", the center position of the display is registered as the 
target position. 
 

Send & T G G P1 ¥ (SUM) CR 
 

Receive & T G G R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Mark number 
00: Mark0 and Mark1 
01: Mark0 
02: Mark1 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
11: Specified mark unregistered 
15: Calibration unset 
22: Mark0 undetected 
23: Mark1 undetected 

 

Communication behavior 

Host  PV240 

Sends TGG command. → Detects target mark. 

Receives response. ← Sends TGG response. 

 
 

 



 

91 

Get Object Position 
Detects object marks. 
 

Send & O B G P1 ¥ (SUM) CR 
 

Receive & O B G R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Mark number 
00: Mark0 and Mark1 
01: Mark0 
02: Mark1 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
11: Specified mark unregistered 
15: Calibration unset 
22: Mark0 undetected 
23: Mark1 undetected 

 

Communication behavior 

Host  PV240 

Sends OBG command. → Executes object mark detection. 

Receives response. ← Sends OBG response. 
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Reset, Cancel Alarm 
Turns off the parallel I/O error flag. 
Clears an error message on the screen. 
 

Send & A R R ¥ (SUM) CR 
 

Receive & A R R R1 ¥ (SUM) CR 
 

  

Parameter 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 

 

Communication behavior 

Host  PV240 

Sends ARR command. → Turns off error signal and deletes error 
message. 

Receives response. ← Sends ARR response. 

 
 

When a command error occurs, turn off the ERROR signal and clear the error message by 
sending the alarm reset command. 
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Execute Alignment for 1 Camera (with Target 
Offsets) 
Executes an alignment sequence once by this command after obtaining two object positions. Target offsets 
can be specified. 
This command is used when the timing of capturing object marks is different between Mark0 and Mark1, in 
such a case that one object mark is captured after moving a camera after the other mark was captured. (It is 
not related to "TYPE" > "Type Setting" > Capture Delay".) Use AAE or AAS command for capturing two 
object marks simultaneously. 

 

Send & A C L P1 P2 P3 P4 ¥ (SUM) CR 
 

Receive & A C L R1 R2 ¥ (SUM) CR 
 

 Parameter 

P1 Reserved (2 digits): 00 fixed 

P2 X-axis offset value (12 digits, sign + or - as the head) [1/10000 mm units] 

P3 Y-axis offset value (12 digits, sign + or - as the head) [1/10000 mm units] 

P4 Theta-axis offset value (12 digits, sign + or - as the head) [1/100000 degree 
units] 

 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
11: Specified mark unregistered 
14: Alignment calculation failed 
15: Calibration unset 
21: Target position outside screen error 
22: Mark0 undetected 
23: Mark1 undetected 
25: Mark pitch incorrect 
34: X: Movement threshold error 
35: Y: Movement threshold error 
36: Theta: Movement threshold error 
37: XY: Movement threshold error 
38: XTheta: Movement threshold error 
39: YTheta: Movement threshold error 
40: XYTheta: Movement threshold error 

R2 Result (4 digits) 
0000: End within threshold 
0001: End out of threshold 
* A value returned to "Result" at the time of error occurrence is not 
determined. Sometimes, 0000 is returned. 

 

Host  PV240 

(Target and object have been detected.) 
Sends ACL command. 

→ Calculates deviation. 
When it is out of judgement threshold: 
Goes to step 1. 
When it is within judgement threshold: 
Goes to step 2. 

Gets the current stage position. ← 1. Sends TAG command. 

Sends TAG response.  Receives response. 

Moves stage.    Sends TAR. 

Sends TAR response.    Receives response. Goes to step 2. 

ACL complete. If ended with values out 
of thresholds, re-detects the object and 
re-executes ACL. 

 Sends ACL response. 
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ACL Command Flow 
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Get Deviation (with Target Offsets) 
Gets the difference between the currently detected target position and object position. Target offsets can be 
specified. 
 

Send & G D V P1 P2 P3 P4 ¥ (SUM) CR 
 

Receive & G D V R1 R2 R3 R4 ¥ (SUM) CR 
 

  

Parameter 

P1 Reserved (2 digits): 00 fixed 

P2 X-axis offset value (12 digits, sign + or - as the head) [1/10000 mm units] 

P3 Y-axis offset value (12 digits, sign + or - as the head) [1/10000 mm units] 

P4 Theta-axis offset value (12 digits, sign + or - as the head) [1/100000 degree 
units] 

 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
15: Calibration unset 
21: Target position outside screen error 

R2 X amount of deviation  (12 digits, sign + or - as the head) [1/10000 mm  
units] 

R3 Y amount of deviation  (12 digits, sign + or - as the head) [1/10000 mm  
units] 

R4 Theta amount of deviation (12 digits, sign + or - as the head) [1/100000 degree 
units] 

 

Communication behavior 

Host  PV240 

(Target and object have been 
detected.) 
Sends GDV command. 

→  Calculates deviation. 

Receives response. ← Sends response. 
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Get Stage Adjustment Amount (Absolute Value) 
Obtains the adjustment amount (absolute value) based on the current position (absolute value). 

Send & A Z G P1 P2 P3 P4 P5 P6 ¥ (SUM) CR 
 

Receive & A Z G R1 R2 R3 R4 ¥ (SUM) CR 
 

 
Parameter 

P1 Stage current value (Axis #1 absolute value) (12 digits, sign + or - as the head) 

P2 Stage current value (Axis #2 absolute value) (12 digits, sign + or - as the head) 

P3 Stage current value (Axis #3 absolute value) (12 digits, sign + or - as the head) 

P4 Stage current value (Axis #4 absolute value) (12 digits, sign + or - as the head) 

P5 Stage current value (Axis #5 absolute value) (12 digits, sign + or - as the head) 

P6 Reserved (2 digits): 00 fixed 

 

R1 Stage adjustment amount (Axis #1 absolute value) (12 digits, sign + or - as the 
head) 

R2 Stage adjustment amount (Axis #2 absolute value) (12 digits, sign + or - as the 
head) 

R3 Stage adjustment amount (Axis #3 absolute value) (12 digits, sign + or - as the 
head) 

R4 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
11: Specified mark unregistered 
14: Alignment calculation failed 
15: Calibration unset 
17: Target unregistered 
22: Mark0 undetected 
23: Mark1 undetected 

 
Behavior of axes and input units 

 XYTheta Stage Line Theta Stage UVW Stage 

Axis #1 
absolute value X-axis position [1/10000 mm] U-axis position [1/10000 mm] 

Axis #2 
absolute value 

Y-axis position [1/10000 mm] V-axis position [1/10000 mm] 

Axis #3 
absolute value 

Theta-axis 
position 
[1/100000 
degree] 

Stroke position 
[1/10000 mm] W-axis position [1/10000 mm] 

Axis #4 
absolute value 

(0 fixed) 
Axis #5 
absolute value 

Communication behavior 

 Host  PV240 

(1) Target and object have been detected.   

(2) Sends AZG command. → Calculates stage adjustment 
amount. 

 (Stage moves on PLC side.) 
Returns to the above (1) after re-executing 
object detection. 

← Sends AZG response. 
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AZG Command Flow 
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Set Target Position (Specify Camera Coordinate)  
Specifies camera coordinates and registers the target position. 
 

Send & T G S P1 P2 P3 ¥ (SUM) CR 
 

Receive & T G S R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Mark No. (2 digits) 
00: Unavailable 
01: Mark0 
02: Mark1 

P2 X-axis camera coordinate (12 digits, sign + or - as the head) [1/10000 pixel 
units] 

P3 Y-axis camera coordinate (12 digits, sign + or - as the head) [1/10000 pixel 
units] 

 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
66: Inexecutable due to the PV not in RUN mode 

 

Communication behavior 

Host  PV240 

Sends TGS command. → Obtains target position form parameter. 

Receives response. ← Sends TGS response. 
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Move Rotation Center 
Moves the rotation center for alignment calibration. 
 

Send & S R P P1 P2 P3 P4 ¥ (SUM) CR 
 

Receive & S R P R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Mark No. (1 digit) 
1: Mark0 
2: Mark1 

P2 Reserved (1 digit): (00 fixed) 

P3 X-axis movement (12 digits, sign + or - as the head) [1/10000 mm units] 

P4 Y-axis movement (12 digits, sign + or - as the head) [1/10000 mm units] 

 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
15: Calibration unset 
64: Sequence error 
66: Inexecutable due to the PV not in RUN mode 

 

Communication behavior 

Host  PV240 

Sends SRP command. → rotation center X = Current rotation center + 
X-axis movement 
rotation center Y = Current rotation center + 
X-axis movement 

   

Receives response. ← Sends SRP response. 
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Print Screen 
It is output into the place specified from “ENVIRONMENT” >  “Input/Output” >  “Print Screen” -> “Destination”. 
This command cannot specify the destination. 

 

Send BCC = 26 or ** % P S BCC CR 

Receive % P S BCC(02) CR 

Error (ERROR signal = ON) 

% P S ! Error code (3-digit) BCC CR 
 

 Error code 

200 Operation is stopped 

265 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is set to "Disable", and the cover is open. 
• Ethernet communication cannot be established (with connection problems 

such as cable unconnected or disconnection) 
• Image Receiver is not activated. 

 

Communication behavior 

Host  PV240 

Sends PS command. → When receiving the command, "PRINT 
SCREEN" is displayed in the message 
display area. 

Receives response. ← Sends PS response. 

 
 

The file name format of a print screen image saved by PS command is different from that saved 
with the keypad. Information such as an alignment result or the amount of deviation is indicated 
in the file name.  
It is possible to confirm alignment information on the display of the list of files without opening 
each file. 

File name saved by 
PS command 

yymmdd_hhmmss_n_r_xxxxxx.xxxx_yyyyyy.yyyy_tttttt.ttttt.bmp 
 
yymmdd: Date 
hhmmss: Time 
n: File number 
r: Alignment result (OK: 1, NG: 0) 
xxxxxx.xxxx: Amount of deviation X (4 digits after the decimal 
point) 
yyyyyy.yyy: Amount of deviation Y (4 digits after the decimal 
point) 
tttttt.tttt: Amount of deviation Theta (5 digits after the decimal 
point) 

Example of file name 140409_113246_0_0_0.0000_0.0000_0.00000.bmp 
File name saved with 
the keypad 

yymmdd_hhmmss_n.bmp 

For information on the procedure for saving print screen images with the keypad, see "3.2.5 
Copying the Screen Display (Print Screen)" of PV200 User's Manual. 
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Print Screen (Specify File Name) 
Saves print screen images with arbitrary file names. 

 
This command cannot be used when operation is stopped. Although it is possible to save print screen 
images with the keypad when operation is stopped, file names cannot be specified. 

Send 
 

% P S     N A M E = Arbitrary string BCC CR 

Receive % P S $ BCC CR 

Error (Error signal = ON) 

% P S ! Error code (3-digit) BCC CR 
 

 Error code 

200 Cannot be executed as operation is stopped. 

265 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is se to "Disable", and the cover is open. 
• Ethernet communication cannot be established (with connection problems 

such as cable unconnected or disconnection) 
• Image Receiver is not activated or stops. 

266 Parameter does not begin with "NAME=". Or, character string with more than 
199 characters is specified. 

 

Communication behavior 

Host  PV240 

Sends PS command. → When receiving the command, "PRINT 
SCREEN" is displayed in the message 
display area. 

Receives response. ← Sends PS response. 

 
 

• A string exceeding 199 characters cannot be saved as a file name. 
If a file name exceeds the number of characters that can be displayed in the text box 
in the folder display window, it is not displayed correctly. Take care when saving print 
screen images with arbitrary names by PS command, etc, or when changing a file 
name directly on a PC. 

• The following symbols cannot be used for file names. If these symbols are used, the 
name is registered skipping these characters. 
¥ / : , ; * ? " < > | 

• The name of an image file saved by the normal PS command differs from that saved 
by this command. 

File name saved by 
PS (Specify file name) 
command 

yymmdd_hhmmss_n_r_xxxxxx.xxxx_yyyyyy.yyyy_tttttt.ttttt.bmp 
 
yymmdd: Date 
hhmmss: Time 
n: File name + File number 
r: Alignment result (OK: 1, NG: 0) 
xxxxxx.xxxx: Amount of deviation X (4 digits after the decimal 
point) 
yyyyyy.yyy: Amount of deviation Y (4 digits after the decimal 
point) 
tttttt.tttt: Amount of deviation Theta (5 digits after the decimal 
point) 

Example of file name 
(when file name is 
"ABC") 

140409_113246_ABC0_0_0.0000_0.0000_0.00000.bmp 
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Save Print Screen in Image Memory 
Saves print screen images in the dedicated image memory. 

 
• Up to ten images can be held in the memory. (Images after the 11th image will be discarded.) 

 

Send BCC=6B or ** % P S M BCC CR 

Receive % P S M BCC(6B) CR 

Error (Error signal = ON) 

% P S M ! Error code (3-digit) BCC CR 
 

 Error code 

200 Cannot be executed as operation is stopped. 

265 • Image data was discarded because the number of saved images exceeds the 
limit (10 images). 

• No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is se to "Disable", and the cover is open. 
• Ethernet communication cannot be established (with connection problems 

such as cable unconnected or disconnection) 
• Image Receiver is not activated or stops. 

 

Communication behavior 

Host  PV240 

Sends PSM command. → Saves images in the dedicated image memory 
for print screen. 

Receives response. ← Sends PSM response. 
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Save Print Screen in SD 
Saves print screen images to an SD card from the dedicated image memory, and deletes data in the image 
memory. 

 

Send BCC=6B or ** % S S M BCC CR 

Receive % S S M BCC(68) CR 

Error (Error signal = ON) 

% S S M ! Error code (3-digit) BCC CR 
 

 Error ode 

200 Cannot be executed as operation is stopped. 

265 • No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• No image is saved in the dedicated image memory. 
• "Write When Cover is Open" is se to "Disable", and the cover is open. 

 

Communication behavior 

Host  PV240 

Sends SSM command. → Saves images within the dedicated image 
memory for print screen to an SD card, and 
deletes the images within the memory. 

Receives response. ← Sends SSM response. 
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Get Distance between Target/Object Marks 
Obtains the distance between target marks and the distance between object marks. 
 

Send & G M L ¥ (SUM) CR 
 

Receive & G M L R1 R2 R3 ¥ (SUM) CR 
 

  

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
66: Inexecutable due to the PV not in RUN mode 

R2 Distance between target marks 0 and 1 (12 digits, sign + or - as the head) 
[1/10000 mm  units] 

R3 Distance between object marks 0 and 1 (12 digits, sign + or - as the head) 
[1/10000 mm units] 

 

Communication behavior 

Host  PV240 

(Target marks 0, 1 and object marks 
0, 1 have been detected.) 
Sends GML command. 

→ Calculates the distance between target 
marks 0 and1, and the distance between 
object marks 0 and 1. 

Receives response. ← Sends GML response. 
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Change Camera Shutter Speed 
Changes the shutter speed of a camera. 
 

Send & C S H P1 P2 ¥ (SUM) CR 
 

Receive & C S H R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Camera No. (1 digit) 

P2 Shutter speed [1/100 msec units] (6 digits) 
0.3-Mega Compact Gray Camera (ANPVC5030): 0.10 msec to 500 msec 
Cameras other than the above: 0.03 msec to 1000 msec 

 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
15: Calibration unset 
66: Inexecutable due to the PV not in RUN mode 

 

Communication behavior 

Host  PV240 

Sends CSH command. → Stops operation when receiving the 
command and restart the operation after 
completing the command. "Data Updated!" 
is displayed in the message area. 

Receives response. ← Sends CSH response. 
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Set Threshold of Change Judgement 
Changes the thresholds of change judgement of X, Y and Theta which are used as the judgement condition 
of Alignment checker. 

 
This command cannot be used when operation is stopped. 

 

Send & S C T P1 P2 P3 P4 ¥ (SUM) CR 
 

Receive & S C T R1 ¥ (SUM) CR 
 

  

Parameter 

P1 Reserved (2 digits): 00 fixed 

P2 Threshold of change judgement X (+Sign: 1 digit, 11-digit value: Always 0 as a 
head) [1/10000 mm units] 
+00000000000 mm to +09999999999 mm 

P3 Threshold of change judgement Y (+Sign: 1 digit, 11-digit value: Always 0 as a 
head) [1/10000 mm units] 
+00000000000 mm to +09999999999 mm 

P4 Threshold of change judgement Theta (+Sign: 1 digit, 11-digit value: Always 0 
as a head) [1/100000 degree units] 
+00000000000 mm to +09999999999 mm 

 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
03: Command parameter error 
60: Alignment checker unregistered 

 

Communication behavior 

Host  PV240 

Sends SCT command. → Changes the threshold of change 
judgement of X, Y and Theta. 

Receives response. ← Sends SCT response. 
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Get Deviation/Stage Adjustment Amount 
Obtains the current value from PLC, and returns the adjustment amount plus the amount of deviation after 
the detection of an object. 
 

Send & A O G P1 P2 P3 P4 P5 P6 P7 ¥ (SUM) CR 
 

Receive & A O G R1 R2 R3 R4 R5 R6 R7 ¥ (SUM) CR 
 

 Parameter 

P1 Reserved (1 digit): 00 fixed 

P2 Stage current value (Axis #1 absolute value) (12 digits, sign + or - as the head) 

P3 Stage current value (Axis #2 absolute value) (12 digits, sign + or - as the head) 

P4 Stage current value (Axis #3 absolute value) (12 digits, sign + or - as the head) 

P5 Offset value X (12 digits, sign + or - as the head) [1/10,000mm units] 

P6 Offset value Y (12 digits, sign + or - as the head) [1/10,000mm units] 

P7 Offset value Theta (12 digits, sign + or - as the head) [1/100,000 degree units] 

 

R1 Error (2 digits) 
00: Normal end 11: Specified mark unregistered 
01: Communication error 22: Mark0 undetected 
02: Checksum error 23: Mark1 undetected 
03: Command parameter error  

 

R2 X amount of deviation  (12 digits, sign + or - as the head) [1/10,000mm units] 

R3 Y amount of deviation  (12 digits, sign + or - as the head) [1/10,000mm units] 

R4 Theta amount of deviation  (12 digits, sign + or - as the head) [1/100,000 degree 
units] 

R5 Stage adjustment amount (Axis #1 absolute value) (12 digits, sign + or - as the 
head) 

R6 Stage adjustment amount (Axis #2 absolute value) (12 digits, sign + or - as the 
head) 

R7 Stage adjustment amount (Axis #3 absolute value) (12 digits, sign + or - as the 
head) 

 
Behavior of axes and input units 

 XYTheta Stage Line Theta Stage UVW Stage 

Axis #1 
absolute value 

X-axis position [1/10000 mm] U-axis position [1/10000 mm] 

Axis #2 
absolute value 

Y-axis position [1/10000 mm] V-axis position [1/10000 mm] 

Axis #3 
absolute value 

Theta-axis 
position 
[1/100000 
degree] 

Stroke position 
[1/10000 mm] 

W-axis position [1/10000 mm] 

 

Communication behavior 

Host  PV240 

Sends AOG command. → Executes object mark detection. 

Receives response. ← Sends AOG response. 
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Set Object Position 
Assigns the coordinate of an object position directly instead of the detected position by the checker, and 
executes alignment once. 

 

Send & O B S P1 P2 P3 P4 P5 ¥ (SUM) CR 
 

Receive & O B S R1 ¥ (SUM) CR 
 

 Error (Error signal = ON) 

 Parameter 

P1 Mark No. 
(2 digits, 00: Both, 01: Mark0, 02: Mark1) 

P2 Object* X coordinate value (Camera coordinate value) 
(12 digits, sign + as the head (sign - is unavailable) [1/10000 pixel units] 

P3 Object* Y coordinate value (Camera coordinate value) 
(12 digits, sign + as the head (sign - is unavailable) [1/10000 pixel units] 

P4 Object* X coordinate value (Camera coordinate value) 
(12 digits, sign + as the head (sign - is unavailable) [1/10000 pixel units] 

P5 Object* Y coordinate value (Camera coordinate value) 
(12 digits, sign + as the head (sign - is unavailable) [1/10000 pixel units] 

*) For specifying 00 for parameter P1, input the coordinate of Mark0 in P2 and P3, and the 
coordinate of Mark1 in P4 and P5. For specifying 01 for P1, input the coordinate of Mark0 in 
P2 and P3, and input the coordinate +00000000000 in P4 and P5 respectively. For 
specifying 02 for P1, input the coordinate of Mark1 in P2 and P3, and input the coordinate 
+00000000000 in P4 and P5 respectively. 

R1 Error (2 digits) 
00: Normal end 
02: Checksum error 
03: Command parameter error 
14: Alignment calculation failed 
15: Calibration data unregistered 
17: Target coordinate unregistered 
60: Alignment checker unregistered  
61: Calibration checker unregistered  
63: Object checker unregistered  
64: Sequence error 
66: Inexecutable due to the PV not in RUN mode 
Error (Error signal = ON) 

Communication behavior 

Host  PV240 

Sends AAE and AAS commands. → Object undetected. 

Receives AAE and AAS 
responses. 

← Sends AAE and AAS responses with error 
codes 22 and 23. 

Sends OBS command. → Calculates the amount of deviation and 
stage adjustment amount. 
Displays the stage adjustment amount in 
Data R/W. 

Receives response. ← Sends OBS response. 

Sends AZG command. → Receives AZG command. 

Moves stage. ← Sends AZG response with the stage 
adjustment amount. 
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OBS Command Flow 
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Output Alignment Result Data 
Saves the latest result of the execution of alignment to an SD card. 
For using this function, set "Output" for SD Card to "No" in "ENVIRONMENT" > "Input/Output" > "General 
Output". 
This function is used to output the latest alignment result held by PV240 to an SD card when the following 
RTD command is received regardless of the settings of "Alignment result output" and "Output Conditions" in 
"ENVIRONMENT" > "Input/Output" > "Alignment result output". 

 

Output destination: ¥ Panasonic-ID SUNX Vision ¥PV240¥Result 

File name: YYYYMMDD_ALN_RSLT.txt 
YYMMDD: Alignment execution time (When a date is changed, results are output to another file.) 

 
Output content 

• Execution date 
• Judgement 

• Inspection Time (Outputs "--------------".) 

• No. of retries 

• Amount of deviation X 

• Amount of deviation Y 

• Amount of deviation Theta 

• Mark the amount of deviation M0 X, Mark the amount of deviation M0 Y 

• Mark the amount of deviation M1 X, Mark the amount of deviation M1 Y 
All the above results are output. 

 
For details of the output format of results, refer to page 25 ”Result Data Output 
Format”. 

 

Send 
 

& R T D ¥ (SUM) CR 

Receive & R T D R1 ¥ (SUM) CR 
 

 Error (Error signal = ON, Error number is displayed in the information display area at the same 
time.) 

Parameter 

R1 Error (2 digits) 
00: Normal end 
01: Communication error 
02: Checksum error 
15: Calibration data unregistered 
17: Target coordinate unregistered 
61: Calibration checker unregistered  
62: Target checker unregistered 
63: Object checker unregistered 
66: Inexecutable due to the PV not in RUN mode 
97: General output SD card output error 

 

 

Communication behavior 

Host  PV240 

Sends RTD command. → Outputs alignment result. 

Receives response. ← Sends RTD response. 
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4.4 PLC Communication  

4.4.1 Overview and Communication Specifications 

This method communicates with a PLC according to the protocol of the destination PLC. Either RS-232C 
interface or Ethernet interface can be used.  
The following communications are available with PV240. 

 

・General output  

When accepting an inspection start signal (parallel input including reinspection signal, control command by 
communication or TRIG input by keypad) in RUN menu, after the inspection, the inspection results that are set 
to be output, Scan count, Total judgement, Judgement, Numerical calculation) are written to a specified register 
of PLC as the beginning. Only integers can be written. The PLC does not need a communication program to 
receive data. For the information of the settings to use this function, refer to PV200 User’s Manual. 

A function to resend general output is not available. 

 

・Control command 

Using this function enables to control PV240, read and change the setting values. Only integers can be read 
and changed.For the information of the settings to use this function, refer to PV200 User’s Manual. 
PV240 can accept all the general communication commands even when PLC communication is selected. 

Usable PLCs for PLC Communication  
The following list shows the PLC models available for PLC communication via a RS232C or Ethernet 
interface. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

*1) TOOL port, COM port, FP2-MCU (RS232C communication block), FP2-CCU 
*2) Applicable unit: FP-X COM5 communication cassette, FP Web Server 2 unit 
*3) Applicable unit: CPU with a built-in Ethernet, Ethernet unit (QJ71E71-100) only 
*4)For using FX or FX-2N series, it is recommended to use the settings of A/FX series. 

 

 
• When Baud Rate is "115200 bps", the communication via RS232C interface may not be carried out 

stably in accordance with PLC to communicate with. In the case, set Baud Rate to "57600 bps" or lower. 
• PLC communication via Ethernet interface is performed with UDP/IP. 

Manufacturer Model (series) name RS232C Ethernet 
Panasonic Industrial Devices 
SUNX Co., Ltd. 

FP series Available *1) Available *2) 

FP2 ET-LAN unit  Available 

Mitsubishi Electric Corporation 
(MELSEC) 

A /FX series Available  

Q series Available Available *3) 

FX series(older ver.)  
(FX1N)*4) 

Available  

FX-2N series(older ver.)  
(FX2N, FX3U, FX3UC)*4) 

Available  

OMRON Corporation C series, CV series, CS1 series Available  

Allen-Bradley SLC500 Available  

Fuji Electric FA Components & 
Systems Co., Ltd. 

MICREX-SX SPH series Available  
 

Yokogawa Electric Corporation FA-M3/e-RT3  Available 

(Standard) MODBUS RTU  Available  
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Specifications of PLCs 

 
In accordance with specification of PLCs, some of the registers in "Usable range" of "Usable device" listed 
below could not be used. Please confirm the specifications of PLC before use. 

 

Panasonic: FP / Panasonic: FP(ET-LAN unit) 

 Protocol: MEWTOCOL 

 Usable 
device 

Data output/ Type switch DT 

Data output completion notice Register* WR 

 Bit 0-15 (0-F) 

 Control command Control Register WR 

  Command Input/Output Register DT 

 Sum check: Yes (type: BCC) 

Mitsubishi: MELSEC-Q 

 Protocol: 
- RS232C interface: “Format 4”, 4C frame compatible for QnA 
- Ethernet interface: 3E frame compatible for QnA 

CPU with a built-in Ethernet port, Ethernet unit (Applicable unit: QJ71E71-100 only) 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value" is command start 
bit, "Specified value +16" is processing 
bit and "Specified value +17" is error bit.) 

  Command 
Input/Output Register 

D 

 Make the following setting with PLC. 
When using RS-232C Interface 
- Sum check: Yes (type: BCC) 
- Write at RUN time: "Enable" 

When using Ethernet interface 
- Communication data code: Binary code communication  
- Initial timing setting: Always wait for OPEN 
- Send frame setting: Ethernet(V2.0) 
- Write at RUN time: "Enable" 

Mitsubishi: MELSEC-A/FX("Mitsubishi: MELSEC-A" for 
versions older than Ver.1.3) 

 Protocol: “Format 4”, 1C frame compatible for A 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value" is command start 
bit, "Specified value +16" is processing 
bit and "Specified value +17" is error bit.) 

  Command 
Input/Output Register 

D 

 Make the following setting with PLC. 
- Sum check: Yes (type: BCC) 
- Modification in RUN mode: Available 
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Mitsubishi: MELSEC-FX 

 For using FX-series, it is recommended to set PLC type to "Mitsubishi: MELSEC-A/FX". 

 CPU: FX1N, Communication adapter: FX1N-232-BD 

 Protocol: Special protocol for FX1N 
Register for specifying communication format: Store "0" in D8120. (Reboot the PLC after the setting.) 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value x16" is 
command start bit, "Specified 
value x16 +16" is processing bit 
and "Specified value x16 +17" is 
error bit.) 

  Command 
Input/Output 
Register 

D 

 Sum check: Yes 
With PLC, you cannot select to perform sum check. Automatically “Yes” is selected. 

Mitsubishi: MELSEC-FX-2N 

 For using FX-2N series, it is recommended to set PLC type to "Mitsubishi: MELSEC-A/FX". 

 CPU: FX2N, FX3U, FX3UC 
Communication adapter: FX2N-232-BD, FX3U-232-BD, FX3U-232-ADP 

 Protocol: Special protocol for FX2N 
Register for specifying communication format: Store "0" in D8120. (Reboot the PLC after the setting.) 

 Usable 
device 

Data output/ Type switch D 

Data output completion notice Register* M 

 Bit Invalid 

 Control command Control Register M ("Specified value x16" is 
command start bit, "Specified 
value x16 +16" is processing bit 
and "Specified value x16 +17" is 
error bit.) 

  Command 
Input/Output 
Register 

D 

 Sum check: Yes 
With PLC, you cannot select to perform sum check. Automatically “Yes” is selected. 

C, CV, and CS1 series by OMRON Corporation 

 Protocol: Host link 

 Usable 
device 

Data output/ Type switch D / DM 

Data output completion notice Register* CIO / IR 

 Bit 0-15 (0-F) 

 Control command Control Register CIO / IR 

  Command Input/Output Register D / DM 

 

 Make the following setting with PLC. 
- Sum check: Yes 
- Station No.: "0" 

 Communication is not available when PLC is in "Run" mode. Change to "Monitor" mode to 
communicate. 
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MICREX-SX (SPH series) by Fuji Electric FA Components & 
Systems Co., Ltd. 

 Usable device 

 Usable 
device 

Data output/ Type switch %MW3 

Data output completion notice Register* %MW3 

 Bit 0-15 (0-F) 

 Control command Control Register %MW3 

  Command Input/Output Register %MW3 

 Sum check: Yes (type: BCC, the calculation method developed by Fuji is used.) 

SLC series by Allen-Bradley 

 Usable 
device 

Data output/ Type switch N7 (Only integer registers) 

Data output completion notice Register* N7 (Only integer registers) 

 Bit 0-15 (0-F) 

 Control command Control Register N7 (Only integer registers) 

  Command Input/Output Register N7 (Only integer registers) 

 Make the following setting with PLC. 
- Duplicate Detect: OFF 
- ACK Timeout (*20 ms): 20 
- Control Line: NO HANDSHAKING 
- Error Detect: CRC 
- NAK Retries: 3 
- ENQ Retries: 0 
- Embedded Responses: AUTO DETECT 
 

MODBUS RTU 

 Usable 
device 

Data output/ Type switch Holding register 

 Data output completion notice Bit Coil 

 Control command Control Register Coil 

  Command Input/Output Register Holding register 
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4.4.2 Setting PLC Communication  

In PLC communication, commands and results are sent and received using the registers of a PLC to 
communicate. More than one register area is used for each function. Set register areas as the figure below. 

Relation between setting items and PLC registers  

 

 

PLC Communication Common Setting 
This is the common setting for sending and receiving result output and control commands. 

1. Select ”ENVIRONMENT” > “Input/Output” > “PLC Communication” from the menu bar. 

2. Select a communication port in "Communication 
Type". 
Select "PLC Type". 

Serial Communicates with RS-232C 
interface. 

  

Ethernet Communicates with Ethernet 
interface. 

  

 
Selectable PLC types differ depending on the 
communication type. 
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3. Set time for “Timeout (ms)”.  

20 – 20000 msec  (default: 5000) 
 

When PV240 writes data in the specified address of 
PLC, it sends and receives commands and response 
messages in the dedicated protocol between PV240 
and PLC. The value set here is Timeout in the message 
communication in this case. 
If PLC sends no response in the time of Timeout, a 
timeout error occurs. 

4. Set "No. of Error Retries". 
0 – 255  (Default: 0) 

 

5. According to the function to be used, set "Result 
Output" or "Communication Command". 

 

 

PLC Communication (General) Output Setting 

1. Make PLC communication common settings. 

2. Select “ENVIRONMENT” > “Input/Output” > “PLC Communication” > “Result Output” from the menu 
bar.  

 

3. In “Data Output Register”, specify the first 
register number of the PLC that PV240 outputs 
data into. 

0 to 99999 are available. 
 

 
Not all addresses 0 to 99999 can be used in 
destination PLC. As the address allowed to be 
written by the external device (PV240) varies 
depending on PLC, please make sure the address 
with the instruction manual of PLC. 
The number of data registers differ depending on 
the number of data to be output and "Bit Width". Be 
sure to set address number not to destroy the 
contents of registers used for other applications. 

 

 

4. Select 16-bit or 32-bit to output Scan count and Numerical calculation data in “Bit Width” 
according to the maximum value of the data to be output.When output data exceeds the value 
which can be output in the selected Bit Width, "0" is output. 

5. To notice to PLC that data output is complete, set “Data Output Completion Notice” to “Yes”.  

Specify an address to make the specified bit to “1” and the bit. 
 

Register: 0 - 99999: It varies according to the PLC used. 

Bit: 0 - 15: Specifying “15” makes the highest order bit "1". 
 

 
For Mitsubishi PLC, enter interface No. to output register. (Output bit is invalid.) 

 

6. Select “ENVIRONMENT” > “Input/Output” > “General Output” from the menu bar. 
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7. Set "Output" to "Yes" for the selected 
communication port, and select "PLC 
communication" in Protocol. 

When the communication port is 
Ethernet, select the column of PLC 
communication in advance. For PLC 
communication, either “Serial” or 
“Ethernet” can be selected.. 

 

8. Set "Date/Time", "Scan Count", "Total 
Judgement", "Judgement", and 
"Numerical Calculation" to "Yes" as 
necessary. 

 

 

 

PLC Communication Control Command Setting 

Make PLC communication common settings.  

1. Select either "Polling" or "Parallel Input" in "Command 
Read Type" from "ENVIRONMENT" > "Input/Output" > "PLC 
Communication". 

Select the trigger for PV240 to start reading data from PLC.  

 No Not perform command control. 

 
Polling:  Periodically checks whether commands are written in PLC or not, and starts 

reading the commands once the completion is confirmed. The response speed 
is slower than that of "Parallel Input". 
The time such as the time of inspection or image output gets longer because the 
polling process is performed even during the inspection. 
Set "Polling Time" and "Start Bit Off Timeout" in step 7. 
Set "Watch Dog Timer" as necessary. 

 
Parallel Input Starts reading commands from PLC when the signal is input to PV200 from a 

parallel input terminal (*). 
 *: Terminal among one of ASSIGN0, 1 and EXTRA 0 to 2 assigned to "PLC 
Communication Command". (Set in "ENVIRONMENT" > "Input/Output" > "Parallel 
I/O") 

2. Open the "Communication Command" menu. 

 

The display of "WR" and "DT" in the menu is different 
between PLC types. 
 
 
 

 

 

3. ”Control Register": Specify the start address of the 
control register to be used for sending and receiving 
the control command. 
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According to the bit information of the 
specified control register, it is used as 
the command start bit, error bit, 
processing bit or transmitting bit. 
It is used as the watch dog bit when 
using watch dog timer. 
For the information of using the 
control register.  

 

Example: Control Register = 10 

4. ”Command Input Register": Specify the start register number in which PLC writes commands 
for PV240. 

There is a command which uses a maximum of twelve words. It is recommended not to use twelve words 
for other applications. 
Please refer to PV200User’s Manual for details. 

5.  ”Command Output Register": Specify the start register number in which PV200 writes 
responses to PLC. 

There is a response which uses a maximum of nine words. It is recommended not to use nine words for 
other applications. 
Please refer to PV200User’s Manual for details. 

6. When "Polling" was selected in step 2, set "Polling Time (ms)" and "Start Bit Off Timeout 
(ms)". 

”Polling Time”  The cycle that PV240 monitors the registers of PLC. The shorter the cycle, the 
faster the response after a command is written by PLC. However, it affects the 
execution time as PV240 monitors the PLC registers during inspections. 
The actual polling frequency may be longer than the frequency set here. The 
actual polling frequency is displayed in the information area of RUN menu. 
Please check it. 

”Start Bit Off 
Timeout”  

The time until PLC turns off the command start bit after PV240 turns on the 
command processing bit. The error (E0113) occurs when the command start bit 
does not turn off within the time set here. 

 

7.  When "Polling" was selected in step 2, set " Watch Dog Timer" and “WD Time (ms)”as 
necessary. 

The watch dog timer is to notify that PV240 is in the normal communication status such as no 
disconnection of the communication cable to PLC. When setting "Watch Dog Timer" to "Yes", the watch 
dog bit is overwritten during inspection. It affects the execution time or the response time to the 
command transmitted from PLC. 
 

No  Not activate watch dog timer. 

Yes  Activates watch dog timer. "Watch Dog Time" can be set freely, however, the 
watch dog timer is activated with a period of polling time. Actually, it is activated 
with a period of the integral multiple of polling time and a longer period of the set 
watch dog time. For information on the registers used for watch dog, refer to 
PV200 User’s Manual. 
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When performing PLC communication using RS-232C Interface  

1. Make PLC communication common settings. 

2. Only when selecting "Panasonic: FP" for PLC Type, set 
"Specify Station No.". 

Station Home (Default):  
A command which specifies no station number is issued. 
Example) %EE#WDD0001 ⋅ ⋅ ⋅ ⋅ ⋅ 

 
Specify Station No. (Station No.:1 – 99):  
A command for a PLC with the specified station number is 
issued. Specify the same number of the station number that 
is set for the PLC to communicate in "Station No.". 
Example) When Station No. is 99 %99#WDD0001 ⋅ ⋅ ⋅ ⋅  

 

When performing PLC communication using Ethernet interface 
 Applicable PLCs are three types. 

1. Make PLC communication common settings. 
 

2. Specify the network setting of the selected 
"PLC Type". 

The network setting consists as listed below. 
- PV240 station No. 
- PLC IP address 
- PLC Port No. 
- Specify PLC Station No. 
- PLC Station No. 

 
Items to be specified vary depending on the 
selected PLC type. For the detail, refer to steps 
3 to 6. 

 

3. Specify the PV240 station No. in "PV Station No.". 

Selectable station No.: 1 to 64 
 

Set only when PLC Type is Panasonic: FP (ET-LAN unit) 

4. Assign the IP address to the PLC. 

5. Specify the port number of the PLC. 

Input the same number as the port number set on the PLC to communicate. 
When PLC Type is Panasonic: FP  
When PLC Type is Panasonic: FP (ET-LAN unit) 
Available port No. on PV240: 1 to 32767 (except 8600 to 8699 and 9090) 

Default: 9094 
 
When PLC Type is Mitsubishi: MELSEC-Q 
Available port No. on PV240: 1 to 65534 (except 8600 to 8699 and 9090) 

Default: 5000 
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6. Select whether to limit the PLC to communicate by setting "Specify Station No." or not. 

 
This item is set when PLC Type is Panasonic: FP or Panasonic: FP(ET-LAN unit). 
 

Station Home 
(Default): 

A command which specifies no station number is issued. 
Example) %EE#WDD0001 ...... 

Specify Station 
No.  
(Station No. 1 - 
99) 

A command for a PLC with the specified station number is issued. Specify the 
same number of the station number that is set for the PLC to communicate. 
Example) When Station No. is 50, %50#WDD0001 ...... 

 
When PLC Type is Panasonic: FP  
Settable Range: 1 to 99 
 

When PLC Type is Panasonic: FP (ET-LAN unit) 
Settable Range: 1 to 64 
The number specified in the step 3 "PV Station No."  cannot 
be used. 
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4.4.3 Outputting Data through PLC Communication 

Data Output Flaw 

PV240    PLC 

     
Receives START signal  

 
 Outputs START signal for inspection 

execution. 

Turns on command processing bit in 
case of accepting inspection by control 
command. 

 
 

 

  

  Command read type: Always turns off 
command start bit in case of polling. Writes response in command output 

register, turns on response completion 
and turns off command processing bit. 

   

 
 

  

Executes an inspection; image capturing 
and performing checkers. 

 
 

  

 
 

 
  

Changes data output completion notice 
to “0” and writes data in PLC from the 
specified address. (Writes data 
communicating commands and 
response messages with the dedicated 
protocol.) 

 

 

 Writes data in the address specified by 
data output register. 

 
 

 
 

  

Changes data output completion notice 
to “1”. 

 
 

 As detecting data output completion 
notice is “1”, confirms the address where 
the data have been stored. 

 
 

 
 

 

Waits for the next signal.  
 

 Goes back to the beginning and outputs 
START signal for the next inspection 
execution. 

     

About Data that can be Output 
When PV240 executes inspection, the data set to output are output in the following order. 

1. Date/Time 

2. Scan Count 

2. Total Judgement 

3. Judgement result:  
Up to 1000 points combining judgements and numerical calculations. 

4. Numerical Calculation:  
 

In the following cases, the data of Judgement and Numeric Calculation are not output to PLC. 
• PV sets data to output, but no data exist. 
• The setting data exist, but data are set to not to be output. 
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Output format of Date/Time: 
Output Data Regardless of output bit width, 3 words (48 bits) are used. Order of output: 1st 

word; "Year and Month (YYMM)", 2nd word; "Date and Hour (DDH)", 3rd word; 
"Minute and second (MMSS)". It does not depend on the format of the calendar in 
PV240. 
(Output example) 
  15:26:03 on August 31, 2014 
    1408   3115   2603 
   YYMM  DDHH  MMSS 

Output format of Scan count: 
Output Data Differs depending on the setting of Output bit width. 

• Range (16 bits) between 1 and 32767 
• Range (32 bits) between 1 and 2147483647 

Number of Data 1 

Values to be Output Normal 1 to 2147483647 

Overflow (when exceeding the 
specified "Bit Width") 

0 

 

Output format of Total Judgement: 
Output Data Regardless of output bit width, it is output in the last bit using one word. 

Number of Data 1 

Values to be Output OK 1 in hexadecimal form (0001 in binary form) 

NG 0 in hexadecimal form (0000 in binary form) 

Error E in hexadecimal form (1110 in binary form) 

Unset E in hexadecimal form (1110 in binary form) 

 

Output format of Judgement data: 
Output Data A Judgement is output in 4-bit (digit) unit 

Four data of Judgement per word from PLC are saved starting with LSB. 
When the outputting data is other than multiples of four, hexadecimal E is 
output. 

Number of Data Up to 1000 

Values to be Output OK 1 in hexadecimal form (0001 in binary form) 

NG 0 in hexadecimal form (0000 in binary form) 

Error E in hexadecimal form (1110 in binary form) 

Unset Data are not output. (But if the Judgement data No.s before and 
after the unset data No. are set to output, E is output in 16-digit 
form (1110 in binary form).) 

 

Output format of Numerical Calculation:  

The values that can be output are only integers. Actual values with value after decimal point are rounded to 
whole number and output. 
Output Data Differs depending on the setting of Output bit width. 

• Range of 16-bit: -32768 to 32767 
• Range of 32-bit: -2147483648 to 2147483647 

Number of Data Numerical Calculation: Up to 1000 
Values to be Output Normal Range of specified bit width 

Overflow (when exceeding the 
specified "Bit Width") 

- Range of 16-bit: 
If the numerical calculation results to be 
output exceeds the ranges of 16-bit and 
32-bit regardless of setting to output or 
not, all the numerical calculation results 
are output as "0".  
- Range of 32-bit: 
Only the numerical calculation results 
which exceed the range of 32-bit are 
output as "0". 
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Error - Range of 16-bit: 
If an error occurs in any of the set 
numerical calculation regardless of 
setting to output or not, all the numerical 
calculation results are output as "0". 
- Range of 32-bit: 
(Only the erroneous numerical 
calculation result is output as"0".) 

Unset or not output Data are not output. 

Example of General Output 
Output Condition - Output Data: 
• Date and Time: 15:26:03 on August 31, 2014 
• Scan count: 1234 times 

• Total Judgement: OK 

• Judgement: JDC000=OK, JDC001=unset, JDC002=NG, JDC003 or later=Unset 

• Numerical Calculation: CAC000=215.3, CAC001=unset, CAC002=-2184.6, CAC003 or later=Unset 

 

Output Result: Bit Width(bit) = 16 bit, Data Output Register = 500 

Data 
Register 
No. 

Value 
(Hex.) Description Details 

Date/Time 

500 1408 Year-Month (Value calculated by subtracting 2000 from 
Year is displayed.) 

 

501 3115 Date-Hour  

502 2603 Minute-Second  

Scan Count 503 04D2 “1234” is stored. Scan 
Count 

  Bit 15                                            Bit 
0 

 

Total 
Judgement 

504 0001 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 OK 

Judgement 505 E01E 1 1 1 0 0 0 0 0 0 0 0 1 1 1 1 0 JDC001, 
JDC002 

Numerical 
calculation 

506 00D7 “215” is stored. CAC000 
507 F777 “-2185” is stored. CAC002 

Concept: 
• The number of scans is stored in the start register (data output register). 

When specifying "32-bit" for "Bit Width", the number of scans is stored in the first two registers. 

• Four pieces of judgement data are stored per word (16 bits). (Four bits are used for a piece of data.) 
Data is output up to Judgement specified with the largest number. For unset judgement data within 
the range, "E" is output such as JDC000. 
Also, when the number of output data is "3" which is not multiples of 4 like this example, "E" is 
stored in each part which cannot make a word. 

• Only the data of Numeric Calculation that are set to output are output. 
(In the case where the data of CAC000 or CAC002 is out of the range between -32768 and +32767, “0” 
is stored in the registers No.506 and 507.) 

• Numerical calculation results are rounded to whole numbers and output. 

• Negative numbers are output in the complement number of 2. 

• When specifying "32-bit" for “Output data”; 
- Four Judgement data are stored per word as the same as when you select "16-bit".  
- Each data of Scan Count and Numerical Calculation uses two words (32-bit). In the case, the data is 

output from of lower 16-bit to upper 16-bit, and data of lower word (16-bit) is stored in the register of 
smaller number. 
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4.4.4 Controlling PV240 through PLC Communication  

 

For controlling PV240 through PLC Communication, PLC sends commands to PV240 and receives the 
responses. 

For the details of the control and commands to be used, refer to PV200 User’s Manual .PV240 uses the 
following signals for the timings that PV240 reads commands sent by PLC and PLC receives responses. Refer 
to the timing charts for the details of the timing of each signal. 

Those signals can be read when PV240 is in RUN menu. PV200 cannot be controlled when it is in SETUP 
menu. (Refer to PV200 User’s Manual) 

 

Timing signal for PV240 to read the command sent by PLC 

The timing varies according to the selected "Command Read Type". 

Polling Uses the command start bit of the control register. PLC turns on the command start bit 
after writing a command. 

Parallel 
Input 

PLC turns on the signal of "Read PLC Communication Command" assigned to ASSIGN 
or EXTRA after writing a command. 

 

Timing signal for PLC to read the received response 

PV240 sets the response completion (COR = the first word of command output register) to 1 after writing 
responses. 

Also, PV240 sets the processing bit of the control register to zero after setting the response completion (COR) 
to one. 

Control register 
Example: Control Register = 10 

 
 

Command start bit: 

The zeroth register number specified in "Control Register". 
It is used when setting "Command Read Type" to "Polling". It indicates that a command was sent to PV240 
from PLC. PLC turns on (sets to 1) after setting the command. PV240 performs polling, and starts reading the 
command after confirming this bit is on. Also, PLC turns off this bit (sets to zero) when the processing bit is on. 

 

Processing bit:  

The zeroth bit of the next register number specified in "Control Register". 
PV240 turns on this bit (sets to 1) during the command processing. After the processing, PV240 writes 
response to the command in the command output register and turns off this bit (sets to zero). Monitoring this bit 
shows the timing that the next trigger can be used. 

 

Error bit:  

The first bit of the next register number specified in "Control Register". 
It indicates that an error occurred. When an error occurred, PV240 turns on this bit (sets to 1). 
(1) When the response error to the control command occurred 
(2) When the "Start Bit Off Timeout" error occurred when using polling 
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Transmitting bit : 

The eighth bit of the next register number specified in "Control Register". 
It indicates PV240 can communicate. In such state, PV240 turns on this bit (sets to 1). 
It turns on when RUN menu is displayed after the startup of PV240. As PV240 cannot perform PLC 
communication once switching to SETUP menu, PV240 turns off this bit (sets to zero).  

If PV200 is turned off or the communication cable is disconnected while this bit is on, it will retain on state. 

 

Watch Dog bit : 

The ninth bit of the next register number specified in "Control Register" 
When "Watch Dog Timer" is set to "Yes", PV240 switches this bit on (sets to 1) and off (sets to 0) periodically.  
The watch dog bit is overwritten with a period of the integral multiple of polling time and a longer period of the 
set watch dog time. However, when the transmitting bit is off, PV240 does not switch the watch dog bit on and 
off. Also, during some processings such as saving the image memory in a SD card (the processing bit turns 
on), the processing time of switching the watch dog bit on and off gets slow.  

Therefore, for checking communication errors, set the check timer long enough in combination with the 
processing bit, transmitting bit and watch dog bit. 

 

 Example of sequence for checking communication 
errors 

R110:  

R118:  

R119:  

 

T0: 

 

T1:  

 

R0:  

Processing bit 

Transmitting bit 

Watch Dog bit 

 

Watch dog bit ON 
check timer 

Watch dog bit OFF 
check timer 

Communication 
error 
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PLC Communication: Control Command Timing Chart 
(Command Read Type: Polling) 

 

 
 

Tc: Command processing time. It varies depending on the content. For example, the processing time of saving 
data in a SD card may be over several seconds. 

To: Timeout period. An error occurs when the command start bit does not turn off within the time of Tc + To. 
CR: PLC address specified in "Control Register". 
CIR: PLC address specified in "Command Input Register". 
COR: PLC address specified in "Command Output Register". 

1. PLC confirms that the command processing bit is off, and resets the response completion (COR) to 
zero to clear the previous result output. (Off-state) Then, PLC writes a command in the command 
input registers (CIR, CIR+1, ...) to give PV240. 

2. PLC turns on the command start bit. 
PV240 monitors the command start bit in the specified polling cycle, and starts reading the 
commands from the command input register (CIR) as the first register once it confirms that the 
start bit is on. 

3. PV200 turns on the command processing bit.  Also, PV240 turns off the error bit regardless of the 
previous state. 

4. PLC turns off the command start bit within the time of Tc + To after confirming the command 
processing bit is on. 
During this process, PV240 confirms that the command start bit is off by polling. 

PV240 responds the error code (113) when the command start bit does not turn off within the time of Tc + 
To. 

5. PV240 write responses in the command output register, and then sets the response completion 
(COR) to 1. (On-state) 

6. PV240 turns off or on the error bit according to the error occurrence, and then turns off the 
command processing bit. 
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PLC Communication: Control Command Timing Chart 
(Command Read Type: Parallel Input) 

 

 
 

CR: PLC address specified in "Control Register". 
CIR: PLC address specified in "Command Input Register". 
COR: PLC address specified in "Command Output Register". 

1. PLC confirms that the command processing bit is off, and resets the response completion (COR) to 
zero to clear the previous result output. (Off-state) Then, PLC writes a command in the command 
input registers (CIR, CIR+1, ...) to give PV240. 

2. PLC turns on the "Read PLC Communication Command" assigned to the parallel I/O terminal of 
PV240. 
PV240 starts reading the commands from the command input register (CIR) as the first register 
once it confirms this parallel signal is on. 

Assign "Read PLC Communication Command" to one of ASSIGN0-1 and EXTRA0-2 from 
"ENVIRONMENT" > "Input/Output" > "Parallel" in SETUP menu. 

3. PV240 turns on the command processing bit.  Also, PV240 turns off the error bit regardless of the 
previous state. 
PLC can turn off the "Read PLC Communication Command" signal after turning on the command 
processing bit. 

4. PV240 write responses in the command output register, and then sets the response completion 
(COR) to 1. (On-state) 

5. PV240 turns off or on the error bit according to the error occurrence, and then turns off the 
command processing bit. 
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4.4.5 List of PLC Communication Commands 

The following commands are used for PLC communication. 

List of Alignment Commands 

  Refer 
to 

Comm
and 

Description 

Request Stage Current 
Position 130 TAG Obtains the coordinate of the stage current position. 

Request Stage Absolute 
Position Move 131 TAR 

Specifies the movement amount of stage absolute position. 
It is specified with the absolute position (stage coordinate 
system) of XYTheta or UVW. 

Execute Calibration 132 CAE Starts a calibration sequence. 

Execute Auto Alignment 134 AAE Starts an auto alignment sequence. 
Target running offsets are specified. 

Execute Auto Alignment 
(Simple Flow) 135 AAS 

Starts an auto alignment sequence. Target running offsets are 
specified. Obtaining the stage current position (TAG) at the time 
of retry is omitted, and the execution time is shorter than AAE 
command. 

Get Target Position 136 TGG 

When "Target Position" is set to "Mark Detection", detected mark 
position is registered as target position. When "Target Position" is 
set to "Center of Display", center position of display is registered 
as target position. 

Get Object Position 137 OBG Detects object marks. 

Reset, Cancel Alarm 138 ARR Turns off the parallel I/O error flag. 
Clears an error message on the screen. 

Execute Aligment for 1 
camera 139 ACL Executes an alignment sequence once at an obtained object 

position. 

Get Deviation 140 GDV Obtains the amount of deviation between the target and object 
positions. 

Get Stage Adjustment 
Amount 141 AZG Obtains the adjustment amount (absolute value) based on the 

current position (absolute value). 

Set Target Position 
(Specify Camera 
Coordinate)  

141 TGS Specifies camera coordinates and registers the position. 

Move Rotation Center 143 SRP Moves the rotation center for alignment calibration. 

Print Screen 144 PS Obtains print screen images of screens. 

Save Print Screen in 
Image Memory 145 PSM Saves print screen images in the dedicated image memory. 

Save Print Screen in SD 145 SSM Saves print screen images saved in the dedicated image memory 
to an SD card, and clears data within the image memory. 

Get Distance between 
Target/Object Marks 146 GML Obtains two distances between target marks and the distance 

between object marks. 

Change Camera Shutter 
Speed 146 CSH Changes the shutter speed of a camera. 

Change Threshold of 
Change Judgement 147 SCT Changes the threshold of change judgement of X, Y and Theta. 

Get Deviation/Stage 
Adjustment Amount 148 AOG Obtains the current value, and returns the adjustment amount 

plus the amount of deviation after the detection of an object. 

Set Object Position 149 OBS Assigns the coordinate of an object position directly instead of the 
detected position by the checker when executing alignment. 

Output Alignment Result 
Data 

150 RTD Saves the latest result of the execution of Alignment to an SD 
card. 

 
*1: Both reading and writing cannot be executed when the PV240 stops. 

*2: This cannot be executed when you select “TOOL” > "General", "Setting Help", or "Update". 
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4.5 Descriptions of PLC Communication Commands 
 

The "Command" in the tables means commands to be issued (sent) to PV200 from PLC. CIR is written at the 
beginning. The "Response" means the responses to PLC from PV240 to the sent commands. COR is written at 
the beginning. 

The CIR and COR in the tables mean the following contents. 
CIR:  
 

Address specified in "Command Input Register". A request to PV240 is 
written with this address at the beginning.  

COR: 
 

Address specified in "Command Output Register”. A response is 
written by PV240 with this address at the beginning.  

The common error codes in PLC communication are as follows. For the details of the error codes peculiar to 
each command, refer to the description of each command.  

Error code 
100 An undefined command was sent. 

111 • PLC response timeout 
• Register number error 
• Format error of a response from PLC 

113 Command Start Bit Off Timeout 

114 When "Parallel Input" has not been selected for "Command Read Type", the "Read 
PLC Communication Command" signal was input. 

 

For Read and Write commands 
200 Operation is stopped. (However, except Read of "Operation Status") 

252 • The specified parameter does not exist. (e.g. The number of uncreated checker is 
specified as a parameter.) 

• The specified parameter value is out of the settable range. (e.g. Maximum value 
of slice level is being set to over 256.) 

• The specified values led to the status of “Maximum value < Minimum value” when 
entering them. 

• When specifying the moving distance of the marker, a part of the circumscribing 
rectangle of the marker (the intersection point when Shape is Cross line) after move 
was out of the nine screens where checker area is settable. 
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Request Stage Current Position［TAG］ 
Requests the stage current position. 
 

 
 XYTheta Stage Line Theta Stage UVW Stage 

Axis #1 absolute value X-axis position U-axis position 

Axis #2 absolute value Y-axis position V-axis position 

Axis #3 absolute value Theta-axis 
position 

Stroke position W-axis position 

Axis #4 absolute value 
Not used (0 fixed) 

Axis #5 absolute value 

 
Parameter  

X-axis position 1 / 10000 mm 

Y-axis position 1 / 10000 mm 

Theta-axis position 1 / 100000 degree 

Stroke position 1 / 10000 mm 

U-axis position 1 / 10000 mm 

V-axis position 1 / 10000 mm 

W-axis position 1 / 10000 mm 

 
 
 
 

 Command    Response 

 CIR 4001 h   COR 000A h  

 CIR +1 0100 h   COR +1 

 

Normal end = 0 
or Error code 

 

 CIR +2 0014 h    

 CIR +3 , CIR +4 Axis #1 absolute value  COR +2 0000 h  

 CIR +5 , CIR +6 Axis #2 absolute value    

 CIR +7 , CIR +8 Axis #3 absolute value    

 CIR +9 , CIR +10 Axis #4 absolute value    

 CIR +11,CIR +12 Axis #5 absolute value    
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Request Stage Absolute Position Move［TAR］ 
Specifies the movement amount of stage absolute position. 
It is specified with the absolute position (stage coordinate system) of XYTheta or UVW. 
 

 

 
 XYTheta Stage Line Theta Stage UVW Stage 

Axis #1 absolute value X-axis position U-axis position 

Axis #2 absolute value Y-axis position V-axis position 

Axis #3 absolute value 
Theta-axis 

position 
Stroke position Theta-axis position 

Axis #4 absolute value 
Not used (0 fixed) 

Axis #5 absolute value 

 
Parameter  

X-axis position 1 / 10000 mm 

Y-axis position 1 / 10000 mm 

Theta-axis position 1 / 100000 degree 

Stroke position 1 / 10000 mm 

U-axis position 1 / 10000 mm 

V-axis position 1 / 10000 mm 

W-axis position 1 / 10000 mm 

 
 

 Command    Response 

 CIR 4001 h   COR 0014 h  

 CIR +1 0200 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0000 h    

    COR +2 0014 h  

    COR +3 , COR +4 Axis #1 absolute value 

    COR +5 , COR +6 Axis #2 absolute value 

    COR +7 , COR +8 Axis #3 absolute value 

    COR +9 , COR +10 Axis #4 absolute value 

    COR +11,COR +12 Axis #5 absolute value 
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Execute Calibration [CAE] 
Starts a calibration sequence. 
 

 
Parameter  

Mark No. 
0: Mark0 and Mark1 
1: Mark0 
2: Mark1 

Reserved 0: Fixed 

 
●Command Flow 

 

Note1) Error processing is performed when movement cannot be completed. 
Note2) Alignment checker execution error processing 

 

 Command    Response 

 CIR 4010 h   COR 001E h  

 CIR +1 0100 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0008 h    

 CIR +3 , CIR +4 Mark No.  COR +2 0000 h  

 CIR +5 , CIR +6 Reserved    
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Execute Calibration (with Rotation Point 
Adjustment) [CAE] 
Starts a calibration sequence when Rotation Point Adjustment is performed. 
 

 

Parameter  

Mark No. 
0: Mark0 and Mark1 
1: Mark0 
2: Mark1 

Reserved 0: Fixed 

Final deviation 1 / 10000 mm 

 

 Command    Response 1 

 CIR 4010 h   COR 001E h  

 CIR +1 0100 h   COR +1 Error Code  

 CIR +2 0008 h   COR +2 0000 h  

 CIR +3 , CIR +4 Mark No.     

 CIR +5 , CIR +6 Reserved  Response 2 

    COR 001E h  

    COR +1 Error Code  

    COR +2 0004 h  

    COR +3 , COR +4 Final deviation  

      

    Response 3 

    COR 001E h  

    COR +1 Error Code  

    COR +2 0008 h  

    COR +3 , COR +4 Final deviation  

    COR +5 , COR +6 Final deviation  
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Execute Auto Alignment［AAE］ 
Starts an alignment sequence. 
This command is used when capturing two object marks simultaneously. 

 
When the timing of capturing the object mark0 is different from that of capturing the mark1, use ACL 
command. 
 

 
Parameter  

Reserved 0: Fixed 

X offset 1 / 10000 mm 

Y offset 1 / 10000 mm 

Theta offset 1/100,000 degree 

 
●Command Flow 

 

Note1) Error processing is performed when movement cannot be completed. 
Note2) Alignment checker execution error processing 

 Command    Response 

 CIR 4010 h   COR 0028 h  

 CIR +1 0200 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3 , CIR +4 Reserved  COR +2 0000 h  

 CIR +5 , CIR +6 X offset    

 CIR +7 , CIR +8 Y offset    

 CIR +9 , CIR +10 Theta offset    
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Execute Auto Alignment (Simple Flow)［AAS］ 
Starts an auto alignment sequence. Target running offsets are specified. Obtaining the stage current 
position (TAG) at the time of retry is omitted, and the execution time is shorter than AAE command. 
This command is used when capturing two object marks simultaneously. 

 
When the timing of capturing the object mark0 is different from that of capturing the mark1, use ACL 
command. 

 

 

Parameter  

Reserved 0: Fixed 

X offset 1 / 10000 mm 

Y offset 1 / 10000 mm 

Theta offset 1 / 100000 degree 

 
 

 Command    Response 

 CIR 4010 h   COR 002A h  

 CIR +1 0202 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3, CIR +4 Reserved  COR +2 0000 h  

 CIR +5, CIR +6 X offset     

 CIR +7, CIR +8 Y offset     

 CIR +9, CIR +10 Theta offset     
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Get Target Position［TGG］ 
When "Target Position" is set to "Mark Detection", a detected mark position is registered as the target 
position. 
When "Target Position" is set to "Center of Display", the center position of the display is registered as the 
target position. 
 

 
Parameter 

Mark No. 
0: Mar0 and Mar1 
1: Mark0 
2: Mark1 

 
●Command Flow 

 
 
 

 Command    Response 

 CIR 4020 h   COR 003C h  

 CIR +1 0100 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0004 h    

 CIR +3 , CIR +4 Mark No.  COR +2 0000 h  
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Get Object Position［OBG］ 
Detects object marks. 
 

 
Parameter 

Mark No. 
0: Mar0 and Mar1 
1: Mark0 
2: Mark1 

 
●Command Flow 

 
 
 

 Command    Response 

 CIR 4020 h   COR 0046 h  

 CIR +1 0200 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0004 h    

 CIR +3 , CIR +4 Mark No.  COR +2 0000 h  
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Reset, Cancel Alarm［ARR］ 
Turns off the parallel I/O error flag. 
Clears an error message on the screen. 
 

 

 
●Command Flow 

 
 

 

 Command    Response 

 CIR 4030 h   COR 0064 h  

 CIR +1 0100 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0000 h    

    COR +2 0  
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Execute Alignment for 1 Camera (with Target 
Offsets)［ACL］ 
Executes an alignment sequence once by this command after obtaining two object positions. Target offsets 
can be specified. 
This command is used when the timing of capturing object marks is different between Mark0 and Mark1, in 
such a case that one object mark is captured after moving a camera after the other mark was captured. (It is 
not related to "TYPE" > "Type Setting" > Capture Delay".) Use AAE or AAS command for capturing two 
object marks simultaneously. 
 

 

Parameter  

Reserved 0: Fixed 

X offset 1 / 10000 mm 

Y offset 1 / 10000 mm 

Theta offset 1 / 100000 degree 

 
●Command Flow 

 
 

Note1) Error processing is performed when movement cannot be completed. 
Note2) Alignment checker execution error processing 

 Command    Response 

 CIR 4010 h   COR 00C8 h  

 CIR +1 0400 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3, CIR +4 Reserved  COR +2 0004 h  

 CIR +5, CIR +6 X offset  COR +3, COR +4 Result* = OK (0000), NG (0001) 

 CIR +7, CIR +8 Y offset   * A value returned to "Result" at the 
time of error occurrence is not 
determined. Sometimes, 0000 is 
returned. 

 CIR +9, CIR +10 Theta offset   
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Get Deviation (with Target Offsets)［GDV］ 
Gets the difference between the currently detected target position and object position. Target offsets can be 
specified. 
 

 

Parameter  

X-axis offset,  
X amount of deviation 1 / 10000 mm 

Y-axis offset,  
Y amount of deviation 1 / 10000 mm 

Theta-axis offset, Theta 
amount of deviation 1 / 100000 degree 

 
●Command Flow 

 
 

Note1) The latest object position has been detected. 
Note2) Alignment checker execution error processing 

 

 Command    Response 

 CIR 4040 h   COR 008C h  

 CIR +1 0400 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3, CIR +4 Reserved (0 fixed)  COR +2 000C h  

 CIR +5, CIR +6 X offset  COR +3, COR +4 X amount of deviation  

 CIR +7, CIR +8 Y offset  COR +5, COR +6 Y amount of deviation  

 CIR +9, CIR +10 Theta offset  COR +7, COR +8 
Theta amount of 

deviation 
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Get Stage Adjustment Amount (Absolute Value)
［AZG］ 
Obtains the adjustment amount (absolute value) based on the current position (absolute value). 
 

 

 XYTheta Stage Line Theta Stage UVW Stage 

Axis #1 
absolute value 

X-axis position U-axis position 

Axis #2 
absolute value Y-axis position V-axis position 

Axis #3 
absolute value 

Theta-axis position Stroke position W-axis position 

Axis #4 
absolute value 

Not used (0 fixed) 
Axis #5 
absolute value 

 

Parameter  

X-axis position 1 / 10000 mm 

Y-axis position 1 / 10000 mm 

Theta-axis position 1 / 100000 degree 

Stroke position 1 / 10000 mm 

U-axis position 1 / 10000 mm 

V-axis position 1 / 10000 mm 

W-axis position 1 / 10000 mm 

 
●Command Flow 

 

Note1) The amount of deviation has been calculated by GDV command. 
Note2) Alignment checker execution error processing 

 Command    Response 

 CIR 4010 h   COR 0096 h  

 CIR +1 0500 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0018 h    

 CIR +3, CIR +4 Axis #1 absolute value  COR +2 0014 h  

 CIR +5, CIR +6 Axis #2 absolute value  COR +3, COR +4 Axis #1 absolute value  

 CIR +7, CIR +8 Axis #3 absolute value  COR +5, COR +6 Axis #2 absolute value  

 CIR +9, CIR +10 Axis #4 absolute value  COR +7, COR +8 Axis #3 absolute value  

 CIR +11, CIR +12 Axis #5 absolute value  COR +9, COR +10 Axis #4 absolute value  

 CIR +13, CIR +14 Reserved (0 fixed)  COR +11, COR +12 Axis #5 absolute value  
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Set Target Position (Specify Camera Coordinate) 
［TGS］ 
Specifies camera coordinates and registers the target position. 
 

 

Parameter 

Mark No. 1: Mark0 
2: Mark1 

Camera X coordinate 1 / 10000 pix 

Camera Y coordinate 1 / 10000 pix 

 Command    Response 

 CIR 4020 h   COR 003E h  

 CIR +1 0101 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 000C h    

 CIR +3, CIR +4 Mark No.   COR +2 0000 h  

 CIR +5, CIR +6 Camera X coordinate      

 CIR +7, CIR +8 Camera Y coordinate      
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Move Rotation Center［SRP］ 
Moves the rotation center for alignment calibration. 
 

 

Parameter 

Mark No. 1: Mark0 
2: Mark1 

Reserved 0 (Fixed) 

X-axis movement 1 / 10000 mm 

Y-axis movement 1 / 10000 mm 

 Command    Response 

 CIR 4040 h   COR 006E h  

 CIR +1 0100 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3, CIR +4 Mark No.   COR +2 0000 h  

 CIR +5, CIR +6 Reserved      

 CIR +7, CIR +8 X-axis movement      

 CIR +9, CIR +10 Y-axis movement      



 

144 

Print Screen［PS］ 
Obtains print screen images of screens. 
 

Print Screen (Specify File Name)［PS NAME］ 
Obtains a print screen image of a specified file name. 
 

 
●Example of file name: "ABC" 

Register No. Character 1 byte = 16 bits 

Checker No. BA 0x4241 

X offset 0C 0x0043 

 

 Command    Response 

 CIR 0600 h   COR 
Response completion = 

1 
 

 CIR +1 0130 h   
COR +1 

Normal end = 0 
or Error code 

 

 CIR +2 0    

     COR +2 0  

 Command    Response 

 CIR 0600 h   COR 
Response completion = 

1 
 

 CIR +1 0133 h   
COR +1 

Normal end = 0 
or Error code 

 

 CIR +2 0006 h    

 CIR +3 

File name 

  COR +2 0000 h  

 CIR +4      

 CIR +5      



 

145 

Save Print Screen in Image Memory［PSM］ 
Saves print screen images in the dedicated image memory. 
 

 
●Error code 

265 • Image data was discarded because the number of saved print screen images exceeds the 
limit (10 images). 

• No SD memory card is attached or cannot be accessed. 
• Capacity of the SD memory card is used up. 
• The SD memory card is write-protected. 
• "Write When Cover is Open" is se to "Disable", and the cover is open. 
• Ethernet communication cannot be established (with connection problems such as cable 

unconnected or disconnection) 
• Image Receiver is not activated or stops. 

 

Save Print Screen in SD［SSM］ 
Saves print screen images to an SD card from the dedicated image memory, and deletes data in the image 
memory. 
 

 
●Error code 

265 • No SD memory card is attached or cannot be accessed. 
• SD card memory is used up. 
• The SD memory card is write-protected. 
• No image is saved in the dedicated image memory. 
• "Write When Cover is Open" is se to "Disable", and the cover is open. 

 

 Command    Response 

 CIR 0600 h   COR 
Response completion = 

1 
 

 CIR +1 0134 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0000 h    

     COR +2 0000 h  

        

        

 Command    Response 

 CIR 0600 h   COR 
Response completion = 

1 
 

 CIR +1 0123 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0000 h    

     COR +2 0000 h  
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Get Distance between Target/Object Marks［GML］ 
Obtains the distance between target marks and the distance between object marks. 

 

Parameter 

Distance between target marks 1 / 10000 mm 

Distance between object marks 1 / 10000 mm 

Change Camera Shutter Speed［CSH］ 
 

 
Parameter 

Camera No. 
0: Camera 0 
1: Camera 1 

Shutter speed 

[1/100 msec units] 
0.10 msec to 500 msec: 0.3-Mega Compact Gray 
Camera (ANPVC5030) 
0.03 to 1000 msec: Cameras other than the above 

 

 

 Command    Response 

 CIR 4040 h   COR 012C h  

 CIR +1 0600 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0000 h    

     COR +2 0008 h  

     COR +3, COR +4 
Distance between target 

marks 
 

     COR +5, COR +6 
Distance between object 

marks 
 

 Command    Response 

 CIR 4030 h   COR 0041 h  

 CIR +1 0300 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0008 h    

 CIR +3, CIR +4 Camera No.   COR +2 0000 h  

 CIR +5, CIR +6 Shutter speed      
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Set Threshold of Change Judgement［SCT］ 
Changes the thresholds for judging the amount of deviation of X, Y and Theta which are used as the 
judgement condition of Alignment checker. 
 

 

Parameter 

Reserved 0 (Fixed) 

Threshold of change judgement X 1 / 10000 mm 

Threshold of change judgement Y 1 / 10000 mm 

Threshold of change judgement Theta 1 / 100000 degree 

 

 Command    Response 

 CIR 4050 h   COR 0190 h  

 CIR +1 0100 h   
COR +1 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3, CIR +4 Reserved  COR +2 0000 h  

 CIR +5, CIR +6 
Threshold of change 

judgement X 
    

 CIR +7, CIR +8 
Threshold of change 

judgement Y 
    

 CIR +9, CIR +10 
Threshold of change 

judgement Theta 
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Get Deviation/Stage Adjustment Amount［AOG］ 
Obtains the current value from PLC, and returns the adjustment amount plus the amount of deviation after 
the detection of an object. 

 

 XYTheta Stage Line Theta Stage UVW Stage 

Axis #1 absolute 
value X-axis position U-axis position 

Axis #2 absolute 
value 

Y-axis position V-axis position 

Axis #3 absolute 
value 

Theta-axis 
position Stroke position W-axis position 

 

Parameter 

Reserved 0 (Fixed) 

X-axis position, Offset X 1 / 10000 mm 

Y-axis position, Offset Y 1 / 10000 mm 

Theta-axis position, Offset Theta 1 / 100000 degree 

Stroke position 1 / 10000 mm 

U-axis position 1 / 10000 mm 

V-axis position 1 / 10000 mm 

W-axis position 1 / 10000 mm 

 

 

 Command    Response 

 CIR 4010 h   COR 00AA h  

 CIR +1 0520 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 001C h    

 CIR +3, CIR +4 Reserved  COR +2 0018 h  

 CIR +5, CIR +6 
Stage current value  

(Axis #1 absolute value) 
 COR +3, COR +4 Amount of deviation X  

 CIR +7, CIR +8 
Stage current value 

(Axis #2 absolute value) 
 COR +5, COR +6 Amount of deviation Y  

 CIR +9, CIR +10 
Stage current value 

(Axis #3 absolute value) 
 COR +7, COR +8 

Amount of deviation 
Theta 

 

 CIR +11, CIR 
+12 

Offset X  COR +9, COR +10 
Stage adjustment value 
(Axis #1 absolute value) 

 

 CIR +13, CIR 
+14 

Offset Y  COR +11, COR +12 
Stage adjustment value 
(Axis #2 absolute value) 

 

 CIR +15, CIR 
+16 

Offset Theta  COR +13, COR +14 
Stage adjustment value 
(Axis #3 absolute value) 
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Set Object Position［OBS］ 
Assigns the coordinate of an object position directly instead of the detected position by the checker, and 
executes alignment once. 
 

 

 

Parameter 

Mark No. 00: Both, 01: Mark0, 02: Mark1 

Object X coordinate (CIR +5,CIR+6) 1/10000 in pixels 

Object Y coordinate (CIR +7,CIR+8) 1/10000 in pixels 

Object X coordinate (CIR +9,CIR+10) 1/10000 in pixels 

Object Y coordinate (CIR +11,CIR+12) 1/10000 in pixels 

 
* ) For specifying Mark No.00 for parameter CIR+3 and CIR+4, input the X coordinate of Mark0 in CIR+5 and 
CIR+6, the Y coordinate of Mark0 in CIR+7 and CIR+8, the X coordinate of Mark1 in CIR+9 and CIR+10, and 
the Y coordinate of Mark1 in CIR+11 and CIR+12. 
For specifying Mark No.1 for parameter CIR+3 and CIR+4, input the X coordinate of Mark0 in CIR+5 and 
CIR+6, the Y coordinate of Mark0 in CIR+7 and CIR+8, and 0 in CIR+9, CIR+10, CIR+11 and CIR+12. 
For specifying Mark No.02 for parameter CIR+3 and CIR+4, input the X coordinate of Mark1 in CIR+5 and 
CIR+6, the Y coordinate of Mark1 in CIR+7 and CIR+8, and 0 in CIR+9, CIR+10, CIR+11 and CIR+12. 

 

 

 
 

 Command    Response 

 CIR 4010 h   COR 01F4 h  

 CIR +1 0600 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0010 h    

 CIR +3, CIR +4 Mark No.  COR +2 0000 h  

 CIR +5, CIR +6 
Object* X coordinate 

value 
    

 CIR +7, CIR +8 
Object* Y coordinate 

value 
    

 CIR +9, CIR +10 
Object* X coordinate 

value 
    

 CIR +11, CIR 
+12 

Object* Y coordinate 
value 
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Output Alignment Result Data［RTD］ 
Saves the latest result of the execution of Alignment to an SD card. 
For using this function, set "Output" for SD Card to "No" in "ENVIRONMENT" > "Input/Output" > "General 
Output". 
This function is used to output the latest alignment result held by PV240 to an SD card when the following 
RTD command is received regardless of the settings of "Alignment result output" and "Output Conditions" in 
"ENVIRONMENT" > "Input/Output" > "Alignment result output". 

 
Output Destination: ¥ Panasonic-ID SUNX Vision ¥PV240¥Result 
File Name:YYYYMMDD_ALN_RSLT.txt 

YYMMDD: Alignment execution time (When a date is changed, results are output to another file.) 
 

Output content 

• Execution date 
• Judgement 

• Inspection Time (Outputs "--------------".) 

• No. of retries 

• Amount of deviation X 

• Amount of deviation Y 

• Amount of deviation Theta 

• Mark the amount of deviation M0 X, Mark the amount of deviation M0 Y 
• Mark the amount of deviation M1 X, Mark the amount of deviation M1 Y 

All the above results are output. 
 

For details of the output format of results, refer to page 25 ”Result Data Output 
Format”. 

 

 
●Command Flow 

 

Note) Error (Error signal=ON. Error number is displayed in the information display area at the same time.) 

 

 Command    Response 

 CIR 4030 h   COR 0001 h  

 CIR +1 0400 h   COR +1 
 

Normal end = 0 
or Error code 

 

 CIR +2 0000 h    

    COR +2 0000 h  
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4.6 List of Error Codes 
 

The following is the list of error codes. 

 

Error code Error 

E000 Normal end 

E001 Communication error 

E002 Checksum error 

E003 Command parameter error 

E011 Specified mark unregistered 

E014 Calibration/Alignment calculation failed 

E015 Calibration data unregistered 

E017 Target position unregistered 

E020 Number of alignment retries exceeded 

E021 Target position outside screen error 

E022 Mark0 undetected 

E023 Mark1 undetected 

E025 Mark pitch incorrect 

E034 Movement threshold error (X    ) 

E035 Movement threshold error (Y    ) 

E036 Movement threshold error (Theta  ) 

E037 Movement threshold error (X, Y  ) 

E038 Movement threshold error (X,  Theta) 

E039 Movement threshold error (  Y, Theta) 

E040 Movement threshold error (X, Y, Theta) 

E060 Alignment checker unregistered 

E061 Calibration checker unregistered 

E062 Target checker unregistered 

E063 Object checker unregistered 

E064 Sequence error 

E066 Alignment command issued in STOP 

E067 Calibration data incomplete 
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4.7 Command Communication Log 
This is a function to display the communication logs (history) of the general-purpose communication and 
PLC communication, or to save the logs in SD cards.The following communication data can be displayed 
and saved. 

 

Control 
commands： 

Commands from external devices + Responses from PV240 
Requests from PV240 to external devices + Responses from external devices 

Result 
output: 

Outputs from PV240 + Responses from external devices 
(Data set to "Output" from "ENVIRONMENT" > "Input/Output" > "General Output") 

 

 

As PV240 can accept a start signal and control command sent with the keypad or an external device 
showing the window of a command communication log, the communication log can be confirmed during an 
ongoing inspection. 
For details, refer to PV200 User's Manual. 

4.7.1 Confirming Communication Logs on Monitor 

1. Select "View" > "Command Communication Log" 
from the menu bar in RUN menu. 

2. The "Command Communication Log" window is 
displayed. 

3. Press the F1 key when "Monitoring Stop" is 
displayed as the monitor status. "Monitoring" is 
displayed. 

(When the monitor status has been already 
"Monitoring", there is no need to press this button. 
Logs are already displayed in the communication 
log list.) 
 

 
The F1 key switches whether to keep monitoring 
the monitor display or pause when the command 
communication log window is displayed. 

4. When PV240 communicates with external devices 
(general-purpose communication , PLC 
communication), the communication data is 
displayed on the monitor. 

 
 
 

3. To close the "Command Communication Log" 
window, press the CANCEL key while the cursor 
is in the "Command Communication Log". 
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4.7.2 Saving Communication Log and Setting Display Contents 

Command communication logs are displayed in RUN Menu, and can be saved in SD memory cards. 

For setting the display contents and the saving method of communication logs, use the "Command Com. 
Log" menu in "ENVIRONMENT" > "Input/Output", or the menu displayed by selecting "Settings" in the 
pop-up menu displayed with the FUNC key on the "Command Com. Log" window in RUN menu. 

 

"ENVIRONMENT" > "Input/Output" > "Command 
Com. Log" menu 

"RUN Menu" > "Command Com. Log" 
pop-up menu 

  

 

 

Format Select Command (Default) or Data. 

Polling view No (Default) / Yes 

Select whether or not polling data is displayed/saved as logs. 

Keep logs No (Default) / Yes 

Select whether or not logs are always saved to SD cards. 

Overwrite No (Default) / Yes 

Set whether to overwrite an existing file or not when the number of log folders 
reaches the specified number or when it exceeds the capacity of the SD card. 

No. of Folders 1 to 1000 (Default: 10) 

Set the maximum number of folders to store communication log files 
generated by [Keep logs]. 

New log file (type 
select) 

No (Default) / Yes 

Select whether or not logs are automatically saved in a new file when a type is 
switched by an external device. When selecting "No", logs are added to the file to 
which data is being written. (This function is not available when a type is switched 
with the keypad.) 

 

There are two methods to save logs, one is to always save logs and the other is to manually save the data 
displayed in the log list. For always saving logs, make the above setting. For saving logs manually, press the 
FUNC key while the "Command Com. Log" window is displayed and select "Save to SD". 
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Chapter 5 
 Alignment Function Setting 
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5.1 Setting Alignment Function 
Make the settings related to the alignment function in preparation for inspections. After completing the settings 
in this chapter, make necessary settings for executing Alignment inspection. 
For information on each item, refer the following chapters. 
 

・Calibration setting: Chapter 6 ・Object setting: Chapter 8 

・Target setting: Chapter 7 ・Judgement condition setting: Chapter 9 

 

5.2 TYPE > Alignment > Alignment 
This setting is made from "TYPE" > "Alignment" > "Alignment" in Normal Menu. In Engineering Menu, it is 
made from "1.2 Calibration" and "1.4 Alignment Setting" on the top page. 

 
 

In Normal Menu In Engineering Menu 

 
The following items are divided into two items in Engineering Menu.  
・"TRIG Type" and "Arrowhead of stage direction": "1.2 Calibration" > "Calibration" 
・"Retry" and "Target Cross Drawing": "1.4 Alignment Setting" > "Options" 

 

 

TRIG Type 
Select an operation method when pressing the TRIG key in a situation related to Alignment*. 

(When the TRIG key is pressed in a situation other than that related to Alignment, a test is executed like 
the standard PV200.) 

 

Mask Sync. 
Execution 
(Default) 

Pressing the TRIG key once in a situation related to Alignment* captures and 
detects two marks, and performs alignment calculation (calculates the deviation 
and stage adjustment amounts, etc.). 
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Mark Async. 
Execution 

Pressing the TRIG key in a situation related to 
Alignment* displays the menu** for selecting "Mark0 
Detection", "Mark1 Detection" and "Alignment 
Execution" like the right figure, and executes a 
selected item. 

 

Also, the manual calibration setting is made for each mark. (Refer to page 168.) 

(**: Selectable items vary by situations that the TRIG key is pressed.) 

* Menus in "INSPECTION" > "Alignment" > "Checkers Setting" > "Target Checker" / "Object Checker" / 
"Target" / "Object" / "Judgement Limits", and RUN menu. 

Retry 
Specify how many times alignment operation is retried until OK judgement is obtained (within thresholds) 
at the time of alignment execution. 
(However, when an error occurs during the execution, it will be terminated.) For information on the 
termination of alignment operation due to errors, refer to page 198.) 

Target Cross Drawing 
Select whether to display a target position using a cross or not. 

Yes 
(default) 

: Displays the target position of Mark0 using a pink cross. 
Displays the target position of Mark1 using a blue cross. 

No : Not display. 

Arrowhead of Stage Direction 
Select whether to display an arrow indicating the rotation direction of stage and the direction of the XY 
axes of global coordinate in RUN menu or not. 

No (Default) : Not display. 

Top Left 
Bottom Left 
Top Right 
Bottom Right 

: Displays an arrow. Select a position where it is displayed on the 
screen window. 
On the screen window that displays a camera image after the 
calibration registration with an arrow indicating the rotation direction of 
stage in the information display area, the arrow indicating the positive 
direction of XY axes is displayed. 

 

 
• It is also possible to select whether to display or 

hide the arrowhead of stage direction in RUN 
menu. Press the F1 key in RUN menu, and set it 
in "Screen0 (Screen1)" > "Display Patterns" > 
"Arrowhead of stage direction". 
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Display Alignment Time 
Select whether to display the execution time of alignment in the information display area in RUN menu or 
not. (The execution time of alignment: The time from the start to the finish of alignment.) 

Inspection Time 
(Default):  

Displays "Inspection Time" in the information display area in RUN 
menu. 

Alignment Time:  Displays the execution time of alignment in the information display 
area in RUN menu. 
At this time, the execution time of inspection is not displayed. 
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Options 
Set as necessary. 

Target Position 

Select Mark Detection or Center of Display for the target position. 
There are two methods, which aligns the object position with a target position using a checker and aligns 
the object position with the center of the screen. 
(Target position: The target position to move the mark. Object position: The position of an object to be 
moved.) 

Mark Detection 
(Default) 

: Detects the target position using a checker. 
The position detected by a checker specified in "INSPECTION" > "Alignment" > 
"Target" > "Target Checker" is used as the target position. The following checkers 
are selectable for detecting the target position. 
Smart Matching / Corner Detection / Feature Extraction / Contour Matching / Smart 
Edge (Circle) / Arbitrary Point 

Center of 
Display 

: The center of the display is used as the target position. (When running a test in 
SETUP menu, "----" is displayed in the judgement field in "INSPECTION" > 
"Alignment" > "Target" > "Target Checker.) 

 

Display Data R/W 

Select whether to fix Data R/W for the R/W display for alignment or set and display Data R/W arbitrarily. 

Fixed : Data R/W is fixed as the R/W display for alignment. It cannot be edited (such as 
registering or deleting data). It becomes editable by changing the setting to "Free". 

Free 
(Default) 

: Data R/W can be edited freely. 

Display Total Judgement 

Select whether to display the results of alignment (whether Delta X, Delta Y and Delta Theta are within 
thresholds) in the screen as "Total Judgement" or not. 

Yes : Displays the results of alignment as total judgement. At this time, even if the "Total 
Judge." in "INSPECTION" > "Judgement" > "Condition" has been set, its result is not 
displayed as total judgement. 

No (Default) : Displays the result specified in "Total Judge." under "INSPECTION" > "Judgement" > 
"Condition" as total judgement. 
When a type is selected, JDC000=ALN000_JUDGE (judgement result of Alignment 
checker No.000) is automatically set in "INSPECTION" > "Judgement", and JDC000 is 
set in Total Judgement. 
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Checksum 

Select whether to add a checksum or not for improving the reliability of communication data when 
executing an alignment command using general purpose communication. 

 

Checksum 

Unlike the normal BCC, the sum of all the ASCII character codes of a command and command parameter 
is calculated, and the lower one-byte value is expressed as hexadecimal two-digit values using ASCII 
characters. 

 

Example) In the case of Reset Alarm command 

 

& A R R ¥ 

 41H 52H 52H  

▼The lower two bytes of addition result▼ 

E5H 
 

Command composition including checksum 

& A R R ¥ E 5 

     Checksum 
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5.3 INSPECTION > Alignment 

Specify the items in "INSPECTION" for the settings and judgement conditions of mark detection and base 
positions required for Alignment. 

 

 
In Normal Menu In Engineering Menu 

 

* The screen below is the Alignment menu window in Normal Menu. 

 
 

 

About the tables 

a: Displays the deviation between the target and object positions at the time of the execution of 
alignment. (Refer to page 199.) 

b: Displays the object coordinate at the time of the execution of alignment. 

Checkers 
Setting : 

A list of "Checkers" in "Calibration", "Target" and "Object". 

Each checker can be directly specified here, however, as for Calibration and Target, 
position registration is necessary after the checker setting. 

Calibration
 : 

Set for converting the camera coordinate system to stage coordinate system. The 
coordinate position of a mark captured with a camera is automatically converted to 
the system coordinate system by performing Calibration. (*: Acquires the angle of a 
camera, camera view range, and the relation between the camera and a stage 
automatically, and creates a new coordinate.) 

Target : Set target positions (target) for alignment. 

Object 
 : 

Set for detecting marks to be used for alignment. 

Judgement 
Limits : 

Set the allowable range for the deviation between a target position and an object 
position at the time of the execution of alignment. 
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c: Displays the deviation between the target and object positions for each mark at the time of the 
execution of alignment. 

5.3.1 Setting Checkers (Bulk Checker Setting)） 

In "Checkers Setting", the settings for the mark detection performed in Alignment are made. Make the 
settings for checkers for Calibration, Target and Object. The checkers listed in this menu can be also set 
individually in "INSPECTION" > "Alignment" > "Calibration", "Target" or "Object". (For details of the setting 
procedures, refer to 6.3.1 (page 166), 7.1.1 (page 182) and 8.1.1 (page 192).) Each checker specified in 
"Calibration", "Target" or "Object" under "Checkers Setting" can be copied and pasted. 

When Calibration Checker or Target Checker has been set in "Checkers Setting", each position should be 
registered after the setting. It is set in "INSPECTION" > "Alignment" > "Calibration" or "Target" in Normal Menu. 
In Engineering Menu, it is set in "1.4 Alignment Setting" on page 1. 

 

Normal Menu Engineering Menu 

 
 

 

5.3.2 Checkers Setting > Comment 

A name for Alignment checker "No.000" can be specified. 

5.3.3 Checkers Setting > Common Object 

This item is set to use specified Calibration checkers by Object checkers in common. If checked, the checkers 
specified in "Calibration" are also used as the checkers for detecting objects. However, Object checkers cannot 
be used as Calibration checkers. 

 

 

 
Note that if "Common Object" is 
checked after the setting of Object 
Checker, the message "Do you 
want to delete the object checker?" 
will appear and the Object Checker 
will be deleted.  
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Chapter 6 
 Calibration Setting 
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6.1 Setting Calibration 

About Calibration 
Performs an operation to convert the coordinate system of a camera to the coordinate system of the stage by 
capturing a mark on the stage within the view range of the camera and moving the stage in the X, Y and Theta 
directions. The coordinate position of the mark captured with the camera is automatically converted to the 
system coordinate system (global coordinate system) by performing Calibration. 

For executing Calibration, the communication between a communication device and the stage should be 
established in advance. (Refer to Manual Setting on page 168 or Setting with General Commands or PLC 
Communication on pages 82, 84, 132 and 133.) 

Operation of Calibration 

1. Moves the stage from the base position in the X direction and detects the mark position. 

2. Moves the stage from the base position in the Y direction and detects the mark position. 

3. Moves the stage from the base position in the +Theta direction and detects the mark position. 

4. Moves the stage from the base position in the -Theta direction and detects the mark position. 

 
Executing the procedures 1 to 4 shows the relation between the positions of the base mark and the center of 
the stage. 
The movement amounts in X, Y and Theta directions described in the above steps 1 to 4 are specified in 
"TYPE" > "Alignment" > "Calibration" > "Stage Movement". For details, refer to 6.2.1. 
 

 
• For executing the above steps 1 to 4, change the position and angle of the stage to the base 

position. 

• Calibration should be performed when installing a camera for the first time or reinstalling the camera 
or stage for maintenance. 

 

 
If marks are not detected from the stage base position with the +X, +Y or +/-Theta for detecting the mark 

positions in the above steps 1 to 4, correct calibration data cannot be created. 

 

Stage movement when executing Calibration 

 

⇒ 
OK 

 
Correct calibration 
data is created. 

 

⇒ 
NG 

 
Wrong calibration 
data is created. 
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6.2 TYPE > Alignment > Calibration 

"TYPE" > "Alignment" > "Calibration" 

 

 
In Normal Menu In Engineering Menu 

 

6.2.1 Stage Movement 

Specify each moving distance of the X, Y, Theta axes for moving the stage when performing calibration. 
Set the values within the range that the detection mark does not go out of the screen. Especially for theta, 
moving the table widely as much as possible improves the accuracy of the rotation center. 
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6.3 INSPECTION > Alignment > Calibration 
In the case of Engineering Menu, set "Checker" under "1.2 Calibration" on page 1. 

[Normal Menu] [Engineering Menu] 

  

6.3.1 Checker 

Register checkers which obtain coordinate values for executing calibration for each mark. 

 

* For details of how to set and operate checkers, refer to PV200 User's Manual (4th Edition or later). 

 

 

Checker Detected image 

Smart 
Matching 

This is a function that searches and detects a 
similar part to the registered image pattern. 

Template:  

 

Corner 
Detection 

The horizontal base checker and vertical base 
checker are both set, the intersection point of 
two approximate lines will be considered as the 
base position. 

 

Feature 
Extraction 

Feature Extraction binarizes an image captured 
by a camera, detects a specified size of clusters 
of white or black pixels (hereinafter called 
“object”), and then judges as OK or NG 
depending on the measured number. 
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Contour 
Matching 

Contour Matching searches and detects a 
similar part of an inspection image to the 
registered contour information on the part of an 
image the brightness of which varies. 

Template:   

Smart Edge 
(Circle)） 

Smart Edge (Circle) is a function to output the 
center point, radius or diameter of a round 
object by detecting edges of the object with a 
number of cells. 
The central coordinate or radius of a circle can 
be also detected when a whole object cannot be 
captured or for the angle of a chamfered object.  

For changing the type of a used checker after selecting the checker, press the FUNC key once and "Delete" 
the checker before setting a new checker. 
 

When using "Corner Detection" (Calibration/Target/Object) 

 
In "Corner Detection" which is a checker type for 
Calibration, Target and Object, each line is detected with 
Horizontal Base Checker and Vertical Base Checker, and 
the intersecting point and angle of two lines are calculated 
simultaneously. 

 
When the intersecting point is detected and the angle is 
within the range of "Max. Angle" to "Min. Angle", it is 
judged as OK and the position of the intersecting point is 
used for alignment. 

 

 

Setting of [Intersecting angle] 

Select CW (Default) or CCW. 
The calculated angle is an intersecting angle of the line 
detected with Horizontal Base Checker and the line 
detected with Vertical Base Checker.  

 
The directions of the lines detected with each base checker depend on the positions of the start 
and end points in each checker area. 

 

 

 

Setting of "Max. Angle" and "Min. Angle" 

Set them in the range of 0.000 degrees to 359.999 degrees. 
If the detected intersecting angle is out of this range, the 
result is judged as NG in SETUP menu, and errors 22 and 23 
are displayed during alignment. 

 



 

168 

6.3.2 Manual Setting (Calibration Data) 

Calibration data can be created manually after 
registering Calibration checkers. 
(When the communication among PV240, a 
communication device and the stage is 
established, the calibration using PLC 
communication or general commands can 
be executed in RUN menu.) 

 

     
 
Execute the following procedure for Mark0 and Mark1. 

 

1. Move the stage to the base position (origin position), and detect the mark position at the base 
position by pressing the TRIG key. 

2. Move the stage in the +X direction from the base position, and detect the mark position at the +X 
position by pressing the TRIG key. 

3. Move the stage in the -Y direction from the base position, and detect the mark position at the +Y 
position by pressing the TRIG key. 

4. Move the stage in the +Theta direction from the base position, and detect the mark position at the 
+Theta position by pressing the TRIG key. 

5. Move the stage in the -Theta direction from the base position, and detect the mark position at the 
-Theta position by pressing the TRIG key. 

 
After the above procedure, create data with the "New Calibration Data" button. 
In the above procedure, pressing the TRIG key in each step and detecting a mark proceeds the operation to 
the next step automatically, however, if no mark is detected, the cursor does not go to the next step.  

 
• Note that the stage is always moved from the base position in the above steps 1 to 4.   
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• When setting "TYPE" > "Alignment" > "Alignment" > "TRIG Type" >"Mark Sync. Execution", both Mark0 
and Mark1 are detected simultaneously and Calibration is executed. When "Mark Async. Execution" is 
selected, Calibration is executed for each mark separately. 

 
If marks are not detected from the stage base position with the +X, +Y or +/-Theta for detecting the 
mark positions, correct calibration data cannot be created. 
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6.3.3 Manual Setting (Calibration Data) 

Calibration data calculated by PV240 can be confirmed. In the menu under "Show details", global 
coordinates can be confirmed from the pop-up menu displayed with the FUNC key. (Refer to page 171.) 

 
Data is displayed under "Show details" after the execution of Calibration. 0 is displayed before Calibration. 

 

 

 

 Contents Details 

1 Movement X, Y, Theta Movement amount of the stage when creating calibration data. 
Displays the set values in "TYPE" > "Alignment" > "Calibration" > 
"Stage Movement" at the time of the creation. 

2 Calibration mark positions 
when setting Calibration 

Displays the detected positions of the calibration mark when the stage 
is moved in each direction for setting Calibration. (Origin position, +X 
coordinate, +Y coordinate, +/-Theta coordinate) 

3 Resolution X, Y Displays the resolutions calculated by the creation of calibration data. 
4 Rotation Point Displays the rotation center of the stage calculated by the creation of 

calibration data and Rotation Point Adjustment. 
5 Camera Angle Displays the angle of a camera to the global coordinate calculated by 

the creation of calibration data. 
6 Camera Angle Fixed This item is used to prevent "Camera Angle" from being updated when 

creating calibration data. "X" is set. (Set this item for preventing a 
different camera angle from being created every time calibration is 
executed.) 
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6.3.4 Display Global Coordinate (Show Details) 

Global coordinates created by the calibration setting can be confirmed. Global Coordinate is coordinates 
which show mark positions of camera coordinates (in pixels) in mm as the rotation center (0, 0) of the stage, 
and it is created by the execution of calibration. If the position or direction of a displayed camera image is 
different from the appearance of workpiece by sight when displaying the global coordinate, it should be 
adjusted. Refer to the next page on the handling method. 
 

For displaying the global coordinate, select "Display Global Coordinate" with the FUNC key under 
"INSPECTION" > "Alignment" > "Calibration" > "Show details". In Engineering Menu, select "Display 
Global Coordinate" on page 1. 

 

 
Display of the pop-up menu by 
"Calibration" > "Show details" 

 

 

Engineering Menu 

 

 

 

 

 

  

    
 

 

The global coordinate display shows the positional relation of cameras and the stage showing two marks 
on the global coordinate. 
X axis is in the horizontal direction and Y axis is in the vertical direction. Camera images in each view 
range are the images at the time of executing a test or inspection before "Display Global Coordinate". 
The origin (0, 0) of the global coordinate display is a rotation center of the stage, and the scales displayed 
on the coordinate axes are in millimeters. 
The camera view range capturing Mark0 is surrounded with a pink square, and that capturing Mark1 is 
surrounded with a blue square. When no calibration registration is performed before Display Global 
Coordinate, the coordinate axes and camera images are not displayed. 

 
The following figures show examples of detecting different marks by two cameras. 

The installation positions of  
cameras differ between the marks. 

 
The camera setting angle leans. 

 
When the camera positions differ and a captured image leans as shown in the above figures, the images 
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are displayed in the same positional relation as those watched by eyes on the global coordinate display 
by executing Calibration. 

Confirmation Items for Global Coordinate Display 

Confirm the following points about whether calibration data is created correctly. 
• Confirm the actual locations of cameras and stage. 

• Confirm the stage operation direction and rotation direction. 
Confirm whether the rotation center position of stage (or whether it is almost correct before performing 
Rotation Point Adjustment) and the directions of X and Y axes match the stage. 

• Confirm captured images (inspection objects). 
 
When it is determined that displayed global coordinates are inappropriate while confirming the above 
confirmation, adjust them. Examples are as follows. 
 

Example of how to handle when the camera position on 
Global Coordinate Display differs from the object 

 
Case 1 The view range showing two marks are inverted by 180 degrees. 
Conceivable 
cause 

At the time of executing Calibration, detected data cannot be obtained properly due 
to any error by checkers when rotating the stage by +/-Theta. 

Solution Change the setting of "Stage + Theta Direction" to the other. 
(Change in "Display Global Coordinate" > "Stage + Theta Direction" or "TYPE" > 
"Alignment" > "Stage Setting" > "Stage + Theta Direction".) 

Failed Succeeded by changing "Stage + Theta 
Direction" 

 
 

 

Case 2 Slanted camera images are displayed  

Conceivable 
cause 

The operation of the stage of a communication device controlling the stage is not 
correct. 

Solution Check the operation of the stage or the communication device controlling the stage 
and adjust. 

Failed (Images are slanted.) Succeeded 
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Case 3 The aspect ratio of camera images is wrong. 
(The aspect ratio of 0.3-Mega Camera and 2-Mega Camera is 3:4 (vertical : 
horizontal), and that of 4-Mega camera is 1:1.) 

Conceivable 
cause 

Malfunction of the stage or a device controlling the stage occurs or detection by a 
checker is not correct. (An error by checkers or a detected position exceeds the edge 
of the image.) 

Solution Check the operation of the stage or the communication device controlling the stage 
and adjust. 
Confirm whether the detection by checkers is correct. 

Failed (Displayed images are vertically long.) Succeeded 
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6.3.5 Rotation Point Adjustment (Calibration Data) 

The calibration setting in Chapter 6.3.2 performs image capturing and detection in the +X, +Y, +Theta and 
-Theta directions once for each direction and acquires the rotation center of the stage. However, as there is 
the possibility of occurrence of a detection error with this value alone, it is necessary to acquire the rotation 
center of the stage more accurately. "Rotation Point Adjustment" should be executed for each mark. 
Two methods are available for Rotation Point Adjustment; by performing the adjustment manually or using 
the communication with an external device. In the case of the manual adjustment, follow the guide in 
"Mark0" and "Mark1" under "INSPECTION" > "Alignment" > "Calibration". In the case of the automatic 
adjustment, make a program with an external device such as a PLC in advance and performs it in RUN 
menu. At this time, "No. of Movement" should be set under "TYPE" > "Alingment" > "Calibration" > "Rotation 
Point Adj." > "No. of Movement". 

Concept 
With the presence of the deviation in the rotation center of the stage acquired by executing Calibration, an 
error such as the following occurs. So, the stage rotation center should be determined after verifying the 
deviation.  
 

1 

 

 
2 

 

  

 When the stage rotation center acquired by "Calibration" is accurate, it is possible to calculate the 
X and Y coordinates and the movement amount at the time of rotating the mark on the rotation 
center by the angle α. Therefore, A0 will return to its original position by Stage +αTheta and 
moving it for the movement amount Xα and Yα. 

3 

 

4 

 

  

 However, when a deviation occurs in the acquired rotation center, it does not return to the original 
A0 position and it moves to a wrong position like Ar. When moving the stage actually and the 
points do not match, the acquired rotation center is deviated. 

5 
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 At this time, as the difference between A0 and Ar, the amount of deviation delta X and delta Y are 
obtained, the image checker can calculate the center of the stage. For obtaining a more accurate 
rotation center, Rotation Point Adjustment is performed. 
The flow of the operation is as follows; After the above fig. 2, if a deviation occurs like fig. 4, 
calculate the deviation (fig. 5). Calculate the center coordinate which assumed to be correct, and 
verify whether the new coordinate is less deviated (by the image checker). Move the stage again 
to check whether a deviation occurs or not like fig. 2 or fig. 4, and repeat the procedure. Finally, 
determine the coordinate less deviated as the rotation center.  

TYPE > Alignment > Calibration > Rotation Point 
Adjustment 

Set "Move Angle" and "No. of Movement" in "Calibration". In the case of Engineering Menu, set 
"Calibration" under "1.2 Calibration". 
 

"Normal Menu" > "Rotation Point Adjustment"  “Engineering Menu” 

 

 

 

Move Angle 
It is used for the rotation point adjustment with the calibration command (PLC, general purpose 
communication) and on the rotation point adjustment window. 
Setting range: -180.00000 degrees to 180.00000 degrees, Default: 0.25000 degrees, 5 digits after the 
decimal point 

No. of Movement 
0 to 99 (Default: 0) 

Specify the number of times of moving the stage for performing Rotation Point Adjustment. 

Set this value to 2 or larger in the case of performing Rotation Point Adjustment using PLC communication 
or general purpose communication. (This item is not necessary for executing it manually in SETUP menu.) 
When this item is set, Rotation Point Adjustment is automatically executed after calibration registration. 
The number of times of moving the stage by "No. of Movement" and the number of times of executing 
Rotation Point Adjustment are as follows. 

0: Rotation Point Adjustment is not executed. 
2 to99: Rotation Point Adjustment is executed for "(Number of Movement)-1" while the stage 

moves for "Number of Movement". 
(No. of Movement: When specifying 2, Rotation Point Adjustment is executed once while 
the stage moves for two times.) 

Rotation Point Adjustment (Manual Setting) 
This is a method for executing Rotation Point Adjustment for the stage according to the instruction of the menu 
in SETUP menu. (For executing Rotation Point Adjustment by the command control from an external device, 
refer to page 84 or 133.) It is executed after the calibration registration (after the manual setting). It is 
executed for both Mark0 and Mark1. 
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The setting is made from "INSPECTION" > "Alignment" > "Calibration" > "Rotation Point Adjustment" > 
"Mark0 and "Mark1". In Engineering Menu, set "Rotation Point Adjustment" > "Mark0" and "Mark1" under 
"Checker" of "1.2 Calibration" on page 1.  

 

 
 

Flow of Rotation Point Adjustment 

1 

Measurement of deviation 

1. Capture an image the base position of the stage, and measure the detected position. 

2. Capture the image moving the stage, and measure the deviation. 

→The Image Checker calculates the amount of deviation of Mark0. 

  

2 
Confirmation of the amount of deviation. 

Calculate the amount of deviation of the mark, and obtain a new rotation center of the stage. 

The position of the obtained rotation center is still provisional. 
  

3 
Adjustment 

Verify whether the provisional center is more appropriate than the first rotation center or not. For 
the verification, move the stage and execute the operation once again. 

 The amount of deviation is too large. 

4 
Confirmation of the adjustment result. 

Confirm the amount of deviation and determine whether its value is within the allowable range 
or not. 

 When it is within the range 

5 Registration 

Replace the first rotation center with the new one. 
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Image of Stage Movement 
 

 
 
A correct rotation center is acquired from the deviation between A0 and Ar in the above step ○3 . 
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About Setting Menu 

 

a: Target mark number which is currently set 

b: Base point 

Displays the detected mark position at the base point. 

c: Move point 

Displays the detected mark position at a position to 
where the stage moves. 

d: Rotation point 

Displays the rotation of the calibration data calculated 
by measurement. 

e: Measured Change button 

Press this button for calculating or adjusting the 
deviation of the rotation center of calibration data. 

f: Register button 

Press this button for registering the rotation center in 
calibration data and exiting the Rotation Point 
Adjustment window. 

 
 
 
 

1. Select "Measured Change".  
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

2. Move the stage to the origin position and press the TRIG key. 
 

 
Match the stage with the base position. Otherwise the actual 
rotation center position is different. 

 

 



 

179 

3. Confirm the values of "Stage Position" or "UVW Stroke". 
The stage moves by the displayed X, Y and Theta or U, V and W. 
 

 
- These lists show the values for the both XYTheta stage 

and UVW stage. Confirm the stage being used and move 
the stage. 

- The value displayed in the column for Theta is the theta 
of the base point measurement plus the value of "Move 
Angle (°)” in "TYPE" > "Alignment" > "Rotation Point 
Adjustment". 

 

4. Press the TRIG key. 
 

 
5. The window returns to the Rotation Point Adjustment menu 

automatically. 
Values are displayed in "Detect Mark Position", "Rotation Point 
(Before Adj.)" and "Change". 
 

 
A new rotation center is obtained with the condition of Step 3, 
however, it is not clear whether the rotation center should be 
replaced with this result or not at this time. For verifying it, follow 
the next step "Adjustment". 

 
 

6. Select "Adjustment". 
 
 

 

 

 

7. Move the stage by the values displayed in "Stage Position" or "UVW Stroke" in the same way as 
the above Steps 2 and 3, and press the TRIG key. 
 

8. The window returns to the Rotation Point Adjustment menu automatically. 
Confirm the value of "Change" and press "Register" when this value is within the allowable range. 
Repeat the "Adjustment" operation until the value is within the allowable range. 
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Chapter 7 
 Target Setting 
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7.1 Setting Target 
 

This item is to set a target position for positioning using Alignment. 

Set a method for detecting mark positions (Checker), and set coordinate 
values that are the target (movement destination) for Alignment. This 
setting is made from "INSPECTION" > "Alignment" > "Target" in Normal 
Menu. In Engineering Menu, it is made from "Target" under "1.4 
Alignment Setting" on Page 1. 

 

How to Set Target 

1. Set target checkers. (Chapter 7.1.1) 

2. Set Offset as necessary. (Chapters 7.1.2, 7.1.3) 

3. Register target positions. (The registration is required for executing 
Alignment.) 

4. Confirm the registered target positions.  

 
When selecting "Mark Async. Execution" in "TYPE" > "Alignment" > 
"Alignment" > "TRIG Type" (page 156), clicking the TRIG key on the 
target window displays the right menu. Select whether to select Mark0 
or Mark1. 

 

 
 

7.1.1 Target Checker 

Set a method for detecting mark positions for each mark. 

 
• For changing a set checker to another checker, press the FUNC key to delete the set checker and 

select a new checker. 
• For details of how to set and operate checkers, refer to PV200 User's Manual (4th Edition or later). 

 

 

Checker Checker 

Smart 
Matching Smart Matching 
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Corner 
Detection 

The horizontal base checker and vertical 
base checker are both set, the 
intersection point of two approximate 
lines will be considered as the base 
position. 

 

Feature 
Extraction 

Feature Extraction binarizes an image 
captured by a camera, detects a 
specified size of clusters of white or 
black pixels (hereinafter called “object”), 
and then judges as OK or NG depending 
on the measured number. 

 

Contour 
Matching 

Contour Matching searches and detects 
a similar part of an inspection image to 
the registered contour information on the 
part of an image the brightness of which 
varies. 

Template:   

Smart Edge 
(Circle)） 

Smart Edge (Circle) is a function to 
output the center point, radius or 
diameter of a round object by detecting 
edges of the object with a number of 
cells. 
The central coordinate or radius of a 
circle can be also detected when a whole 
object cannot be captured or for the 
angle of a chamfered object. 

 

Desired 
Position 

Sets the output point at a desired position by moving the cursor. 

7.1.2 Display Coordinates 

Select a method for displaying coordinate values on the menu. "Display Coordinate" can be selected when 
calibration data has been registered. Changing this setting changes the unit display of "Coordinates of 
Registered Target". ("X(pix) and Y(pix)" are displayed in the following figure as "Camera Coordinates" is 
selected.) This item is common to "Display Coordinates" in "Object". 

 

 

 

Display Coordinates 
Camera Coordinates 
(Default) 

The displayed values are in "pixels". 

Stage Coordinates 
The displayed values are in "mm". 
It requires that calibration data has been created. 
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7.1.3 Register Coordinates of Target 

Register target positions required for executing Alignment. 

 

 

1. Select "Register coordinates of target". 
 

2. The menu window appears as the right figure. 
 
Coordinates of Detected Target 
Displays the detected positions of target marks at the time of 
executing the previous test. 
When "Stage Coordinates Offset" or "Target Coordinates Offset" is 
set, values added with these values are displayed. 

 
Register coordinates of target 
The "Coordinates of Registered Target" are registered as the target 
positions. 

 
Coordinates of registered target 
The coordinates registered by "Register coordinates of target" are 
displayed. 
Cross marks are displayed as the center of the registered positions on 
the screen window. 

Mark0: Pink cross 
Mark1: Blue cross 

 

 

 

Stage Coordinates Offset 
The registered target coordinates added with the offset specified here are used as the target 
coordinates. They are applied to the both target marks 0 and 1. The rotation center of offset Theta 
is "Change Base" ("Alignment" > "Judgement Limits" > "Change Base"). 

 
Target Coordinates Offset 
The detected coordinates of the target registered in Target Checker added with offsets for each 
mark are the target coordinates for executing Alignment. (Refer to page 186 for details.) 

3. Register target positions by pressing the ENTER key on 
"Register coordinates of target" as necessary after 
setting "Stage Coordinates Offset" or "Target 
Coordinates Offset". 

 
Once registered, the target coordinates are displayed in 
"Coordinates of Registered Target". 

 
If registering the target position failed, check whether or not 
calibration data has been registered and the target marks 
have been detected. 
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7.1.4 Stage Coordinates Offset 

The registered target coordinates added with the offset specified here are used as the target coordinates 
for executing Alignment. These values are applied to the both target marks. Offsets are set for X, Y and 
Theta. 

The rotation center of the offset Theta is the position selected in "Change Base" (In Normal Menu, 
"INSPECTION" > "Alignment" > "Judgement Limits". In Engineering Menu, "1.4 Alignment Setting" > 
Judgement Limits" on Page 1). 

 

Offsets are specified in "Register coordinates of target". 

1. After setting target checkers, select 
"Register coordinates of target". 
 
 
 
 
 
 

 
 

2. The menu window appears as the 
right figure. 

 

3. Select "Stage Coordinates Offset". 
 
 

4. Set stage coordinates offsets. 
The positions that the values 
specified here are added to the 
detected positions of Mark0 and 
Mark1 are used as the target 
positions. 
X (mm), Y (mm), Theta (°) 

 
Set offsets so that each mark is within 
each view range when these values 
are added to the detected positions of 
the marks. 

 
 
 
 
 
 
 
 
 
 

 
 

 
 

5. After the setting, press the CANCEL 
key to return to the previous menu. 

 

6. The values of "Coordinates of 
Detected Target" and "Coordinates 
of Registered Target" in the 
"Register coordinates of target" 
menu are updated. 
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7.1.5 Offset Setting for Target 

Set offsets to use the position moved by a certain movement amount from the detected position of the 
mark specified in "Target Checker" as the target position. 

 

Example 1) When detecting a position you want to 
register is difficult 

Example 2) When there is no point to be a mark 
at the position you want to register 

 
 

If the condition of a captured image is bad as 
shown in the above figure, you can detect another 
position (the left end of the white area in the above 
figure) by Target Checker although you want to 
use the gray cross mark as the target position, and 
can set the position moved by the amount of 
offsets from the detected position as the target 
position. 

If you want to use positions without 
characteristic points as the target positions, 
detect characteristic points as the target marks, 
set values for offset coordinates after checking 
the distances between the detected positions of 
the marks and the desired target positions on a 
drawing, etc. 

 

Offsets are specified in "Register coordinates of target". 

1. After setting target checkers, select 
"Register coordinates of target". 
 
 
 
 
 
 
 
 

 
 

2. The menu window appears as the 
right figure. 

 

3. Select "Target Coordinates Offset". 
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4. The "Target Coordinates Offset" menu 
appears. 
 
The detected position of a target mark at 
the time of executing the previous test is 
displayed in "Detect Position". Press the 
TRIG key to execute a test. 

 

5. Confirm that two target marks are 
detected. 

 

6. Press the ENTER key on the "Base 
Position Regist." button and register the 
current position as the base position as 
necessary. ("Target Coordinates Offset" 
is not required to be set at this time.) 
Once registered, the detected positions of 
each mark at the time of executing a test 
are displayed in "Base Position". 

 

 
• PV240 recognizes the positional relation between the target 

marks on the global coordinates by registering target positions, 
and can get the target positions including offsets. (For details of 
Base Position Registration, refer to page 188.) 

• For clearing the registered base position of target offsets, press 
the FUNC key and select "Delete the base position". 

 

7. Set target coordinates offsets. Set them to make the detected 
positions of target marks be within the screen when the target 
coordinates offsets are added. 
 

 
If the target position lies off the screen as a result of adding the 
target coordinates offsets, the right message appears. In that case, 
set appropriate values. 
 

 

8. When setting "Target Coordinates Offset" and registering target 
positions, the table of "Coordinates of Registered Target" shows 
the registered values to which the offsets are added. At this time, 
cross marks whose center is located at these positions are 
displayed on the screen window. 

Mark0: Pink cross 
Mark1: Blue cross 
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About Base Position Registration of Offset 

There are the following differences depending on whether "Base Position 
Regist." is made or not. 

When setting offsets is required, set values for "Offset Coordinates". As for 
the directions of the offset coordinates X and Y, PV240 provides axes to be 
the base in two ways at this time. 

(1) Set offsets on the global coordinates considering the positional 
relation of two marks. 
(2) Set the direction from Mark0 to Mark1 as the direction of 0 degree 
for offset X, and set the direction that is vertical to it as that for offset Y. 

These differences depend on whether the base position of offset is 
registered or not. The method (1) is recommended because offset values 
are set in XY directions on the global coordinates and offset values can be 
set without paying particular attention to the mounting positions of 
cameras.  

 

Difference in object positions depending on whether Base Position is registered or not 

(1) When the base position of offsets is registered: Set offsets on the global coordinates considering 
the positional relation of two marks. 

The positional relation of Mark0 and Mark1 on the global coordinates (such as Mark0 is right or left, 
above or below) is obtained by registering the base position. The target positions are the positions 
distant from the detected coordinates of each mark by offsets on the global coordinates. 

 

 
(In the above figure, offset X1 is set to a negative value.) 

Required settings 
・Base position 
registration 
・Offset coordinate 
setting 

(2) When the base position of offsets is not registered: Set the direction from Mark0 to Mark1 as the 
direction of 0 degree for offset X, and set the direction that is vertical to it as that for offset Y. 

In this case, "Base Position Regist." is not made. If values are displayed in the table of "Base Position", 
press the FUNC key on the "Base Position Regist." button and delete the base position. 

The target positions are the positions distant from the detected coordinates of each mark by offsets in 
the directions of axes made. 

 

 

Example 1 

 

 

 

 

Required settings 
・Offset coordinate 
setting (without 
"Base Position 
Regist.") 
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When the same values are set as offset coordinates for (1) and (2), the target 
positions differ. 
It is necessary to set values for offsets X and Y considering the angle between 
the marks. 

 Example 2) 

 

In the right figure, 
Mark0 is set on 
the right and 
Mark1 is on the 
left. In this case, 
the offset X is 
directed to the 
left and the offset 
Y is directed to 
the opposite 
direction to the 
above figure. 

 
When a base 
position is not 
registered, offset 
values should be 
set considering 
the positional 
relation of Mark0 
and Mark1. 

 

 

 
 

7.1.6 Coordinates of Registered Target 

The coordinate values to be the target (movement destination) are displayed. 
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Chapter 8 
 Object Setting 
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8.1 Setting Object 
 

This item is to set an object for positioning using Alignment. 

Set a method for detecting mark positions (Checker), and detect object 
coordinate values at the time of executing Alignment. Calculation and output 
needed for Alignment is performed comparing the detected object coordinate 
values and the registered target coordinate values. 

This setting is made from "INSPECTION" > "Alignment" > "Object" in Normal 
Menu. In Engineering Menu, it is made from "Object" under "1.4 Alignment 
Setting" on Page 1. 

 

How to Set Object 

1. Set object checkers. 
(Checkers set for Calibration can be used for Object checkers in common. 
Check "Common Object" in this case.) 

2. Set offsets as necessary. 

3．Confirm the registered target positions. 
 

 
When selecting "Mark Async. Execution" in "TYPE" > "Alignment" > "Alignment" > 
"TRIG Type" (page 156), clicking the TRIG key on the object window displays the 
right menu. 

"Mark0"/"Mark1": Detects the selected object mark. 

"Alignment Execution": Executes Alignment based on the positions of two object 
marks acquired beforehand. 

 

 

 

8.1.1 Object Checker 

Set a checker to detect the mark position for each mark. 

 
• For details of how to set and operate checkers, refer to PV200 User's Manual (4th Edition or later). 

• Checkers used as Calibration Checker can be used as Object Checker. In that case, check 
"Common Object" in "INSPECTION" > "Alignment" > "Checkers Setting". In the case of Engineering 
Menu, check "Common Object" in "Checkers Setting" of "1.4 Alignment Setting" on page 1. (For 
details of "Common Object", refer to page 162 (5.3.3 Checkers Setting > Common Object).) 

• When "Common Object" is checked in "Checkers Setting", the settings in "Object" > "Object 
Checker" cannot be configured. In this case, adjust the settings in "Checkers Setting" > "Calibration 
Checker". 

 

 

 

Checker Detected image 
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Smart 
Matching 

This is a function that searches and detects a 
similar part to the registered image pattern. 

Template:  

 

Corner 
Detection 

The horizontal base checker and vertical base 
checker are both set, the intersection point of two 
approximate lines will be considered as the base 
position. 

 

Feature 
Extraction 

Feature Extraction binarizes an image captured 
by a camera, detects a specified size of clusters 
of white or black pixels (hereinafter called 
“object”), and then judges as OK or NG 
depending on the measured number. 

 

Contour 
Matching 

Contour Matching searches and detects a similar 
part of an inspection image to the registered 
contour information on the part of an image the 
brightness of which varies. 

Template:   

Smart Edge 
(Circle)） 

Smart Edge (Circle) is a function to output the 
center point, radius or diameter of a round object 
by detecting edges of the object with a number of 
cells. 
The central coordinate or radius of a circle can be 
also detected when a whole object cannot be 
captured or for the angle of a chamfered object.  

 

 

8.1.2 Display Coordinates 

Select how to display coordinate values in "Object Coordinates". This item can be selected after setting 
"Calibration". 

Changing this setting changes the unit display of "Object Coordinates". (This setting is not related to the 
values of coordinate axes to be displayed by "Display Patterns" > "Coordinate Axis" in the image menu 
displayed by pressing the FUNC key.) 

 
"Display Coordinates" is a common item with "Display Coordinates" in "Target".  
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Display Coordinates 

Camera Coordinates 
(Default) 

The displayed values are in "pixels". 

Stage Coordinates 
The displayed values are in "mm". 
It requires that calibration data has been created. 
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8.1.3 Detect Coordinates Offset 

This setting is used to set a position which is the detected position by Object Checker plus offsets as object 
coordinates. 

The rotation center of the detect coordinates offset Theta is the rotation center of the stage. 
 

 

Object Coordinates by Setting Detect Coordinates Offset 

By setting offsets, the position shifted from a detected mark position by the offsets is output as object 
coordinates. The positions of orange cross marks are detected as Mark0 and Mark1 in the following figure. 
By setting offsets, the positions of red cross marks will be the object coordinates. 
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8.1.4 Object Coordinates 

Display the coordinate values of a detected object. (The unit display of coordinate values (pixel or mm) is 
set in 8.1.2 Display Coordinates.) 
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Chapter 9 
 Judgement Condition Setting 
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9.1 Setting Judgement Limits 
The amount of deviation (deviation of a specified position), the amount of deviation of each mark and the 
pitch between marks are used for the judgement reference for executing Alignment and judging an 
alignment result whether it is OK or NG. This setting is made from "INSPECTION" > "Alignment" > 
"Judgement Limits" in Normal Menu. In Engineering Menu, it is made from "Judgement Limits" under "1.4 
Alignment Setting" on Page 1. 

 
 

Normal Menu Engineering Menu 

 
When selecting "Mark Async. Execution" in "TYPE" > "Alignment" > 
"Alignment" > "TRIG Type" (page 156), clicking the TRIG key on the target 
window displays the right menu. Select whether to select Mark0 or Mark1. 

 

 

Termination of Alignment 

Alignment is finished as follows. 

 

Alignment succeeded. 
At this time, the alignment result is judged as OK. 
When the position specified in "Change Base" meets "Threshold value for Change Judgement" during 
the execution of "Retry", and each object coordinate and target coordinate is within the range of 
"Threshold value for Mark Deviation".  

 

Alignment failed. 
At this time the alignment result is judged as NG, and PV240 returns an error to a controller such as 
PLC. (For details of error contents, refer to Chapter 4.) 
(1) Alignment failed. 
When the position specified in "Change Base" does not meet "Threshold value for Change 
Judgement" even after "Retry", or each object coordinate is positioned apart from each target 
coordinate by "Threshold value for Mark Deviation" or more even if the position specified in "Change 
Base" meets the threshold value. 
(2) Alignment was cancelled.  (Alignment is not executed until the retry count and terminated.) 

i. Target/Object marks are not detected. 
ii. A stage movement amount exceeds "Stage MAX Distance" ("TYPE" > "Alignment" > "Stage 

Setting"). 
iii. The distance between target coordinates and the distance between object coordinates exceed 

"Threshold value for Mark Deviation" during the execution of Alignment. 
iv. Others, e.g. Target/Object Checker is unset. (For details, refer to Chapter 4.6.) 

 

In "Judgement Limits", items for judging alignment results when it is performed in the state that Alignment is 
executable (the state that marks can be detected and the stage can be moved) are specified. 
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9.1.1 Change Base and Threshold Value for Change Judgement 

Set the allowable range for the deviation between a target position and an object position at the time of the 
execution of alignment. 

Determine the base position of the amount of deviation in "Change Base", and set thresholds in "Threshold 
value for Change Judgement" to judge as OK or NG for the amount of deviation of "Change Base". 

Change Base 
Select the base position for determining the deviation between a target position and an object position at the 
time of the execution of alignment. Select Center (Default), Mark0 or Mark1. 

 

Threshold of Change Judgement 
Set the allowable range for the deviation between the bases specified in "Change Base" for Target and 
Object when executing Alignment. Set the range for the amounts of deviation X, Y and Theta. 

 

 
 
 
Default 

X: 2.0000 mm 
Y: 2.0000 mm 
Theta: 2.00000 degrees 

Change Base (Center) and Threshold Value for Change 
Judgement 

 

■When the middle point between target 
marks is “M” and the middle point between 
object marks is “m”, the distance until these 
points match by moving them in parallel in 
their X and Y directions is Delta X and 
Delta Y. 

 
■The angle that the object line ab becomes 

parallel to the target line AB by rotating on 
the middle point "m" is Delta Theta. 

 
■Judgment is executed for these deviations 

(Delta X, Delta Y, Delta Theta) with 
"Threshold value for Change Judgement". 
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Change Base (Mark0) and Threshold Value for Change 
Judgement 

 

 

■When the target mark0 is "A", target mark1 
is "B", object mark0 is "a" and object mark1 
is "b", the distance until these marks match 
by moving them in parallel in their X and Y 
directions is Delta X and Delta Y. 

 
■The angle that the object line ab becomes 

parallel to the target line AB by rotating on 
the object mark0 "a" is Delta Theta. 

 
■Judgment is executed for these deviations 

(Delta X, Delta Y, Delta Theta) with 
"Threshold value for Change Judgement". 

 

Change Base (Mark1) and Threshold Value for Change 
Judgement 

 

 

■When the target mark0 is "A", target mark1 
is "B", object mark0 is "a" and object mark1 
is "b", the distance until these marks match 
by moving them in parallel in their X and Y 
directions is Delta X and Delta Y. 

 
■The angle that the object line ab becomes 

parallel to the target line AB by rotating on 
the object mark1 "b" is Delta Theta. 

 
■Judgment is executed for these deviations 

(Delta X, Delta Y, Delta Theta) with 
"Threshold value for Change Judgement". 
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9.1.2 Threshold Value for Mark Deviation 

When the base positions of the object and target specified in "Change Base" meet "Threshold of Change 
Judgement", set "Threshold value for Mark Deviation" for determining the deviation between each object 
coordinate and target coordinate. 

 

 
 
 
 
Default 

X: 100.0000 mm 
Y: 100.0000 mm 

Concept 

Change Base: An example using "Center" is explained below. 

 

 
In the left figure, "Threshold of Change Judgement" is met.  
However, alignment should not be finished at this point since 
the target marks and object marks are separated from each 
other. 

  

 

"Threshold value for Mark Deviation" is set here 
considering the deviation between the target and object 
marks. 
 
As Alignment will be finished when the mark deviation 
amounts X and Y for the target and object on the global 
coordinates are within the range of "Threshold value for 
Mark Deviation", adjust the stage to make them be within 
the range. 
 
Setting "Threshold value for Mark Deviation" enables 
more accurate alignment. 

 
Judgement with "Threshold value for Mark Deviation" is performed for Mark0 and Mark1 regardless of the 
setting for "Change Base". 
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9.1.3 Threshold Value for Pitches Between Marks (mm) 

If the difference between the distance between object marks and the distance between target marks which 
is calculated by PV240 is large when executing Alignment, and if the difference is larger than the threshold 
values specified here, an error is output and the alignment operation can be cancelled. 

Default: 100000.0000 mm 
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Chapter 10 
 Judgement, Numeric Calculation, Geometry 

Calculation, Data R/W, Draw Character/Figure 
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10.1 Judgement Output 
The execution results of Alignment can be registered for judgement formulas. 

Registrable Data for Judgement Formulas 
 

Item  Condition judged as OK 

Checker-Alignment 
(ALN) 
No.000 

Judgement 
(JUDGE) 

The judgement result whether the deviation between a 
registered target coordinate and a detected object 
coordinate is within a specified threshold value for change 
judgement is returned. 

 
 

When a type is selected, JDC000=ALN000_JUDGE is automatically set in "INSPECTION" > "Judgement", 
and JDC000 is set in Total Judgement. 
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10.2 Numeric Calculation 
Numeric results by executing Alignment can be registered for numeric calculations. 

Registrable Inspection Data for Numeric Calculation 

 
When items in "Result" of numerical calculation and data R/W have been selected and "Statistics" has 
been selected, the compiled statistics data vary according to items. 

Statistics 
type Numeric Statistics All Statistics OK Statistics NG Statistics 

1 

Judgment Statistics 
 
If the judgement of checker is OK, 
calculates “All Statistics” and “OK 
Statistics”. If the judgement is NG, 
calculates “All Statistics” and “NG 
Statistics”. 
When referring the statistics of 
judgments(JR/JD) during in RUN 
mode, the latest result is referred. 

Scan Count 
(Judgment 
Count) 

OK count NG count 

2 

Statistics of checker results 
 
If the judgement of checker is OK, 
calculates “All Statistics” and “OK 
Statistics”. If the judgement is NG, 
calculates “All Statistics” and “NG 
Statistics”. 

Minimum OK Judge. 
Min. 

NG Judge. 
Min. 

Maximum OK Judge. 
Max. 

NG Judge. 
Max. 

Average OK average NG average 
Range OK Range NG range 
Variance OK Variance NG Variance 

Checker 
Note that the unit of outputting alignment results and magnification are different from those of other 
checkers. 

Item Result 
No. 

Result Type Statistics 
Type 

Details 

Alignment (ALN) 
No.000 
Common Result: 
1/2 page 

--- 
Judgement (JUDGE) 1 Output data 

OK=1, NG=0 
 Inspection Time (TIME) 2  

Alignment  Change Delta X (DX) *1) 2  

  Change Delta Y (DY) *1) 2  

  Change Delta Theta (DT) *2) 2  

  Target mark pitch (TAR_P) *1) 2  

  Object mark pitch (OBJ_P) *1) 2  

  
No. of Movement (MVCNT) No Output result 

only 
Target: 2/2 page  Registration mark0 X (TAR0_X) *1) 2  

  Registration mark0 Y (TAR0_Y) *1) 2  

  Registration mark1 X (TAR1_X) *1) 2  

  Registration mark1 Y (TAR1_Y) *1) 2  

Object  Mark0 X (OBJ0_X) *1) 2  

  Mark0 Y (OBJ0_Y) *1) 2  

  Mark1 X (OBJ1_X) *1) 2  

  Mark1 Y (OBJ1_Y) *1) 2  

Mark the amount of 
deviation 

 Mark0 DeltaX (MX_CAM0) *1) 2  

 Mark0 DeltaY (MY_CAM0) *1) 2  

  Mark1 DeltaX (MX_CAM1) *1) 2  
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  Mark1 DeltaY (MY_CAM1) *1) 2  

  *1) Result is output in µm. 
  *2) Result multiplied by 100 is output. 
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10.3 Geometry Calculation 

Results of alignment can be referred in Geometry Calculation. 
Geometry Calculation is set from "INSPECTION" > "Geometry Calc." in Normal Menu. 
 
Referable geometry calculations: Those referring positions of points  
(Distance between two points, Distance between point and line, Point of approximate lines, approximate 
circle, approximate ellipse) 
 
Setting example (Use for the points of the distance between two points)  

References in 
Geometry Calculation Select Alignment. 

Select a checker 
number. 

Select reference 
data. 

 
 
 

 
 
 
Only points in the 
results of Alignment 
can be referred. 

 

 
 

 

 

 

 
 
The above six items 
can be referred. 

List of Settable Items for Each Object 
 

  Point  All Points  Line  Circle 

ALN: Alignment  Yes 

Coordinate origin 0 

Coordinate origin 1 

Registration target 
coordinates 0 

Registration target 
coordinates 1 

Object coordinate 0 

Object coordinate 1 

 No  No  No 

 
The checker with a camera number different from that selected for the setting geometry calculation cannot 
be specified or referred. 

An operation error occurs if a test is executed at this time. ("E0071 No ref. checker result." is displayed.) 
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10.4 Data R/W 
Alignment data can be referred in Data R/W. 
The setting is made from "TYPE" > "Data R/W" > "Data R/W 0" and "Data R/W 1". 
For details of the setting method, refer to "4.19 Displaying Data on the Screen and Updating Settings (Data 
R/W)" of PV200 User's Manual. 

10.4.1 Settings Unique to PV240 (Presets)） 

Data R/W of PV240 provides "Presets" in which frequently used items at the time of Alignment are set, and 
the following contents are automatically stored when creating a type. Different preset items are prepared 
for Data R/W 0 and Data R/W 1 respectively. Edit and use them as necessary. 

 

Preset items for Data R/W0 Preset items for Data R/W1 

  

Displays deviations. Displays calibration data. 

 

Settings of Presets 

Data R/W 0 

 Text (Delta X) Text (Delta Y) Text (Delta Theta) 

Text  
(Threshold) 

Checker (Alignment 
No.000 Threshold X) 

Checker (Alignment 
No.000 Threshold Y) 

Checker (Alignment 
No.000 Threshold Theta) 

Text  
(Present Value) 

Checker (Alignment 
No.000 Change Delta X 
(present) 

Checker (Alignment 
No.000 Change Delta Y 
(present) 

Checker (Alignment 
No.000 Change Delta 
Theta (present) 

Text  
(Previous Value) 

Checker (Alignment 
No.000 Change Delta X 
(previous) 

Checker (Alignment 
No.000 Change Delta Y 
(previous) 

Checker (Alignment 
No.000 Change Delta 
Theta (previous) 

Text (Result) Checker (Alignment 
No.000 Judgement) 

Text (No. of Execution) Checker (Alignment 
No.000 No. of Movement) 

 

Data R/W 1 

 Text (Mark0)  Text (Mark1)  

 Text (X) Text (Y) Text (X) Text (Y) 

Text 
(Resolution) 

Checker (Alignment 
No.000 
Calibration 0 
Resolution X 
(mm/pixel)) 

Checker (Alignment 
No.000  
Calibration 0 
Resolution Y 
(mm/pixel)) 

Checker (Alignment 
No.000  
Calibration 1 
Resolution X 
(mm/pixel)) 

Checker (Alignment 
No.000  
Calibration 1 
Resolution Y 
(mm/pixel)) 

Text 
(Rotation 
Point) 

Checker (Alignment 
No.000  
Calibration 0  
Rotation Point X 
(mm)) 

Checker (Alignment 
No.000  
Calibration 0  
Rotation Point Y 
(mm)) 

Checker (Alignment 
No.000  
Calibration 1  
Rotation Point X 
(mm)) 

Checker (Alignment 
No.000  
Calibration 1  
Rotation Point Y 
(mm)) 

     

Text 
(Camera 
Angle) 

Checker (Alignment 
No.000  
Calibration 0  
Camera Angle (°)) 

 Checker (Alignment 
No.000  
Calibration 1  
Camera Angle (°)) 
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How to Set Presets in Data R/W 
 

1. Set "Display Data R/W" to "Free" in "TYPE" > 
"Alignment" > "Alignment" > "Options". 
 
(If it is set to "Fixed", Data R/W cannot be 
edited.) 

 

 
 

 
2. Select "TYPE" > "Data R/W". 

3. Select "Data R/W 0" or "Data R/W 1". 
 
 
 
 
 
 
 

4. Press the FUNC key while the cursor is on 
the table. 

5. Select "Presets". 
 
 
 
 
 
 

 

 

 
 

 

6. Select "Yes" in the right dialog box. 
 
 
 

7. Preset items are stored in "Data R/W".  

 

 
 
 

 
 

• It is possible to add other items or edit the settings after storing the preset data. 

• For displaying the Data R/W window in RUN menu, select "Data R/W 0" or "Data R/W 1" in "View" > 
"Data R/W". 

• Inappropriate characters may be displayed depending on language specifications when switching 
language. So, read the preset data again after switching language. Accordingly, character strings 
are displayed in the selected language. 

 

 

 

 



 

210 

10.4.2 Referring Alignment Data 

“Yes” in the “Change” column indicates the value of the cell is modifiable from Data R/W sheet. 

For details of "Statistics Type", refer to page 205. 
Alignment （ALN）  Change Statistics type 

Parameter Calibration Checker 0 *1) No No 
  Checker 1 *1) No No 
 Target Checker 0 *1) No No 
  Checker 1 *1) No No 
  Stage Coordinates Offset (X) Yes No 
  Stage Coordinates Offset (Y) Yes No 
  Stage Coordinates Offset (Theta) Yes No 
  Target Coordinates Offset 0 (X) Yes No 
  Target Coordinates Offset 0 (Y) Yes No 
  Target Coordinates Offset 1 (X) Yes No 
  Target Coordinates Offset 1 (Y) Yes No 
 Object Checker 0 *1) No No 
  Checker 1 *1) No No 
  Detect Coordinates Offset 0X Yes No 
  Detect Coordinates Offset 0Y Yes No 
  Detect Coordinates Offset 0Theta Yes No 
  Detect Coordinates Offset 1X Yes No 
  Detect Coordinates Offset 1Y Yes No 
  Detect Coordinates Offset 1Theta Yes No 
 Judgement Limits Threshold of Change Judgement (X) Yes No 
  Threshold of Change Judgement (Y) Yes No 
 

 Threshold of Change Judgement 
(Theta) Yes 

No 

 
 Threshold value for pitches between 

marks Yes 
No 

  Threshold value for Mark Deviation (X) Yes No 
  Threshold value for Mark Deviation (Y) Yes No 
Result Common Result Judgement No No 
  Execution Time No No 
 Alignment Change Delta X (present) No No 
  Change Delta Y (present) No No 
  Change Delta Theta (present) No No 
  Change Delta X (previous) No No 
  Change Delta Y (previous) No No 
  Change Delta Theta (previous) No No 
  Change Delta X (before last) No No 
  Change Delta Y (before last) No No 
  Change Delta Theta (before last) No No 
  Target mark pitch No No 
  Object mark pitch No No 
  No. of Movement No No 
 Calibration Resolution X (mm/pixel) No No 
 Mark0 Resolution Y (mm/pixel) No No 
  Rotation Point X (mm) No No 
  Rotation Point Y (mm) No No 
  Camera Angle (°) No No 
 Calibration Resolution X (mm/pixel) No No 
 Mark1 Resolution Y (mm/pixel) No No 
  Rotation Point X (mm) No No 
  Rotation Point Y (mm) No No 
  Camera Angle (°) No No 

 Target Registration mark0 X *2) No No 
  Registration mark0 Y *2) No No 
  Registration mark1 X *2) No No 
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Alignment （ALN）  Change Statistics type 

  Registration mark1 Y *2) No No 
 Object Mark0 X No No 
  Mark0 Y No No 
  Mark1 X No No 
  Mark1 Y No No 
 Mark the amount of 

deviation 
Mark0 DeltaX No No 

 Mark0 DeltaY No No 
  Mark1 DeltaX No No 
  Mark1 DeltaY No No 
 Stage Adjustment 

Amount 
Adjustment Amount Delta X *3) No No 

 Adjustment Amount Delta Y *3) No No 
  Adjustment Amount Delta Theta *3) No No 

 

*1) When setting "Checker" (Calibration Checker, Target Checker, Object Checker) for the parameter of 
Alignment, characters indicating checkers used for each mark are displayed. (Smart Matching: SMC, Corner 
Detection: CNR, Feature Extraction: FEC, Contour Matching: CMC, Smart Edge (Circle): SEC, Arbitrary 
Point: FRE) 
*2) The registered target coordinates are displayed. 
*3) Use this value for moving the stage by Manual Alignment. 
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10.5 Character/Figure Drawing 
Detected positions and results of Alignment can be used for drawing positions of figures or displayed 
character strings in Draw Character/Figure. 
Character/Figure Drawing is set from "INSPECTION" > "Draw Char/Fig." in Normal Menu. 
For details of the setting method, refer to "4.14 Character/Figure Drawing" of PV200 User's Manual.  
 

Using alignment data (detected positions) in Character/Figure Drawing 
 Figure Reference destination 

Usable for drawing 
positions 
 

Line 
Cross 
Rectangle 
Slanted rectangle 
Ellipse 
Character 

Start point and End point 
Intersection point 
Start point and End point 
Center of rectangle 
Center of ellipse 
Displayed position 

Usable for displayed 
characters 

Character Character string 

 
 
Setting example1 (Use alignment data for point positions) 

Start point of a line Select Alignment. Select checker No. 
and reference data. 

Specify a position of 
Alignment for start point. 

 
 

 
 

 

 
 

 
 
 

 
The above six items 
can be referred. 
 

 

 

 

 

 

 
Setting example 2 (Use alignment data for Display Character) 

Character 
Display 
Character 

Select Alignment. Select checker No. 
and reference data. 

Specify a position of Alignment for 
start point. 

 
 
 

 

 

 
 
 

 

    
 
 
 
 
 

 

 
 

 



 

213 

 
IN

D
E

X
 

IN
D

E
X

 

INDEX 

A 

AAE (Execute Auto Alignment) 
General Communication Command 33, 83 
PLC Communication Command ...... 131 

AAS (Execute Auto Alignment) 

General Communication Command 34, 85 
PLC Communication Command ...... 132 

ACL (Execute Alignment for 1 Camera) 
General Communication Command 90 
PLC Communication Command ...... 136 

Alignment ............................................ 152 

Arrowhead of stage direction ........... 153 
Checksum ........................................ 156 
Display Alignment Time ................... 154 
Display Data R/W ............................ 155 
Display Total Judgement ................. 155 
Retry ................................................ 153 

Target Cross Drawing ...................... 153 
Target Position ................................. 155 
TRIG Type ....................................... 152 

Alignment (INSPECTION) ................... 157 
AOG (Get Deviation/Stage Adjustment 

Amount) 

General Communication Command 104 
PLC Communication Command ...... 145 

ARR (Reset, Cancel Alarm) 
General Communication Command .. 89 
PLC Communication Command ...... 135 

AZG (Get Stage Adjustment Amount) 

General Communication Command .. 93 
PLC Communication Command ...... 138 

B 

Base Position Regist. (Target 
Coordinates Offset) ......................... 184 

Bayer Image .......................................... 27 

BCC ....................................................... 76 
Block check code .................................. 76 
Bulk Checker Setting ........................... 158 

Calibration Checker ......................... 158 
Common Object ............................... 158 
Object Checker ................................ 158 

Target Checker ................................ 158 
byr.......................................................... 27 

C 

CAE (Execute Calibration) 
General Communication Command .. 79 

PLC Communication Command ...... 129 
Calibration ................................... 157, 162 

Checker Setting ............................... 162 
Display Global Coordinate ............... 167 
Manual Setting ................................. 164 
Rotation Point Adjustment ............... 170 

Rotation Point Adjustment (Manual 
Setting) ........................................ 171 

Show details .................................... 166 
Stage Movement ............................. 161 

Calibration (TYPE) .............................. 161 
Change Base ....................................... 197 

Change Camera Shutter Speed (CSH)102,143 
Change Threshold of Change Judgement 

(SCT) ....................................... 103, 144 
Checker Setting 

Object .............................................. 190 
Checkers Setting 

Alignment ................................. 157, 158 
Common Object ............................. 158 

Calibration ....................................... 162 
Target .............................................. 178 

CIR(Command Input Register) ............ 126 
Command Communication Log 

Format ............................................. 150 
Keep logs ......................................... 150 
New log file (type select) ................. 150 
No. of Folders .................................. 150 
Overwrite ......................................... 150 
Polling view ...................................... 150 

Command Input Register ..................... 112 
Command Output Register .................. 112 
Command Read Type .................... 67, 114 
Command start bit ................112, 121, 123 
Common Object .................................. 158 
Compression ......................................... 26 



 

214 

IN
D

E
X

 

Compression Rate of Image Output ...... 26 
Compression Rate of Inspection Image 

Output ................................................ 26 

Control Register ............................ 112, 114 
Coordinates of Registered Target 181, 187 
COR(Command Output Register) ....... 126 
CSH (Change Camera Shutter Speed) 

General Communication Command 102 
PLC Communication Command ...... 143 

D 

Data Output Completion Notice .... 112, 113 
Data Output Register ........................... 112 
Data R/W ............................................. 205 
Decimal digit .......................................... 69 
Detect Coordinates Offset ................... 193 

Display Alignment Time ....................... 154 
Display Coordinates .................... 179, 191 
Display Global Coordinate ................... 167 
Draw Character/Figure ........................ 209 

E 

Error bit ........................................ 112, 121 

Error Code ........................................... 148 
Ethernet Interface .................................. 65 
Execute Auto Alignment (AAE) ..... 83, 131 
Execute Auto Alignment (Simple Flow) 

(AAS) ......................................... 85, 132 
Execute Calibration (CAE)79, 81, 129, 130 

G 

General Communication .................. 67, 68 
GDV (Get Deviation) 

General Communication Command .. 74 
PLC Communication Command125, 137 

General Output ...................................... 68 

Geometry Calculation .......................... 204 
Get Deviation (GDV)....................... 92,137 
Get Deviation/Stage Adjustment Amount 

(AOG) ....................................... 104,145 
Get Distance between Target/Object 

Marks (GML) ............................ 101, 143 

Get Object Position (OBG) ............. 88,134 
Get Stage Adjustment Amount (AZG)93,138 
Get Target Position (TGG) ............ 87, 133 

GML (Get Distance between 
Target/Object Marks) 
General Communication Command 101 

PLC Communication Command ...... 143 

H 

hange Threshold of Change Judgement 
(SCT) ................................................. 74 

J 

Judgement ........................................... 201 

Output using General Communication69 
Output using PLC Communication ...113 

Judgement Limits ................................ 196 
Change Base ................................... 197 
Threshold of Change Judgement .... 197 
Threshold Value for Mark Deviation 199 

Threshold Value for Pitches Between 
Marks ........................................... 199 

Judgement Limits (Alignment) ............. 157 

L 

List of PLC Communication Commands125 

M 

Manual Alignment 
Mark Async. Execution ...................... 10 
Mark Sync. Execution ........................ 10 
TRIG Type ......................................... 10 

Manual Setting (Calibration Data) ....... 164 
Mark Async. Execution .......................... 10 

Mark Sync. Execution ............................ 10 
Measured Change ............................... 174 
Move Rotation Center (SRP) ......... 96, 140 

N 

Numeric Calculation ............................ 202 
Numerical Calculation 

Output using General Communication69 
Output using PLC Communication ...113 

O 

OBG (Get Object Position) 
General Communication Command .. 88 
PLC Communication Command ...... 134 

Object .......................................... 157, 190 



 

215 

 
IN

D
E

X
 

IN
D

E
X

 

Detect Coordinates Offset ............... 193 
Display Coordinates ........................ 191 
Object Checker ................................ 188 

Object Coordinates .......................... 194 
OBJECT (Manual Setting) ..................... 42 
Object Coordinates .............................. 194 
OBJECT ................................................ 42 
OBS (Set Object Position) 

General Communication Command 105 

PLC Communication Command ...... 146 
Offset 

Stage Coordinates (Target) ..... 181, 182 
Target Coordinates .................. 181, 184 

OBJECT (Manual Setting) ....................... 9 

P 

Parallel Input(PLC Communication) ..... 114 
PLC Communication 

Command start bit ........... 112, 121, 123 
Control Command Timing Chart ...... 123 
Controlling PV200 ............................ 125 
Error bit ..................................... 112, 121 

General Output example ................. 120 
Parallel Input ..................................... 114 
Polling ............................................... 114 
Polling Time ...................................... 115 
Processing bit .......... 112, 121, 123, 124 
Relation between setting items and 

PLC registers ................................ 112 
Response completion .............. 123, 124 
Start Bit Off Timeout ......................... 115 
Transmitting bit ................................ 122 
Watch Dog ....................................... 122 

PLC Communication ........................ 67, 108 

Controling PV240 ............................ 121 
Usable PLC ..................................... 108 
Setting PLC Com. ............................. 112 

Polling ................................................... 114 
Polling Time .......................................... 115 
Port number ........................................... 66 

Preset Menu (Select Menu)................... 14 
Presets (Data R/W) ............................. 205 
Print Screen 

Saving Conditions .............................. 38 
Print Screen (PS) ........................... 98,141 

Processing bit .............. 112, 121, 123, 124 
PS (Print Screen) 

General Communication Command .. 97 

PLC Communication Command ...... 141 
PSM (Save Print Screen in Image 

Memory) 
General Communication Command .. 99 
PLC Communication Command ...... 142 

R 

Register Coordinates of Target ........... 181 
Relation between setting items and PLC 

registers ............................................ 112 
Request Stage Absolute Position Move 

(TAR) ......................................... 78, 128 
Request Stage Current Position (TAG)77,127 

Reset, Cancel Alarm (ARR) ........... 89,135 
Response completion .................. 123, 124 
Retry .................................................... 153 
Rotation Point Adjustment 

(INSPECTION) ................................ 170 
Rotation Point Adjustment (Manual 

Setting) ............................................ 171 
Measured Change ........................... 174 

Rotation Point Adjustment (TYPE) ...... 171 
RS-232C ................................................ 63 
RTD (Output Alignment Result Data) 

General Communication Command .. 07 

PLC Communication Command ...... 147 
RUN Menu 

Alignment message ............................. 9 
Information display area ...................... 9 
OBJECT .............................................. 9 

S 

Save Print Screen in Image Memory 
(PSM) ........................................ 99, 142 

Save Print Screen in SD (SSM) .. 100, 142 
SCT (Change Threshold of Change 

Judgement) 
PLC Communication Command ...... 144 

SCT (Change Threshold of Change 
Judgement) 
General Communication Command 103 
PLC Communication Command ...... 125 



 

216 

IN
D

E
X

 

Select Menu 
Preset Menu ...................................... 14 

Set Object Position(OBS) ............ 105, 146 

Set Target Position (Specify Camera 
Coordinate) (TGS) ...................... 95,139 

Show details (Calibration Data) ........... 166 
SRP (Move Rotation Center) 

General Communication Command .. 96 
PLC Communication Command ...... 140 

Stage +Theta Direction .................... 57, 59 
Stage +XY Direction ........................ 57, 59 
Stage Coordinates Offset ............ 181, 182 
Stage Direction Automatic Judgement .. 55 
Stage MAX Distance .............................. 60 
Stage Movement ................................. 161 

Stage Setting 
Stage + Rotation Direction............... 168 
Stage +Theta Direction ................ 57, 59 
Stage +XY Direction .................... 57, 59 
Stage Direction Automatic Judgement55 

Stage Type ............................................. 51 

Line Theta Stage .......................... 50, 51 
Theta Axis .......................................... 52 
Theta Axis Length (mm)..................... 53 
UVW Pin Position (mm) ..................... 54 
UVW Stage .................................. 49, 51 
XThetaY Stage ............................. 49, 51 

XYTheta Stage ............................. 49, 51 
YThetaX Stage ................................... 49 

Start Bit Off Timeout ............................ 115 
Station No.(PLC communication) ........ 116 

T 

TAG (Request Stage Current Position) 

General Communication Command .. 77 

PLC Communication Command ...... 127 
TAR (Request Stage Absolute Position 

Move) 

General Communication Command .. 78 
PLC Communication Command ...... 128 

Target .......................................... 157, 178 
Base Position Regist. ...................... 185 
Coordinates of Registered Target .... 185 
Display Coordinates ........................ 179 

Register Coordinates of Target ....... 181 
Stage Coordinates Offset ........ 181, 182 
Target Checker ................................ 178 
Target Coordinates Offset ............... 184 

Target Checker .................................... 178 
Target Coordinates Offset ........... 181, 184 

Target Cross Drawing .......................... 153 
TGG (Get Target Position) 

General Communication Command .. 87 
PLC Communication Command ...... 133 

TGS (Set Target Position) 
General Communication Command .. 95 
PLC Communication Command ...... 139 

Threshold of Change Judgement ........ 197 
Threshold Value for Mark Deviation .... 199 
Threshold Value for Pitches Between 

Marks ............................................... 199 
Timeout 

PLC Communication .........................113 
Start Bit OFF .....................................115 

Total Judgement .......................... 155, 201 
Transmitting bit .................................... 122 
TRIG Type ........................................... 152 

W 

Watch Dog ........................................... 122 
 



 

217 

IN
D

E
X

 

Record of Changes 

Manual No. Date Revision detail 

WME-PV240-OP-01 May 2015 First edition 

 

 



WME-PV240-OP-01

2015.4

IM
AGECHECKER PV240　

Uesr’s M
anual

Please contact ..........

■ Overseas Sales Division (Head O�ce): 2431-1 Ushiyama-cho, Kasugai-shi, Aichi, 486-0901, Japan

■ Telephone: +81-568-33-7861     ■ Facsimile: +81-568-33-8591

panasonic.net/id/pidsx/global

For sales network, please visit our website.

© Panasonic Industrial Devices SUNX Co., Ltd. 2015
WME-PV240-OP-01May, 2015  PRINTED IN JAPAN


	 Table of Contents
	1. Alignment
	1.1 Menu
	1.2 Main Settings

	2. Basic Operation
	2.1 About Windows
	2.1.1 RUN Menu and SETUP Menu
	2.1.2 Operation by Pressing TRIG Key in RUN Menu (Manual Alignment)

	2.2 Select Menu
	2.2.2 Selecting Engineering/User Menu
	2.2.3 Referring to Engineering/User Menu
	2.2.4 Applying Preset Menu (Engineering Menu) Again

	2.3 Result Output and Image Output to SD Card
	2.3.1 Outputting Alignment Result Data

	2.4 Useful functions
	2.4.1 Copying the Screen Display (Print Screen)
	2.4.2 Changing Saving Conditions of Print Screen
	2.4.3 Displaying Print Screen Images on Monitor
	2.4.4 Setting Object Position in RUN Menu (Manual Registration)


	3. Stage Setting
	3.1 Supported Stages
	3.2 Setting Stages
	3.3 Selecting Stage Type
	3.4 Setting Theta Axis
	3.6 Setting UWV Pin Position (mm)
	3.7 Setting Stage Operation Direction
	3.7.1 Stage Direction Automatic Judgement

	3.8 Setting Stage MAX Distance
	3.9 Stage Adjustment Amount (Absolute Value)

	4. Communication Setting
	4.1 Communication Port and Protocol
	4.1.1 RS-232C Interface

	4.2 General Communication
	4.2.1 Overview and Communication Specifications
	4.2.2 Setting General Communication
	4.2.3 Outputting Data through General Communication

	4.3 Details of General Communication Commands
	4.4 PLC Communication 
	4.4.1 Overview and Communication Specifications

	4.5 Descriptions of PLC Communication Commands
	4.6 List of Error Codes
	4.7 Command Communication Log
	4.7.1 Confirming Communication Logs on Monitor


	5. Alignment Function Setting
	5.1 Setting Alignment Function
	5.2 TYPE > Alignment > Alignment
	5.3 INSPECTION > Alignment
	5.3.1 Setting Checkers (Bulk Checker Setting)）
	5.3.2 Checkers Setting > Comment
	5.3.3 Checkers Setting > Common Object


	6. Calibration Setting
	6.1 Setting Calibration
	6.2 TYPE > Alignment > Calibration
	6.2.1 Stage Movement

	6.3 INSPECTION > Alignment > Calibration
	6.3.1 Checker


	7. Target Setting
	7.1 Setting Target
	7.1.1 Target Checker
	7.1.2 Display Coordinates
	7.1.6 Coordinates of Registered Target


	8. Object Setting
	8.1 Setting Object
	8.1.1 Object Checker
	8.1.2 Display Coordinates


	9. Judgement Condition Setting
	9.1 Setting Judgement Limits
	9.1.3 Threshold Value for Pitches Between Marks (mm)


	10. Judgement, Numeric Calculation, Geometry Calculation, Data R/W, Draw Character/Figure
	10.1 Judgement Output
	10.2 Numeric Calculation
	10.3 Geometry Calculation
	10.4 Data R/W
	10.4.1 Settings Unique to PV240 (Presets)）
	10.4.2 Referring Alignment Data

	10.5 Character/Figure Drawing
	INDEX
	Record of Changes



